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Preface

This reference guide describes the features of Oracle Risk Manager, an Oracle Finan-
cial Services (OFS) application that models the effects of interest rate risk. This pref-
ace describes the following information about the reference guide:

■ Intended Audience

■ Organization

■ Report-Related Changes

■ Related Documents

■ Conventions

■ Customer Support Information

Intended Audience
Risk Manager users who perform interest rate risk analysis, cash flow forecasting, 
and market valuation will find this reference guide useful. It assumes the applica-
tion has already been installed on your client/server system.

Organization
Preliminary material appears in chapters 1–4. Read these chapters if you are new to 
Risk Manager or want to read about new features:

Chapter 1, "Introduction," describes the OFS applications, setting user parameters, 
and menus and toolbars.

Chapter 2, "Overview of the Process," describes the processes used in Risk Man-
ager, with explanations of key concepts and modeling logic.
xix



Chapter 3, "Performance Data," describes processing performance factors, reading 
and processing instrument data, processing formula leaves, and writing processing 
errors.

Chapter 4, "Overview of IDs," defines the ID concept, functions associated with IDs 
(such as importing and exporting), and tree-related IDs.

The following chapters describe the IDs used in Risk Manager. The chapters are 
organized alphabetically by ID name.

Chapter 5, "Batch ID," describes how to use the Batch ID, and covers serial and par-
allel Batch ID processing.

Chapter 6, "Configuration ID," explains modeling buckets, autobalancing, and 
dynamic buckets.

Chapter 7, "Data Filter ID," describes how to create and use the Data Filter ID and 
explains Data Filter ID processing.

Chapter 8, "Data Verification ID," describes how to create and use the Data Verifica-
tion ID and explains Data Verification ID processing. 

Chapter 9, "Discount Rates ID," explains discount methods and cash flows.

Chapter 10, "Forecast Balance ID," presents different approaches to forecasting bal-
ances and defines five forecast methods.

Chapter 11, "Forecast Rates ID," describes how to create and use the Forecast Rates 
ID.

Chapter 12, "Formula ID," describes how to use Formula IDs to specify report col-
umns, calculate assignments in data correction, and create calculated conditions in 
data and relationship filters.

Chapter 13, "Formula Leaves ID," defines the Formula Leaves ID, including funda-
mental concepts, functions, and examples.

Chapter 14, "Group Filter ID," describes how to create and use the Group Filter ID.

Chapter 15, "Leaf Characteristics ID," describes how to create and use the Leaf Char-
acteristics ID.

Chapter 16, "Maturity Strategy ID," describes how to create and use the Maturity 
Strategy ID.

Chapter 17, "Prepayment ID," explains Prepayment IDs and calculation methods.

Chapter 18, "Prepayment Table ID," explains prepayment table structures and 
dimensions. 
xx



Chapter 19, "Pricing Margin ID," describes how to create and use the Pricing Mar-
gin ID.

Chapter 20, "Process ID," describes how to create and use the Process ID.

Chapter 21, "Rate Index ID," describes how to create and use the Rate Index ID for 
Monte Carlo processing.

Chapter 22, "Transaction Strategy ID," describes how to create and use the Transac-
tion Strategy ID. 

Chapter 23, "Transformation ID," explains how to create and use the Transforma-
tion ID for analysis and reporting.

Chapter 24, "Tree Filter ID," describes how to create and use the Tree Filter ID. An 
example is provided. 

Chapter 25, "Tree Rollup ID," describes how to create and use the Tree Rollup ID. 
An example is provided.

The following chapters describe advanced features of Risk Manager.

Chapter 26, "User-Defined Payment Pattern," explains how to customize amortiza-
tion due to changes in payment frequency, seasonal payments, or variable payment 
amounts.

Chapter 27, "User-Defined Repricing Pattern," explains how to use repricing pat-
terns to describe interest rate adjustments over the life of a cash flow instrument.

Chapter 28, "SQL Talk," explains how to open an SQL Talk dialog to connect to the 
database directly.

The appendixes provide additional information:

Appendix A, "Risk Manager Error Messages" lists Risk Manager error messages.

Appendix B, "Transformation ID Error Messages" lists Transformation ID error mes-
sages.

This guide also contains a glossary and an index.

Report-Related Changes
Oracle Discoverer is the recommended reporting tool for OFSA Release 4.5. Discov-
erer is fully integrated with the following OFSA products:

■ Oracle Financial Data Manager Balance & Control

■ Oracle Performance Analyzer
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■ Oracle Risk Manager

■ Oracle Transfer Pricing

This release supports both Oracle Discoverer and the reporting tool used in prior 
OFSA releases. You can find information about both reporting tools in the follow-
ing documents:

The following report-related chapters and appendixes have been removed from 
OFSA reference guides and moved to the Oracle Portfolio Analyzer Reference Guide:

■ Report ID

■ Report Macros

■ Report Runner Dialog

■ Report Stratification ID

■ Standard Reports

■ Subtotal ID

Related Documents
For more information, see the following manuals:

■ Oracle Financial Data Manager Balance & Control Reference Guide, PN A82947-01

■ Oracle Financial Data Manager Reporting Administration Guide, PN A80993-01

■ Oracle Financial Services Installation and Configuration Guide, PN A80992-01

■ Oracle Financial Services Technical Reference Manual, PN A70144-01

Reporting Tool Documentation

Oracle Discoverer Oracle Discoverer User Guide

Oracle Discoverer Administrator Guide

OFSA reporting tool Oracle Portfolio Analyzer Reference Guide

Oracle Reports Oracle Financial Data Manager Reporting Administration Guide
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Conventions
This reference guide uses the following conventions:

Symbols
■ Bullets indicate a list of items or topics.

1. Numbered lists are used for sequential steps in completing a procedure.

Orientation of Procedures
Procedures in OFSA reference guides are generally menu-driven rather than com-
mand- or icon-driven. Only occasionally is a reference to a toolbar or mouse action 
necessary because the action has no menu equivalent. If you prefer to use the tool-
bar icons, refer to Chapter 1, “Introduction.”

Convention Meaning

    .
    .
    .

Vertical ellipsis points in an example mean that information not 
directly related to the example has been omitted.

. . . Horizontal ellipsis points in statements or commands mean that 
parts of the statement or command not directly related to the 
example have been omitted.

boldface text Boldface type in text indicates a term defined in the text, the glossary, 
or in both locations. 

bold monospace Bold monospace type in text indicates information that you type in.

Italics Italics emphasize a word or phrase.

< >  Angle brackets enclose user-supplied names (for example, <Branch 
Name>).

[ ] Brackets enclose function and terminal keys. In common syntax, 
brackets denote one or more optional items.

{ } Braces are used to denote variables, and in command syntax, a choice 
within a mandatory item.

Example of command syntax: 

Warning: INIT file {filename} already exists.

Example of choices: 

{EXIT|QUIT}

-> This arrow indicates a menu path.
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Notes, Cautions, and Warnings
Certain information may be set off in boxes for purposes of emphasis:

■ Note refers to important information

■ Caution indicates the possibility of damage to a product, system, or data

■ Warning refers to a situation that is potentially hazardous to people

Customer Support Information
Product support is available through Oracle Support Services. Contact your project 
manager for information about using the support options offered in your geo-
graphic region. These options may include the following:

■ MetaLink (which provides online access to information about Technical 
Libraries, Patches, TARs, and Bugs and is available at metalink.oracle.com)

■ Telephone support
xxiv
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Introduction

Oracle Risk Manager is a versatile forecasting tool, supporting asset/liability plan-
ning, budgeting, and treasury management. Powerful analytical functions can fore-
cast every instrument, including derivatives and embedded options. Modeling at 
the account level of detail (loan-by-loan and deposit-by-deposit) provides highly 
accurate modeling results. Flexible assumption (IDs) and reporting structures sup-
port a wide range of analytical power.

Release 4.5 of Risk Manager includes multicurrency capabilities and improved data 
management and control for interest rates. You can analyze currency risk, manage 
multicurrency balance sheets, and incorporate exchange rate forecasting and pro-
cessing. The redesigned interest rate algorithms for interest rate forecasts, valua-
tion, and rate format conversion simplify data management and improve the 
overall accuracy of the model. 

Oracle Financial Services Overview
You can use Risk Manager as a standalone application or as part of the Oracle 
Financial Services (OFS) group of applications. As with all the other OFS applica-
tions, the Oracle Financial Data Manager provides the foundation for Risk Manager.
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Oracle Financial Services Overview
OFS Applications
OFS applications form a comprehensive decision support solution that significantly 
enhances transfer pricing, budgeting and planning, risk management, and perfor-
mance measurement functions across a financial institution.

Oracle Financial Data Manager 
Oracle Financial Data Manager (FDM) is a standalone data warehouse with pre-
packaged data elements for the financial services industry. FDM is also the founda-
tion for the OFS applications. It provides the database structures necessary to 
support the individual business applications.

FDM includes Oracle Financial Data Manager Balance & Control, Oracle Financial 
Data Manager Administration, Oracle Financial Data Manager/Discoverer Integra-
tor, and Oracle Financial Data Manager Rate Manager.

Oracle Financial Data Manager Balance & Control  Balance & Control validates, 
corrects, and aggregates data from the FDM.

Oracle
Financial Data

Manager

Oracle Financial
Data Manager
Administration

Oracle Financial
Data Manager

Balance &
Control

Oracle Transfer
Pricing

 Oracle
Performance

Analyzer

 Oracle Risk
Manager

Oracle Financial
Data Manager
Rate Manager

Oracle
Customer

Householding

Oracle
Budgeting &

Planning

Oracle Financial
Data Manager/

Discoverer
Integrator
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Setting User Parameters
Oracle Financial Data Manager Administration FDM Administration manages the 
FDM, providing security and maintenance capabilities.

Oracle Financial Data Manager/Discoverer Integrator  Discoverer Integrator inte-
grates the FDM database with Oracle Discoverer, which provides ad hoc reporting, 
analysis, and Web publishing capabilities.

Oracle Financial Data Manager Rate Manager  FDM Rate Manager manages inter-
est rate, exchange rate, and currency information for the FDM.

Oracle Budgeting & Planning
 Budgeting & Planning provides performance-based planning. It integrates cash 
flow balance sheet and net income forecasting capabilities with the scalability and 
customizable framework of Oracle Financial Analyzer, part of the Oracle Express 
group of data access and analysis tools.

Oracle Transfer Pricing 
 Transfer Pricing calculates a transfer rate for each account and a charge or credit for 
funds for each asset or liability.

Oracle Performance Analyzer
 Performance Analyzer provides comprehensive and flexible cost and equity alloca-
tions. It measures product, business unit, and customer profitability.

Oracle Risk Manager
 Risk Manager forecasts cash flows, interest income, and market value to manage 
rate risk.

Oracle Customer Householding
Customer Householding provides a fully scalable parallel-processing engine for 
customer data loading and cleansing, customer relationship linking, customeriza-
tion, householding, and data aggregation within FDM.

Setting User Parameters
Setup requirements include:

■ OFSA system configuration

■ Files required to run OFSA
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■ Logging in to OFSA

OFSA System Configuration
Basic system configuration is defined using the Configuration ID

Files Required to Run OFS Applications
To verify that all the necessary files for your installation of Risk Manager have been 
installed in the correct locations, consult the Oracle Financial Services Installation and 
Configuration Guide.

Logging In to OFS
To log in to any OFS application, double-click the appropriate OFS icon from Win-
dows. The OFS Login window appears.

In Windows NT or Windows 95, you can run multiple OFS applications, but you 
should run each application in its own memory space.

Menus and Toolbars
You can use menus or the toolbar icons.

Menus
A typical OFS menu bar consists of the following menu options:

■ File

■ Edit

■ Process

■ Setup

■ Options 

■ Tools

■ Window

■ Help
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File Menu
The options of the File menu are used primarily for file management. This includes 
creating new files, opening existing files, saving, deleting, and renaming files. This 
menu also contains commands for printing IDs and windows, and for exiting the 
application.

Save  Select Save to save IDs as you are creating or modifying them. You are 
prompted to confirm the save.

You should save your work every few minutes. From the File menu, you can select 
Save, or you can click on the Save icon (the floppy disk) on the toolbar.

Delete  Select Delete to remove the open and active ID from the disk. You are 
prompted to confirm the deletion.

If you want to delete more than one open ID, make each ID active by clicking any-
where within the window and delete it.

Delete Group  To delete a group of IDs, complete the following steps. Each ID does 
not need to be open and active for you to delete the entire group.

1. From the file menu, select Delete Group. The Delete Group window appears.

2. From the ID Type list, select the type of ID that you want to delete. All IDs of 
this type appear in the list below the ID Type list.

3. Select the IDs you want to delete, and select the Add button to list them in the 
ID Type/ID Name box.

4. Repeat steps 1 and 2 for as many ID types as required. You can select and delete 
multiple IDs of multiple types all at once. The following table describes other 
features of the Delete Group window.

Selection Buttons ■ Four buttons control the movement of IDs between the ID 
list box and the Selected IDs box.

■ Select Add to add the ID to the Selected IDs box. Select 
Select All to select all the IDs of the chosen type. 

■ Select Remove to remove an ID from the list you have made 
in the Selected IDs box. 

■ Select Remove All to remove all of them from the Selected 
IDs list.

Order Buttons ■ To change the order of IDs in the Selected IDs box, select an 
ID and click the up or down Order arrows located below the 
list box.
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5. When your list of IDs is complete, select Remove All.

Import/Export Group  Refer to "Importing and Exporting IDs" in Chapter 4, "Overview 
of IDs."

Dependencies  Refer to "Dependent ID Import/Export" in Chapter 4, "Overview of 
IDs."

Print  Select Print to print the open and active ID or window.

Print Group  To print a group of IDs, complete the following steps. It is not required 
that each ID in the group is open in order to print the entire group. 

1. From the File menu, select Print Group. 

2. Select the type of ID you want to print from the ID Type list. All IDs of this type 
appear in the list below the ID Type list. 

3. Select the IDs that you want to print, and select the Add button to list them in 
the Selected IDs box.

4. Repeat steps 2 and 3 for as many ID types as required. You can select multiple 
IDs of multiple types.

5. To change the order of the listed IDs in the Selected IDs list box, select an ID 
and click the up or down Order arrows below the list.

6. When your list of IDs is complete, click OK to proceed with the group print. 

7. Click Yes to proceed or No to cancel the print job.

Edit Menu
Use the Edit menu options to copy and move material from place to place, and to 
delete spreadsheet rows.

Search  Use the Search option to locate a specific leaf value. There are three search 
options: 

ID Information ■ You can view various data about each ID before you delete 
it. Select any ID name in the ID list box, and click the right 
mouse button. An information box for that ID appears.

Search Field Specify Leaf Value or Description.
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Process Menu
The Process menu contains the following options:

■ Run

■ Server Status

■ SQL Talk

Run  Select this option to begin any process.

Server Status  Use this option to check the status of the processes running on the 
server.

SQL Talk  Refer to Chapter 28, "SQL Talk."

Setup Menu
The Setup menu contains one option: Leaves.

Leaves  To access the Leaf Setup window, select Leaves from the Setup menu. 

With Leaf Setup, you can view, edit, insert, renumber, or delete any Leaf Value from 
any Leaf Type in the database. For further information about the Leaf Setup win-
dow, refer to "Leaf Setup" in Chapter 4, "Overview of IDs."

Options Menu
Use the Options menu to set up preferred screen displays, and to change users’ 
passwords.

Search String Type in the Leaf Value or Description.

Search Options Select Case Sensitive if you want your search to match the 
string exactly as you entered it. Select Continue Searching... if 
your search begins part way down the tree (at the cursor loca-
tion) but you also want to search above. 

Click OK to begin the search. When the search is complete 
and successful, the search window closes and the found leaf 
ID is highlighted. If the search string is not found, an error 
message appears.
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Tool Bar  This is a toggle option; that is, it turns the display of the toolbar on and off. 
When the option is “on,” a check mark is displayed.

Status Bar  This is a toggle option; that is, it turns the display of the status bar on and 
off. When the option is “on,” a check mark is displayed.

Customize ID Toolbar  You can customize the vertical toolbar using this option. For 
more information, see the section "Toolbars" in this chapter. 

Change Password  Use this option to change the password for the Current User of this 
OFS application. When you select Change Password, the Change User Password 
window appears.

Tree Bar   When you open a product-based or currency-based ID, the tree bar 
appears. Select a product or currency from the split window. If you worked with 
another product- or currency-based ID during the current work session, the selec-
tions default to the previous product or currency you selected. Otherwise, the selec-
tions default to No Product (0) and Default Currency (000). For all currency-based 
IDs except Forecast Balance ID and Transaction Strategy ID, select Default Cur-
rency (000) to set up assumptions for all the currencies you use. You can move, 
resize, or close the tree bar.

Control Bar  For information about the Control Bar, refer to "Spreadsheet Control Bar" 
in Chapter 4, "Overview of IDs."

Tools Menu
Use the Tools menu to start the Discoverer applications: Oracle Discoverer User Edi-
tion, Oracle Discoverer Administration Edition, and Discoverer Integrator. The 
Tools menu is always present. If an application in not installed, however, its name is 
grayed out and it is not available for use.

Login name The name of the current user appears here.

Current password Enter the current password for the current user. Asterisks 
appear as you type, for security reasons.

New password This box appears blank. Enter the new password for the cur-
rent user. Asterisks appear as you type, for security reasons. 
Click OK to execute the change. Click Cancel to cancel the 
operation and close the window.
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Window and Help Menus
The Window menu options are for managing windows and icons, and for moving 
the cursor between windows.

The Help menu provides an online version of this reference guide.

Status Bar
The Status Bar at the bottom of the screen displays information about current opera-
tions. Position the pointer on any Toolbar icon to display the name of the icon on 
the Status Bar. 

Toolbars
The horizontal and vertical toolbars are panels of icons that support shortcuts for 
menu commands and IDs. 

Horizontal Toolbar
The horizontal toolbar provides shortcuts to menu commands. You cannot custom-
ize this toolbar.

Icon Description

1 New Create a new ID or pattern

2 Open Open an existing ID or pattern

3 Save Save an ID or pattern

4 Print Print results

5 Delete Delete an ID or pattern

6 Close Close an ID or pattern

7 Print Group Print a group of IDs

8 Delete Group Delete multiple IDs

 2

1 7 9 11

2

3

64

5

8 1210

15

14

13

16

17

18
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Two additional icons appear on the horizontal toolbar in Risk Manager and Trans-
fer Pricing. 

9 Group Import/Export Import or export multiple IDs

10 Run Run an ID

11 Report Runner Run an active report

12 Transform Data Run transformation on selected data

13 Set Up Leaves Define user-defined and system leaves

14 Discoverer User Edition Open the user edition of Discoverer

15 Discoverer Administration 
Edition

Open the administration edition of Discoverer

16 Discoverer Integrator Open the OFS/Discoverer Integrator application

17 Leaf Tree Bar Display the leaf tree bar

18 Spreadsheet Control Bar Automate entry of data for spreadsheet-enabled 
IDs

19 Help Access online help

20 Exit Exit the OFS application

Note: The Discoverer icons (14, 15, and 16) are grayed out if the 
application is not installed.

Icon Description

1 User-Defined Payment 
Pattern

Create or edit User-Defined Payment Patterns

2 User-Defined Repricing 
Pattern

Create or edit User-Defined Repricing Patterns

Icon Description

1 2
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Vertical Toolbar
The Vertical toolbar provides shortcuts to the IDs to which you have access in the 
application. Space limitations may restrict the icons that you see on the screen. 
However, you can customize the toolbar for your specific needs. 

To customize the vertical toolbar, complete the following steps:

1. From the Options menu, select Customize ID Toolbar. 

The Customize ID Toolbar window appears.

2. Locate the icon you want to add, delete, or move.

Use the scroll bar on the Customize ID Toolbar window to find the icon that 
you want to add to the vertical toolbar. Or, find the icon on the vertical toolbar 
you want to delete or move.

3. Add, delete, or move the icon.

To add an icon to the toolbar, select and then drag the icon from the Customize 
ID Toolbar window to the vertical toolbar. 

To delete an icon, drag the icon from the toolbar to the Customize ID Toolbar 
window.

To change the order of the icons, drag them individually from one location on 
the toolbar to another.
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Overview of the Process

Risk Manager is designed to model balance sheets under a variety of rate environ-
ments. Risk Manager functionality uses several key concepts and has evolved from 
the continual iterations of building simulated management processes. The basis of 
Risk Manager functionality includes:

■ Modeling at the account-level of detail (loan-by-loan and deposit-by-deposit) is 
the only way to model accurately many of a financial institution’s portfolios.

■ A flexible time horizon and free-form timing bucket increments for reporting 
are critical to meeting the wide range of forecasting requirements of financial 
institutions.

■ Unconstrained chart of accounts definition is a basic requirement of effective 
modeling.

■ A structured process for defining and controlling assumptions is critical to any 
successful modeling process.

■ Unconstrained batching of scenarios, with flexible assumptions sets, is required 
to achieve an effective and efficient analytical process.

Key Operational Concepts
Risk Manager includes six key modeling attributes:

■ Modeling Using Account-Level Data

■ Separation of Data from Assumptions

■ Separation of Assumptions Types

■ Flexible Reporting Buckets

■ A Structured Approach to Defining Rate Scenarios
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Key Operational Concepts
■ Flexible Chart of Accounts

■ Powerful Assumption IDs

Modeling Using Account-Level Data
Risk Manager models data at an account level (loan-by-loan and deposit-by 
deposit). In this way cash flows are precisely modeled based on unique characteris-
tics of each loan and deposit.

Separation of Different Types of Assumptions
By separating data from modeling assumptions, you can modify assumptions and 
then run a reprocessing procedure without affecting data. In addition to the instru-
ment data being separate from assumptions, each type of assumption is defined 
independently from other assumption types. Although they act dynamically dur-
ing a processing run, assumptions about new business characteristics, new busi-
ness volume, new business pricing, new business maturity mixes, prepayments and 
discounting methodology are defined independently. This facilitates the isolation of 
the impact of a change on one assumption. You simply modify the selected assump-
tion, and reprocess in a separate processing run.

Flexible Reporting Buckets
Because the assumptions are separate from the data, and because the model is oper-
ating on an account level of detail, you can specify assumptions and reporting time 
buckets in any increment desired. Since each transaction’s cash flows are being 
solved independently, you can mix and match any combination of time buckets (up 
to 120). Changing the bucket structure will not impact the calculations. Thus you 
might model and report results on a daily and weekly basis for liquidity analysis, 
while employing a monthly five-year forecast for A/L Management. In either case, 
the results produced are consistent.

Structured Approach to Defining Rate Scenarios
Structured testing of alternative rate environments is a key to a strong “what-if” 
analysis process. The model provides numerous utilities for defining and quality 
controlling rate scenarios. Because rate scenario modeling assumptions can be 
saved as patterns in Forecast Rates IDs, the typical burden of quality controlling 
rate scenarios is dramatically reduced. Once a pattern of rate shocks, spread 
changes or yield curve rotations (or combination of the above) is defined, it can be 
saved as a Forecast Rate ID to be used again and again. When data are updated in 
2-2 Oracle Risk Manager Reference Guide



How the Model Works
the model, all you need to do is update the base position of key market rates. The 
change pattern in an ID can be applied and the forecast rate assumptions are auto-
matically updated. It can also easily be cloned and modified to be saved as another 
Forecast Rate ID. This approach for defining rate scenarios is ideally suited for test-
ing numerous rate environments in a controlled fashion.

Flexible Chart of Accounts
You can define an unlimited chart of accounts (Leaf ID Values), incorporating all of 
the key elements which drive cash flow.

The Power of Assumption IDs
You can mix and match any set of combinations of assumptions: forecast rates, fore-
cast balances, pricing margins, maturity strategies, discount rates, prepayments, 
transaction strategies, formula leaves, and leaf characteristics. The separation of 
each element of the scenario assumptions means that you can incrementally modify 
one piece of the modeling equation and easily test its effect. By defining assump-
tions as IDs, unlimited batching of scenarios is possible.

How the Model Works
While the specific operation of each section of the model is addressed separately in 
this guide, a general description of the modeling logic includes the following pre-
mises:

■ The current position data defines the existing base of transactions

■ New business volumes are generated by assumptions

■ The maturity mix of new volumes is defined by assumptions

■ Pricing of new volumes and repricing of existing volumes are defined by rate 
scenario assumptions and the contractual pricing characteristics of individual 
transactions

■ Dynamic prepayment assumptions can be applied to any account

■ Incremental transaction strategies can be used

■ Cash flows are determined through the integration of data and assumptions

■ Assumptions can be flexibly batched
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Current Position Data 
Risk Manager forecasts on the basis of modeling the behavior of existing transac-
tions, as well as those that originate in future periods. The complete cash flow char-
acteristics of each existing transaction are defined in the data structure that is 
imported into the FDM database on a loan-by-loan and deposit-by-deposit basis. 
Accounts are also defined to simulate noninterest income and expense.

New Business Volumes
New Add volumes in each period are defined on the basis of a forecast of new 
incremental volume for each account, or calculated on the basis of achieving a “tar-
get balance” in the account. The cash flow characteristics of newly originated vol-
umes are determined by the Leaf Characteristics ID definitions. New volume 
assumptions apply to noninterest income and expense accounts as well.

The Maturity Mix of New Volumes
The maturity mix of volumes originated for an account is determined by assump-
tions which are applied to each element of the account.

Pricing of New Volumes and Repricing
Pricing of newly originated volumes, or repricing of adjustable and variable rate 
volumes, is determined by the integration of several factors. Each existing or newly 
originated transaction is linked to a single rate (a market rate) or a yield curve. The 
actual rate determined at origination or repricing takes into account the prevailing 
single rate or yield curve. The term of the transaction (if pricing is tied to a yield 
curve) is also taken into account, as well as other pricing characteristics (margin, life 
cap, period cap, etc.). Incremental pricing margins can be applied to new origina-
tions on a period-by-period basis for each account.

Dynamic Prepayment Assumptions
You can apply dynamic prepayment assumptions to any account. Prepayments are 
applied on a loan-by-loan basis. Prepayment assumptions use individual instru-
ments characteristics to drive prepayment behavior. 

Incremental Transaction Strategies
Incremental transaction strategies can be defined which create actual originations or 
sales of assets and liabilities, or off balance sheet transactions.
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Cash Flows
Cash flows for every instrument are calculated in every modeling period according 
to the contractual terms defined in the incoming data and/or leaf characteristics 
definitions, combined with interest rate scenario and prepayment assumptions. 
Principal and interest cash flows are recalculated as contractually defined.

Batching Assumptions
Financial forecasts are built through the integration of current position data with 
each of the modeling scenario assumption elements:

■ Current Position Data (account-level data)

■ Forecast Rate Scenario Assumptions

■ Forecast Balance Assumptions

■ Maturity Strategies

■ Pricing Margins Assumption

■ Prepayment Assumption

■ Transaction Strategies

■ Discount Rate Assumptions (for market value calculation)

■ Leaf (Account) Characteristics Assumptions

■ Formula Leaf (Account) Assumptions

Flow of the Modeling Process
The organization of the Risk Manager menu structure is better understood in the 
context of the general flow of the modeling process, as follows:

1. Set up system parameters, including:

– Certain elements of the system configuration (as of date for data, modeling 
leaves, etc.)

– Data path definitions (drive locations for key data sets)

– Selected modeling parameters which are globally applied in developing 
modeling assumptions and reporting (assumption and reporting date 
buckets, etc.).

2. Load transaction-level data.
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Load data into the system for modeling.

3. Perform cash flow events.

Each of the individual instrument records must be quality controlled. For each 
instrument record, the cash flow edits check all of the columns used in cash 
flow calculations for internal consistency. For example, the maturity date must 
be greater than the origination date, and the payment frequency must be greater 
than zero. This process must be performed in the balance and control process, 
and is a critical step in ensuring that Risk Manager processes properly. For more 
information, see the Oracle Financial Data Manager Balance & Control Reference 
Guide.

4. Define modeling assumptions.

Define assumption sets. These include any number of the assumptions 
described "How the Model Works" in this chapter. 

5. Specify the model run.

Select a combination of assumption sets which will be applied to the data you 
wish to model. You may define a single processing run, or a batch of several 
runs, including multiple sets of assumptions. The run or batch is launched and 
results are produced to results tables.
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Performance Data

Many factors impact the performance you can expect from a Risk Manager process-
ing run. These factors fall into four general categories:

■ Hardware, database, and network performance factors

■ Database activity related to performance factors

■ Software performance factors

■ Multithreading configuration

The impact that hardware, database and network configurations as well as concur-
rent activity (i.e. the number of users and processes running against the database) 
play on the performance of any client/server application is a complex issue and 
beyond the scope of this guide. The intention of this section, however, is to provide 
a thorough understanding of the software-related performance factors in Risk Man-
ager so that a user can judge the relative impact of various Risk Manager process-
ing runs.

The configuration of the multithreading options applies only to processes that are 
run on the server. For more information, see the Oracle Financial Services Installation 
and Configuration Guide.

Processing Steps
Risk Manager goes through a number of processing steps whenever a processing 
run is launched. Depending on the specifics of your institution, as well as the spe-
cific processing run, the amount of time to complete the process varies. The steps of 
a processing run are as follows:
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Reading in Assumptions
The first step in any Risk Manager processing run is to read in all assumption IDs 
into memory (i.e. Forecast Rates, Prepayments, Maturity Strategies, etc.). In this 
step, each ID is read into memory in its entirety. In other words, whether you are 
processing a single instrument record or 1/2 a million, with the same set of IDs, this 
step will take the same amount of time.

For all leaf-related IDs, the number of leaf values (or accounts) for which you made 
assumptions will directly impact how much data needs to be read into memory. For 
a given processing run, if you wish to minimize processing time, create leaf-related 
IDs in which your only assumptions are for the leaf values that you are processing. 
You must create these IDs from scratch - using Save As will bring over all data from 
a previous ID.

The two IDs that usually take the longest to read into memory are the Forecast Rate 
ID and the Leaf Characteristics ID. The Forecast Rate ID is not leaf related, and we 
do not recommend creating too many Leaf Characteristics IDs as this will be harder 
to quality control. The Forecast Balance ID and the Pricing Margin ID also can take 
some time, however. In this case, you may reduce the time it takes to read these into 
memory by only specifying assumptions for the leaves that are included in your 
processing run (an assumption of None counts as an assumption).

Initialize Processing
The next step in a Risk Manager processing run is the initialization of the process-
ing tables that will be updated throughout the process. During this stage (which is 
usually very quick) the following tables are created, updated, or cleared:

■ Risk Manager Detail Results Tables: Risk Manager checks for the existence of 
the RES_DTL_<Sys_ID_Num> table. This will be updated with cash flow and 
gap results throughout the processing run. If this table does not exist, and the 
user has the security rights to create one, it will be created. If it exists, and the 
Selective Reprocessing option is not selected, all of the results will be cleared.

■ Result_Bucket: The Result_Bucket table is updated with all of the date bucket 
header information (i.e. start and end dates for all date buckets). This table will 
be accessed in all date related reports.

■ Result_Header: The Result_Header table is updated with the names of all 
Assumptions IDs that make up the processing run. The ID names can also be 
accessed when generating reports.
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Reading Instrument Data
After the initialization step is complete, Risk Manager will begin the processing of 
cash flows by reading all instrument data specified in your Risk Manager process-
ing ID. In this step, each instrument record is read once no matter how many rate 
scenarios are specified in your processing ID. If you are processing a subset of any 
instrument table the main factor impacting the performance of reading the data is 
whether your filter (or where clause) uses an index. For example, if you are filtering 
on your Risk Manager product leaf, this will result in optimal performance because 
all leaf columns are incorporated in the pre-defined indices for any instrument 
table. If you are filtering on all records with Current Rates > 6.00%, however, it is 
unlikely that you have created an index for this column and therefore the read time 
will be equivalent to reading the entire table. See your database administrator for 
more information.

Processing Instrument Data
Once a record is read into memory, daily cash flows are generated for all scenarios, 
for the entire processing horizon. For all other instruments, processing is optimized 
for instruments whose cash flows are not rate-sensitive. These instruments are iden-
tified by not having a reprice even within the modeling horizon and not have 
rate-sensitive prepayments. These instruments are processed in one scenario only. 
Results for other scenarios are copied from the first scenario.

The number of interest rate scenarios has basically a linear impact on processing 
time. In other words the cash flow calculation time for four interest rate scenarios 
will take about four times as long as for a single interest rate scenario.

Instruments with deferred balances will process much slower than other instru-
ments due to the calculations necessary to determine a constant yield. For more 
information on the deferred calculation, see the discussion of cash flow calculations 
in the Oracle Financial Services Technical Reference Manual.

Another factor which has a significant impact on the cash flow calculation time for 
an instrument record is the number of cash flow “events” that must be processed. 
Any time an instrument makes a payment, reprices or re-computes a payment, it 
impacts the processing time. The total number of events for a single instrument 
record for a single rate scenario is a function of the event frequencies (i.e. Payment 

Note: The steps between reading and processing data are interac-
tively repeated on small subsets of the data; not all data is read 
before processing begins. For performance considerations, how-
ever, these steps can be considered separate.
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Frequency, Repricing Frequency, Payment Change Frequency and Neg-Am Equal-
ization Frequency) and the length of the modeling horizon.

A one-day frequency will take about 30 times as long as a one-month frequency 
because it is processing 30 times as many events. For variable rate instruments, 
there is very little advantage to populating your instrument data with a repricing 
frequency of less than the frequency of the modeling buckets you intend to use. 
Remember that rate scenario assumptions are input for each modeling bucket. So, if 
an instrument reprices every day within a modeling bucket, it will be repricing from 
and to the same rate for all but the first day in the bucket. In fact, due to memory 
limitations, in any processing run, if a single instrument exceeds 16,000 events 
across all rate scenarios, this will generate a warning, and the results will not be 
stored. Depending on your hardware setup, you may run out of memory at a 
threshold of even less than 16,000 events.

The length of the modeling horizon for an instrument record depends on your pro-
cessing options. If you are not processing Gap or Market Value results, and have no 
deferred balances associated with the instrument record, the modeling horizon for 
that instrument record will be the shorter of the maturity date or the end date of 
your last modeling bucket. If you are processing Gap results, or have a deferred bal-
ance associated with a particular record, cash flows will be generated until matu-
rity. Finally, if you are processing market values (and do not have the ‘Reprice as 
Cash Flow’ option selected in your Discount Rates ID) cash flows will be generated 
out to maturity for each instrument record, regardless of the length of the modeling 
or Gap buckets. If you have selected the Reprice as Cash Flow option, the cash 
flows will be generated until the greater of the last modeling or gap bucket, or the 
next reprice date.

One last factor that adds to processing time is the number of financial elements that 
must be accumulated in memory. By selecting fewer output financial elements, you 
will increase overall performance. Fewer financial elements mean that less data will 
be accumulated during processing and less output will be written to the results 
tables.

Writing Results
Risk Manager writes up to four types of results during a processing run. The total 
time it takes to write the results is a function of how many records must be inserted. 
The formulas to determine the number of results rows that will be inserted of each 
type are as follows:
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Cash Flow Results
Cash Flow results are stored in the Res_Dtl_<Sys_ID_Num> table. The number of 
records is determined by:

■ Number of records = Number of Leaf Values (Chart of Account Line Items) 

■ Number of Rate Scenarios (1 - 9)

■ Number of Non-Zero financial elements (depends on financial element set)

Gap Results
Gap results are stored in the Res_Dtl_<Sys_ID_Num> table. The number of records 
is determined by:

Number of records = Number of Leaf Values (Chart of Account Line Items) 

■ Number of Rate Scenarios (1 - 9)

■ Number of Gap start dates (1 - 5)

■ Number of Non-Zero financial elements (depends on financial element set)

Market Value Results
Market Value results are stored in the Result_Master table. The number of records is 
determined by:

Number of records = Number of Leaf Values (Chart of Account Line Items) 

■ Number of Rate Scenarios (1 - 9) 

■ + Number of Gap start dates (1 - 5)

One record is written per leaf value per rate scenario for the current position infor-
mation.

Writing Cash Flow Results
Daily cash flows for up to 5 specific instrument records may be written out to the 
Process_Cash_Flows table. The number of records is determined by:

Number of records = Number of Records processed (if less than 5)

■ Number of Rate Scenarios (1 - 9) 

■ Number of Cash Flow Events

■ Number of Financial Elements (usually10-20)
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Writing specific cash flows is a Processing Option which may generate a lot of 
records, and therefore should only be used when needed.

Processing Formula Leaves
After all cash flow results have been processed, the next step is to process Formula 
Leaves if you have selected the processing option. The processing of Formula 
Leaves can be broken down into the same three steps as processing instrument 
data—read, process, and write.

Reading Formula Leaves Data
The total number of source results records accessed by each type of Formula Leaf 
equation (see Formula Leaves) is computed as follows:

Number of Financial Elements / Leaf Values Referenced in Formulas * Number of Rate Scenarios

Processing Formula Leaves
Once all required data has been read into memory, the processing time required for 
Formula Leaves is a function of the total number of formulas specified - e.g. num-
ber of Formula Financial Elements * Number of Modeling Buckets for a given for-
mula leaf. The complexity of the formulas do not play a major role in the 
performance of processing formula leaves (although it will impact the read time if 
you access many source leaves in your equation).

Writing Formula Leaves Results
For information about the time required to update the results of formula leaves, see 
"Writing Results" in this chapter.

Writing Processing Errors 
When all processing is complete, Risk Manager will update the Process_Errors table 
with all error messages generated during processing. You can limit the number of 
error messages generated in your Configuration ID. This is not a major component 
of processing time, however.

Other Performance-Related Factors Matrix
Factor Impact on Which Processing Step(s)

Number of Leaf Values (Chart of 
Account Line Items)

Reading Assumptions, Writing Results, Formula 
Leaves
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Number of Rate Scenarios Reading Assumptions, Processing Instrument Data, 
Writing Results, Formula Leaves

Number of Cash Flow Events per 
instrument Record

Processing Instrument Data

Length of Modeling Horizon Processing Instrument Data

Number of Dynamic Gap Start Dates Processing Instrument Data, Writing Results

Number of Dynamic Market Value 
Start Dates

Processing Instrument Data, Writing Results

Reprice as Cash Flow option in 
Discount Rates ID

Processing Instrument Data

Factor Impact on Which Processing Step(s)
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4

Overview of IDs

An Oracle Financial Services Application identification (OFSA ID) is a type of dia-
log box that supports the set up of assumptions information, reporting specifica-
tions, or processing specifications. With OFSA IDs, you have the flexibility to define 
as many types of assumptions, report specifications, or processing specifications as 
needed.

You can use an ID immediately after creating it and then discard it without saving 
it. You can also save it and then modify and resave it under another name for use in 
other OFS applications.

This chapter presents the following topics:

■ Creating an ID

■ Opening an Existing ID

■ Closing an ID

■ Saving an ID

■ Deleting an ID

■ Leaf Setup

■ Tree-Related IDs

■ Importing and Exporting Data

■ OFSA ID Dependencies

■ Processing an ID

■ Server Status

■ Spreadsheet Control Bar
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Creating an ID
To create an ID, perform the following steps:

1. From the File menu, select New.

2. From the list of IDs, select the ID you want to create.

The New ID dialog box appears.

3. Select or type in each field, as required, using the following descriptions as a 
reference:

Field Name Field Description

Folder The folder default is set in Configuration ID. Until you set a new default 
in Configuration ID, the default option is <INDIVIDUAL>. This means 
that the user who logged on is the only user who can access this ID.

You can make the ID available to a folder of users. If the user who logged 
on is a member of any folders, you can select the Folder options dialog 
box to view a list of those folders. Select a folder for this ID to make it 
available to all members of the folder. Select <ALL> to make it available to 
everyone.

 Name of ID Type a name for the new ID. When naming IDs, use alphanumeric charac-
ters only. Use an underscore (_) rather than a space.

Description Type up to 60 characters describing the purpose of the ID. The descrip-
tion appears in the ID dialog box and is useful if others access the ID.

This is an optional field.

Permission
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4. Click OK to continue, or click Cancel at any time to cancel the operation and 
exit the dialog box.

Opening an Existing ID
To open an existing ID, perform the following steps:

1. From the File menu, select Open.

2. From the list of IDs, select the type of ID you want to open.

The Select ID dialog box appears. 

3. Select or type in each field, as required, using the following descriptions: 

4. Click OK to continue, or click Cancel at any time to cancel the operation and 
exit the dialog box.

■ Read/Write Read/Write is the default.The individual ID creator always has 
Read/Write capability.

■ Read Only Read Only becomes an available option only when a folder has been 
selected as the folder logon option. 

Note: Some IDs require additional information, such as leaf type 
or reporting currency.

Field Name Field Description

Folder Click the arrow to view a list of folders. Select the name of the folder 
under which this predefined ID was created. The folder you select 
determines which ID choices are listed. 

Additional criteria 
information

Before opening some types of IDs, you must provide additional infor-
mation, such as a leaf type or a Tree Rollup ID. This data determines 
the list of previously defined IDs that appear for your selection.

Variable ID Use the list to select the ID you want to open. (If you know the name 
of the ID, you can type the first letter of the ID to reach that portion of 
the alphabetized list, scroll down and select it.) 

Field Name Field Description
Overview of IDs 4-3



Closing an ID
Closing an ID
From the File menu, select Close.

Saving an ID
From the File menu, select Save.

Save As
You can copy IDs by saving them under a new name. Perform the following steps to 
copy an ID:

1. Select the ID that you want to copy. 

2. From the File menu, select Save As.

The New ID dialog box appears. 

3. Type a folder name and description for the ID and any other data required, and 
click OK. 

The ID is copied and saved under the new name. The original ID remains unal-
tered.

Rename
To rename an ID, perform the following steps: 

1. Open the ID that you want to rename. 

2. From the File menu, select Rename.

The Rename ID dialog box appears. 

3. Type a new name and description for the ID and any other data required, and 
click OK.

The ID is saved under the new name.

You can change the folder using this function, but only if the ID is actually renamed. 
This function does not perform a check for duplicate ID names in the folder.

You can also use Rename to change the Read/Write status for an ID.
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Deleting an ID
To delete an ID, perform the following steps:

1. Open the ID that you want to delete.

2. From the File menu, select Delete.

A Delete Confirmation dialog box appears.

3. Click Yes to confirm your decision, or click No to cancel the operation. 

Deleting a Group of IDs
To delete a group of IDs, perform the following steps:

1. From the File menu, select Delete Group.

The Delete Group dialog box appears. 

2. From the ID Type list, select the Type of ID.

All IDs of that type appear in the large dialog box below it. 

3. Select the IDs that you want to delete, and select Add to display them in the 
selected IDs list.

a. To select multiple IDs of any type, hold down the Shift key while you click 
on them. 

b. To select all IDs of a chosen type, click Select All. 

c. To remove all IDs from the selected IDs list, click Remove All. 

d. Use the arrow buttons to change the position of an ID in the selected IDs 
list. 

e. Select the ID you want to move, and use the up or down arrow to move it 
up or down one position. IDs are deleted in the order that they appear in 
the list.

4. When you have selected all IDs for deletion, select Run from the Process menu.

The Confirm Group Delete dialog box appears.

5. Click Yes to delete the IDs, or click No to cancel the operation.

Note: You cannot import or export IDs while Group Delete is 
open.
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Leaf Setup 
With Leaf Setup you can view, edit, insert (or, in other words, create), renumber, or 
delete any leaf value from any leaf type in the database.

Leaf type and leaf column are synonymous. A leaf type is any column registered in 
the database as a leaf column. For example, GL Account ID, Org Unit ID, Common 
COA ID, and Financial Element ID are all leaf types.

Leaf values compose the next highest level of categorization above detail account 
level. This level is known as the leaf level and provides the foundation for the struc-
ture of a Tree Rollup ID.

Leaf capacity is 200,000 leaves. This increased capacity enables institutions to model 
increasingly complex profitability scenarios.

Creating a Leaf Setup Dialog Box
To create a Leaf Setup dialog box, perform the following steps:

1. From the Setup menu, select Leaves.

The Leaf Setup dialog box appears.

2. To view, edit, renumber, delete, or add any leaf value, select the leaf type that 
you want from the Leaf Type list.

3. Search for the leaf value that you want.

Note: You can display as many as 16,000 leaves at a time.
4-6 Oracle Risk Manager Reference Guide



Leaf Setup
You can search for a leaf value either by using Leaf Value or Leaf Description. 
Leaf Value is the default. Because you can display a maximum of 16,000 leaves 
at a time, Leaf Value is recommended when you do not know the exact leaf 
value or description.

a. If you select Leaf Value, type the From and To Leaf Values in the Range of 
Leaf Values and then select Display.

The Leaf Value and Leaf Description lists for the range that you specified 
appear.

b. If you select Leaf Description, type the description in the Search String field 
and select a Search Option, if appropriate.

The Leaf Value and Leaf Description lists for the description that you 
specified appear.

Note: To search for an exact match, type the value in both the 
From and To fields.
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4. To edit a Leaf Value or Leaf Description, select the Leaf Value that you want to 
edit and then click the Edit button.

The Edit Leaf Info dialog box appears.

Field Name Field Description

Description Leaf description, such as Average Net Rate

Account Type Such as Dividends or Equity

Aggregation Method Such as Average by Days Weighted or Beginning

Column Name Physical column name, such as AVERAGE_NET_RATE

Display Name Can be same or more detailed name as Description or Column 
name
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5. To edit leaf information, select the appropriate Check to Edit options, make 
your changes, and click OK.

6. To renumber a leaf value, select the leaf value that you want to renumber and 
then click the Renumber button.

The Renumber Leaf Value dialog box appears.

7. Type the new number in the New Leaf Value field and then click OK.

8. To delete a leaf value, select the leaf value that you want to delete and then click 
the Delete button.

The Confirm Leaf Delete dialog box appears.

9. Click Yes to delete the leaf value, or click No to cancel the operation.

10. To add a new leaf value, select the leaf type to which you want to add and then 
click the Insert button.

The Enter New Values dialog box appears.

11. Type in the Leaf Value and Description and, depending on the leaf type, any 
other information about the new leaf.

12. Click OK to add the leaf value, or click No to cancel the operation.

Aggregation Methods for Financial Elements
Aggregation methods—Average, Accrual, Sum, First, and Last—are applied to the 
summary financial information calculated at each event in order to generate finan-
cial element data for each modeling period.

Weighting Element Balance used to weight the financial element. For example, Aver-
age Transfer Rate has a Weighting Element Average Balance.

Column Property Values (Balance, Balance Weighted Object, Standard Rate, or Sta-
tistic) that determine whether the element requires currency con-
version in processing or rate aggregation for reporting

Note: All non-common Chart of Accounts (COA) leaves need to 
be tied to the detail leaf. The detail leaf determines the account type 
and accrual basis.

Field Name Field Description
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Average Method
The average method calculates an average value (for example, Average Bal-
ance, Average Net Rate) over a modeling period. The calculation sums up the 
daily values and divides by the number of days in the modeling period.

Daily Average Balance = ∑(Daily Balance)/days in modeling period

All simulated events (originations, payments, prepayments, and repricing) are 
assumed to occur at the end of the event date. This implies that the balance and 
rate on the day of an event is counted as the value prior to any changes made 
by the event. Changes made influence the value of the next day.

Accrual Method
The accrual method determines how much accrual has occurred over the mod-
eling period. The accrual method is determined by the code value in the detail 
record. Interest-in-advance instruments calculate interest accruals from the cur-
rent payment date to the next payment date. Interest-in-arrears instruments cal-
culate interest accruals from the current payment date to the previous payment 
date.

The interest cash flow is divided by the number of days between these two 
dates to determine a daily accrual for each day within the modeling term. Daily 
interest accruals are summed by modeling period.

Daily Interest Accrual = Interest Cash Flow/ number of days in payment

The example below demonstrates an interest accrual for an arrears record:

Example:

Modeling Start Date = January 1

Payment Date Interest Cash Flow Days in Payment Daily Accrual

January 15 950 31 30.64

February 15 900 31 29.03

March 15 850 28 30.36

Modeling Period End 
Date Accrual Calculation Interest Accrual

January 31 15 days @ 30.64 + 16 days @ 
29.03

924.08
4-10 Oracle Risk Manager Reference Guide



Leaf Setup
Sum
The sum method adds together all financial element values associated with 
events occurring during the modeling period. 

Principal Runoff = ∑(Principal Runoff)

First 
The first aggregation method determines the value from the first event within a 
modeling period (for example, Beginning Balance).

Last 
The last aggregation method determines the value from the last event within a 
modeling period (for example, Ending Balance).

Selecting an Aggregation Method
To select an Aggregation Method, perform the following steps:

1. From the Setup menu, select Leaves.

The Leaf Setup dialog box appears.

2. From the Leaf Type list, select the leaf type you want.

3. Search for the leaf value that you want.

You can search for a leaf value either by using Leaf Value or Leaf Description. 

a. If you select Leaf Value, type the From and To Leaf Values in the Range of 
Leaf Values and then select Display.

The Leaf Value and Leaf Description lists for the range that you specified 
appear.

February 28 13 days @ 29.03 + 15 days @ 
30.36

832.79

Note: To search for an exact match, type the value in both the 
From and To fields.

Modeling Period End 
Date Accrual Calculation Interest Accrual
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b. If you select Leaf Description, type the description in the Search String. field 
and select a Search Option, if appropriate.

The Leaf Value and Leaf Description lists for the description that you 
specified appear.

4. From the Leaf Value and Leaf Description lists, select a leaf value and then click 
the Edit button.

The Edit Leaf Info dialog box appears.

5. From the Check to Edit list, select Aggregation Method if it is not already 
selected.

6. Select an Aggregation Method and then click OK.

Tree-Related IDs
Many OFSA IDs function in the context of leaf columns. An example is the defini-
tion of modeling assumptions (such as Transfer Pricing methods or prepayments) 
on the basis of a Product ID (or product segmentation.).

Examples of tree- or leaf-related IDs include the Tree Rollup ID, Tree Filter ID, 
Transfer Pricing ID, and Prepayment ID. Tree Rollup IDs, for example, enable the 
user to drill-down to an appropriate level before making an assumption. The user 
can drill-down to the level of detail needed for the particular purpose.

The OFS applications in which these and similar IDs function include Performance 
Analyzer, Risk Manager, Transfer Pricing, and Balance & Control.

Hints on Editing Tree-Related IDs
When editing Tree Rollup ID and Tree Filter ID, you can use the Options and Tree 
menus to format the appearance of your ID. For example, you can change typeface 
or specify which branches are to be included in the rollup. You can use the Edit 
menu to search for a specific node within the tree structure. For more information 
about these menus, see Chapter 25, "Tree Rollup ID" and Chapter 24, "Tree Filter 
ID".
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Importing and Exporting Data
You can use IDs for importing and exporting data in Performance Analyzer:

Importing and Exporting IDs
You can use import/export functionality of OFSA to:

■ Transport IDs from one FDM database to another

■ Maintain external backup copies of key IDs

■ Load data into FDM from an external database (.DBF) source

OFSA provides two methods of importing and exporting IDs:

■ Individual ID import/export 

■ Dependent ID import/export

Individual ID Import/Export
IDs that do not contain other embedded IDs, such as Leaf Characteristics ID and 
Transfer Pricing ID, are imported and exported using the Individual ID method. 
These IDs are exported into a dBase file with the.DBF extension and can be 
imported only from a dBase file with the .DBF extension.

Note: You can load Ledger Stat records using the server side pro-
cess only. For information about loading Ledger Stat records using 
the server side process, see the Oracle Financial Services Installation 
and Configuration Guide. 

Note: You must configure the ODBC drivers before you can 
import and export IDs. For information about configuring the 
ODBC drivers, see the Oracle Financial Services Installation and Con-
figuration Guide. 
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Individual ID import/export is available for the following IDs:

■ Table ID

■ Allocation ID

■ Leaf Characteristics ID

■ Transfer Pricing ID

■ Historical Rates ID

■ Discount Rates ID

■ Maturity Strategy ID

■ Pricing Margin ID

■ Forecast Rates ID

■ Result Detail ID

■ Transaction Strategy ID

■ Forecast Balance ID

■ Prepayment ID

The Individual ID method of import replaces an existing ID of that type in the 
import database. You cannot import an ID using the Individual ID method without 
replacing an existing ID.

To import an ID, open the ID that you want to overwrite and select File -> Import.

Note: Table ID and Allocations ID are an exception to this rule 
because they use Individual ID import/export. They may also con-
tain other embedded IDs. Dependencies are not exported along 
with Table IDs or Allocations IDs. You must export all dependen-
cies separately.

Caution: If you do not want to lose any existing IDs, create a new 
ID of the type being imported or use Save As from the File menu to 
create a copy of the existing ID before import.
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Dependent ID Import/Export
IDs that contain other embedded IDs, such as Correction Processing ID, are 
imported and exported using the Dependent ID method. This method ensures that 
any dependent IDs required for correct operation of the exported ID are included in 
the export process.

Dependent ID import/export is available for the following IDs:

■ Data Filter ID

■ Tree Rollup ID

■ Tree Filter ID

■ Formula ID

■ Correction Rule ID

■ Correction Processing ID

■ Group Filter ID

Any ID that is exported using the Dependent ID method creates a dBase file with 
the .CAT extension and one or more dBase files with extensions listed in the table 
below. Although the extensions differ from the standard .DBF, these files all use the 
dBase format. Importing these IDs requires that all files created in the export pro-
cess reside in the same directory. Dependent ID import/export uses the following 
file extensions:

ID or Data Type File Extension

Catalog of IDs .CAT

Filter ID .FLT

Report Leaves .LF

Level Description .LEV

Node Description .NOD

Report Columns .RCL

Correction Rule ID .COR

Error Assignments .ASS

Correction Processing ID .PRC

Tree Filter ID .TFT

Tree Rollup ID .ROL
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If a tree rollup ID that contains leaves not in leaf setup is imported, you receive a 
warning. If you elect to continue, the ID is imported but the leaves are not added to 
the leaf setup. You can use the Synchronize Instruments function to synchronize the 
Rollup ID with the leaf setup.

Group Import/Export
Use the Group Import/Export dialog box to import or export multiple IDs of vari-
ous types. To import or export a batch of IDs, perform the following steps:

1. From the File menu, select Group Import/Export.

The Group Import/Export dialog box appears. The Group Import/Export dia-
log box resembles a spreadsheet, where each row represents one import or 
export operation.

2. Click Insert Rows without highlighting any rows to add a row to the top of the 
spreadsheet.

If any rows are highlighted, selecting Insert Rows adds an equivalent number of 
rows immediately before the highlighted section. 

3. Click Delete Rows to remove any highlighted rows from the spreadsheet. 

If no rows are highlighted, selecting Delete Rows removes the first row from the 
spreadsheet.

You can use the Group Import/Export columns as follows:

Formula ID .FOR

Group Filter ID .FGL

Note: If a dependent ID import fails during processing, change 
the file name extension from .DBF to its original form and exten-
sion and reprocess.

Column Name Column Description

Done As IDs are imported or exported, a red check mark appears in 
the dialog box indicating that the job is complete. 

Action Click Import or Export for each ID on your list.

ID or Data Type File Extension
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From the Process menu, select Run to run Group Import/Export.

OFSA processes the rows on your spreadsheet in sequential order, starting with the 
first row.

Export an ID with Group Import/Export
To export an ID using the Group Import/Export dialog box, perform the following 
steps:

1. Select Export in the Action list.

2. Select the ID Type and ID Name you want to export. 

3. Double-click in the PC File Name cell to display the Select Export File dialog 
box.

4. Type a valid file name for the export and click OK.

File Type The only file type that you can select for Import or Export is 
dBase.

ID Type Use the list to select ID types available for import or export.

ID Name Use the list to view previously selected ID types. This field is 
active when exporting an ID or when importing an ID with the 
Individual ID method. When importing with the Dependent ID 
method, <not required> appears in the dialog box.

PC File Name Double click in this field to open Select Import File if you are 
importing an ID or Select Export File if you are exporting an ID.

Column Name Column Description
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Individual ID exports must use .DBF as their file extension. Dependent ID 
exports must use .CAT as their file extension. If the file name that you have 
selected is not valid, you must select a new file name.

5. From the Process menu, select Run to run Group Import/Export.

OFSA processes the rows on your spreadsheet in sequential order, starting with 
the first row.

If the export file name that you have chosen already exists and the file is not 
read-only, you are asked if you want to overwrite the existing file.

6. Click Yes to replace the existing file with your export file.

7. Click No to cancel the export process and select a different name for your 
export file.

Export an ID from the File Menu
To export an ID using the Export option in the File menu, perform the following 
steps:

1. Open the ID that you want to export.

2. From the File menu, select Export.

The Export ID dialog box appears.

3. Click Browse to bring up the same Select Export File dialog box used for export-
ing with Group Import/Export.

4. Type a valid file name in the export data File Name dialog box.

5. Click OK to export your ID.

Import an ID with Group Import/Export
To import an ID using the Group Import/Export dialog box, perform the following 
steps:

1. From the File menu, select Import/Export Group.

The Group Import/Export dialog box appears.

2. Click Import in the Action dialog box. 
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3. Select the ID Type of the ID that you want to import. 

4. If the ID Type that you select relies on the Individual ID import method, select 
an existing ID to overwrite in the ID Name dialog box.

If the ID Type you select relies on the Dependent ID import method, <not 
required> appears in the ID Name dialog box. 

5. Double-click in the PC File Name dialog box.

The Select Import File dialog box appears.

 

The Select Import File dialog box looks and functions almost the same as the 
Select Export File dialog box. The primary difference is in the file name validity 
check that is performed before you are returned to the Group Import/Export 
dialog box. A file name is valid only if it has the necessary file extension, .DBF 
for Individual ID imports and .CAT for Dependent ID imports, and if it is found 
in the designated directory. If a file does not have the necessary file extension, 
or if it is not found, you must select a new file name.

If you import an ID that uses the Dependent ID method, you are importing the 
original ID along with any embedded IDs used in its functionality. You import 
these IDs with the same <Name>/<Group> combination that they had in the 
original database. 

Caution: Individual ID import overwrites the ID listed in ID 
Name with the contents of the imported ID. As a result, you lose 
any information contained in the ID being overwritten. If you do 
not want to lose any existing IDs, create a new ID of the type being 
imported or use Save As from the File menu to create a copy of the 
existing ID before import.
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6. From the Process menu, select Run to process all the rows on your Group 
Import/Export spreadsheet.

If any of the <Name>/<Group> combinations for the IDs you are importing (or 
for any IDs embedded in your imported IDs) are already being used in your 
import database, the Import Warning dialog box appears. The Import Warning 
dialog box offers you three options of how to proceed when the ID you are 
importing or one of its dependent IDs already exists in your import database:

■ Rename

To change the <Name>/<Group> combination of the ID that you are 
importing so it does not conflict with any IDs already present in the import 
database. After typing a new <Name>/<Group> combination for the ID 
that you are importing, click OK to continue with the import.

■ Use Existing

To use the existing ID in the database with the same <Name>/ <Group> 
combination as the ID that you are importing. You can use Use Existing 
when you need to import multiple IDs that share one dependency ID.

■ Cancel

To cancel the import process. Selecting Cancel before all the rows in the 
Group Import/Export dialog box have been processed generates the Import 
Warning dialog box.

Click Yes to stop the Group Import/Export process. Click No to skip the 
current row on the Group Import/Export dialog box and continue 
processing the subsequent rows in sequential order. 

In either case, all IDs imported prior to your clicking Cancel remain in the 
import database.

Import an ID from the File Menu
To import an ID using the Import option in the File menu, perform the following 
steps:
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1. Open the ID that you want to import.

2. From the File menu, select Import.

The Import ID dialog box appears.

3. Click Browse to bring up the same Select Import File dialog box used for 
importing with Group Import/Export.

4. Type a valid file name in the import data File Name dialog box.

5. Click OK to import your ID.

If your import uses the Individual ID method, you overwrite the open ID with 
the contents of the ID you are importing. As a result, you lose any information 
contained in the ID being overwritten.

6. If you encounter the Import ID dialog box, refer to the end of the previous sec-
tion, "Export an ID with Group Import/Export", for instructions on how to pro-
ceed.

Rules, Limitations, and Hints
The Import/Export function is limited in scope. Keep in mind the following rules 
and limitations:

■ If an ID is imported and the <Group> it was created in does not exist in the 
import database, the ID is placed in the default <Group> specified in the 
Configuration ID.

Caution: Individual ID import overwrites the ID listed in ID 
Name with the contents of the imported ID. As a result, you lose 
any information contained in the ID being overwritten. If you do 
not want to lose any existing IDs, create a new ID of the type being 
imported or use Save As from the File menu to create a copy of the 
existing ID before import.
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■ Group Import/Export works only between databases that have identical 
structures. Different versions of the applications may use different database 
structures.

■ Correction Processing IDs using the OFSA Cash Flow Edits cannot be imported.

When importing an ID of a given type, at least one ID of that type must already 
exist in the database or the import fails. No error message is displayed.

OFSA ID Dependencies
OFSA IDs often depend on other IDs for some or all of their data or usefulness. For 
example, a Transformation ID may depend on a particular Filter ID to select and 
focus data in a meaningful way. The Filter ID may have been created especially for 
that transformation and named in the transformation set up dialog box when the 
Transformation ID was created. If that Filter ID is deleted, then the transformation 
becomes unusable.

OFSA provides a Dependencies option in the File menu that enables you to view 
the dependencies factors of any active ID. This option shows both primary and sec-
ondary dependencies. For example, a Data Filter ID dependency may include a Pro-
cessing ID as a primary dependency and a Batch ID as secondary dependency 
(depending on the Processing ID). 

Also, when you click Delete ID or Delete Group of IDs, OFSA automatically checks 
for any dependencies, and enables you to review them before the deletion takes 

Note: Some .DBF files may require structural changes to import 
correctly into your FDM database. Before importing a 
non-OFSA.DBF into a particular database, export a similar type of 
ID to .DBF from that database. In your external database applica-
tion, compare its structure to the non-OFSA file you want to 
import. Correct any structural differences in the non-OFSA file, and 
try the import it. If you experience problems, contact Oracle Sup-
port Services.

Caution: Consider OFSA ID Dependencies when you delete an 
ID. Deleting an ID may deprive a dependent ID of its meaning.
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place. When you attempt to delete an ID, however, note that only primary depen-
dencies are listed in the warning. 

Processing an ID
To process an ID, select Run from the Process menu. In most cases, the process pro-
ceeds immediately, without further prompting from the system.

Server Status
Most OFS applications can launch calculation-intensive software processes on a 
server. The server runs the process in the background, freeing the client PC to do 
other activities. Also, the server is often more powerful and can finish the process 
more quickly than the client PC.

When a server process is launched by an OFS application, the job request first is 
processed by RQ, the special OFS application that monitors OFSA server process-
ing. RQ enters the job in a special table, and sends the job to the server. RQ then 
monitors the progress of the job on the server until it has completed, logging that 
information in its table.

When an OFS application launches a server job, the Server Status Update dialog box 
appears. Getting its data from RQ, the dialog box displays the progress of your 
server jobs or, optionally, displays all jobs on the server. Also, you can terminate any 
of your processes that are running on the server.

In System Administration, the capabilities of the Server Status Update dialog box 
have been expanded. The Server Status Update dialog box:

■ Enables you to terminate any job running on the server, not just those jobs you 
have launched yourself

■ Incorporates a test function to validate the ADMN - RQ - SERVER links

■ Provides a housekeeping capability, enabling you to delete completed jobs from 
the RQ table

Note: Click Dependencies from the File menu if you plan to delete 
unfamiliar IDs.
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Using the Server Status Update Dialog Box
To open the Server Status Update dialog box, select Server Status from the Process 
menu. The Server Status Update dialog box appears.

View Your Jobs or All
■ See your jobs

Select this option to view the status of your own server jobs.

■ See all jobs

Select this option to view the status of all jobs running on the server.

Stop Job
Select any of your own server jobs, and click this option to stop it. This function is 
not a Pause. Once stopped, the job cannot be continued. You must restart it from its 
source application. This option does not cancel jobs that have not begun execution.

Insert Test Request
This option starts a simple job to ping the server, testing network connections and 
protocols. Click Stop Job to halt the test, and click Remove YOUR Finished Jobs to 
delete the job from the display. If the test fails, the Cannot Launch Request error 
message appears.

Remove YOUR Finished Jobs
Select this option to delete all finished jobs from the display. The Request Clean Up 
verification box appears when the jobs have been removed. You click OK to close it.

Note: In this OFS application, the Server Status Update dialog box 
enables you to stop your own server jobs only. In System Adminis-
tration, the dialog box enables you to cancel of any job running on 
the server.

Caution: Selecting Remove YOUR Finished Jobs does not halt 
processing of a server job in progress. The job is deleted from the 
display (and from the RQ table) but continues to run to completion 
on the server. 
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Server Polling Indicator
At the left side of the dialog box is a blue wheel that moves up and down the dia-
log box. The wheel indicates that OFSA is polling the database.

The Status Display
Through this interface you can monitor active server jobs. 

Interface Definition

Job Description Name of the ID being processed

Table Name Name of the table being processed against

Step/Page Step or Page being processed

Host Not currently implemented

Record Number of records being processed

User User’s login name

Title Description or status of the process

Status Indicates whether of not the job has completed

Job Return Status Indicates successful process or an error code. Possible return 
codes include:

■ Making request (Indicates that the client has made a 
request to the server, but it has not yet been acted 
upon)

■ No INI found (Indicates that, on startup, the server process 
could not find the server ini file. This file should be located 
in the same directory as RQ (usually /bin/rq under the 
OFSA install directory). Either the file does not exist (being 
deleted or moved after RQ started) or it is not readable 
(someone changed the modes on the file)

■ None: Running (Job is currently running)

■ Failed on Fork (Normally indicates that RQ was unable to 
execute the requested application. This can occur if the path 
in the server ini file is incorrect (for example, the OFSA 
software suite is not installed normally or is moved after it 
is installed). This message could also indicate that the 
permissions on the executable are incorrect.)

■ None: Canceled (Indicates the process has been canceled, 
either from the client or from the server, with signal 1, 2, or 
15 (SIGHUP, SIGINTR, or SIGTERM, respectively).
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■ Job Return Number (Job returned an unrecognized status)

■ Normal (Indicates the job terminated normally)

■ Bad Usage (Indicates that the subprocess failed to start 
because the parameters were not passed correctly. With the 
current releases of OFSA, this should not happen.)

■ Session Failure (Indicates that the application was not able 
to create a session. Check the server log file for additional 
information.)

■ No memory (Indicates that the server application ran out of 
memory)

■ Internal Error (Indicates that some error occurred within the 
server application. This is normally a database error. Check 
the server log file for additional information.)

■ Internal Error (Indicates that some error occurred within the 
server application. This is normally a database error. Check 
the server log file for additional information.

■ Connect Failure (Indicates that the server process was 
unable to connect to the database. An incorrect 
user/password is probably the reason. Check the log file for 
more information. This can occur if the password is 
changed after starting up the application but before running 
a server process.)

■ Rights Violation (Indicates that the specified user does not 
have the proper rights to run the program. This can occur if 
an administrator changes the rights for a user after the user 
started a client application but before the server application 
is launched.

■ Signaled: <number> (Indicates that the process stopped 
running due to a signal. Check the log file for additional 
information. The number shown is the negative of the 
number that caused the process to halt. The most common 
number is -11.)

Request Date Date and time when request is inserted into OFSA Request 
Queue.The date and time are from the client PC.

Start Date Date when OFSA Request Queue launches process

Start Time Time when OFSA Request Queue launches process

End Date Date and time when process completes

Interface Definition
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Changing a Password
To change your password, perform the following steps:

1. From the Options menu, select Change Password.

The Change Password dialog box appears, with your login name (such as the 
name of the current System Administration user) at the top.

2. Type your current password. 

For security reasons, asterisks appear instead of the characters you type.

3. Type your new password, and then click OK.

You are prompted to confirm the new password.

4. Retype the password exactly as you did the first time.

5. Click OK when you are done, or click Cancel at any time to close the Change 
Password dialog box and return to the main window.

Spreadsheet Control Bar
The Spreadsheet Control Bar, available through the Stratification ID, automatically 
calculates and enters incremental ranges of data into your spreadsheets, such as for 
interest rates or amounts. The Spreadsheet Control Bar offers five incremental meth-
ods for automatically calculating ranges of data.

Increment Methods
Following are descriptions of the five Increment Methods and their uses:

Priority Processing priority in order of importance or urgency

Note: OFSA passwords are case-sensitive. When you log on to the 
database via any OFS application, you must type your password 
exactly as you typed it here.

Interface Definition
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Increment by Value
The increment is applied as a constant value amount (such as 1.00 or -1.50) that is 
cumulatively added to the value of the Start Value. Type an Increment Value and 
then click Run.

Increment by Percent
The increment is calculated as a cumulative percentage increase over the Start Value 
(with 100 percent specified by the value 100). Type an Increment Value and then 
click Run.

Add to by Value
A constant amount is added to the current value of each of the values in the ID. (For 
example a value of 1.5 adds 1.500 percent to each value.) This increment does not 
accumulate. Type an Increment Value and then click Run.

Add to by Percent
Each value is increased by a constant percentage over its current value (with a 100 
percent increase specified by the value 100). This increment does not accumulate. 
Type an Increment Value and then click Run.

Interpolate
Interpolate inserts into the From/To columns an evenly-divided series of values cal-
culated between a Start and End value, leaving the selected first and last row val-
ues intact. Type a Start Value and an End Value and then click Run.

 

When the interpolation is Run, the results are as follows:
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The interpolated values from the 10-to-30 range are evenly distributed between the 
original values of 0 (selected row 2) and 30 (selected row 5). The To column values 
also have been correctly interpolated.

Interpolation in Auto Increment
Interpolation enables you to create interpolated buckets based on a start- and 
end-value. This method does not update the end value specified in the Auto Incre-
ment dialog box, however. You must manually enter that value.

Increment a Range of Values
To automatically increment a range of values, perform the following steps:

1. From the horizontal tool bar, click the Spreadsheet Control Bar icon to open the 
Control Bar.

2. Select a range of values in the spreadsheet.

In the Control Bar, the value from the first row in your selected column is trans-
ferred to the Control Bar’s Start Value dialog box:

Note: You can move the dialog box to another, perhaps more con-
venient, location on your window. Place your mouse pointer in the 
Control Bar’s title bar, and hold the left mouse button while you 
drag the dialog box to a new location.
Overview of IDs 4-29



Spreadsheet Control Bar
The Method list is at the top of the Control Bar. It displays Inc by Value when it 
becomes active. From the Method list, you can open a list of five increment 
Methods.

3. Select the increment method that you want to use and then click Run from the 
Process menu.

.

Using Spreadsheets
In addition to using the Control Bar to enter rates in a spreadsheet, you can also 
copy and paste to and from spreadsheets in other applications.

Note: You can move the dialog box to another, perhaps more con-
venient, location on your window. Place your mouse pointer in the 
Control Bar’s title bar, and hold the left mouse button while you 
drag the dialog box to a new location.
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5

Batch ID

With a Batch ID, you can group time-consuming tasks for processing after hours or 
on weekends.

This chapter presents the following topics:

■ Defining a Batch ID

■ Processing a Batch ID

■ Editing a Batch ID

The Batch ID Window
In the Batch ID window, you select groups of IDs for batch processing.
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ID Type
When you select an ID type from the list, all the predefined IDs of that type are 
listed in the ID Type window.

ID Information Dialog
To locate the ID or IDs that you want, view summary information by selecting an ID 
and clicking the right mouse button. The ID Information dialog box opens. When 
you have finished viewing the data, click OK.

Selected IDs Window
Select the IDs you want to batch process and click Add. The ID names appear in the 
ID Name list. To select multiple IDs, hold the Shift key while selecting ID names. To 
add all of the IDs in your list, click Select All. When you have selected all the IDs 
you want to batch process, click Add. To remove an ID from the ID Names list, 
select the ID and click Remove. To remove all IDs from the ID Names list, click 
Remove All.
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Start Date and End Date
These settings select the period in which you want the allocations or IDs to process. 
If you select Current Date, the system adopts the default As of Date. Choosing spe-
cific Start and End dates overrides the default As of Date.

Order of Process Arrows
The IDs are processed in the order in which they are listed in the Selected IDs win-
dow. To change the order, select an ID and use the up or down arrows to change its 
location in the list. When the order is correct, select Run from the Process menu.

Creating a Batch ID
To create a Batch ID, do the following:

1. From the File menu, select New - > Batch ID. 

2. Complete each field, as described in "The Batch ID Window" in this chapter.

3. Click OK.

Processing a Batch ID
You can process Batch IDs in serial or parallel mode. In serial mode, each ID is pro-
cessed one after another. Serial mode is the default setting. In parallel mode, all IDs 
in Batch ID are run concurrently. Parallel processing may lengthen your processing 
time.

To enable parallel processing, you must modify your OSF.ini file. The appropriate 
parameter value in the [PARALLEL_BATCH_SERVER_PROCESSING] section of 
the .ini file must be changed to 1.

Note: For security reasons, Batch IDs are application-specific. You 
cannot use a Batch ID defined in one Oracle Financial Services 
(OFS) application in another OFS application. Accordingly, Batch 
IDs cannot have the same name, even though they appear in differ-
ent OFS applications.

Note: If any IDs are dependent on other IDs, or if IDs access any 
of the same data, you cannot run parallel processing.
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Editing a Batch ID
To process a Batch ID, do the following:

1. Select Run from the Process menu. A spreadsheet window shows the status of 
each of the IDs being run. 

2. Select Save from the File menu.

Editing a Batch ID
To edit a Batch ID, perform the following steps:

1. From the File menu, select Open - > Batch ID.

2. Select the ID you want to edit.

3. With the ID open, make your changes.

4. Select Save from the File menu.

You can use the Save As option in the File menu to save your edited ID under a new 
name.

Note: Processes that run on the server may show a complete sta-
tus before they have actually completed. To check the status of pro-
cesses running on the server, select Server Status from the Process 
menu.
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Configuration ID

The Configuration ID sets basic default values for working in Risk Manager and 
other applications. You can create a number of Configuration IDs with different 
defaults, each for a different use. Configuration IDs created in either Risk Manager 
or Transfer Pricing are available in both applications. Other applications, such as 
Performance Analyzer, use the as-of date from the Configuration ID. 

Changes made to a Configuration ID in one application affect other applications 
that use Configuration ID settings. Changes made by one user affect all other users, 
with the exception of the Activate and Folder Name settings (see "Configure ID" in 
this chapter.) Any user with rights to the folder in which the Configuration ID 
resides can modify the Configuration ID. 

Creating a Configuration ID
To create a new Configuration ID, do the following:

1. From the File menu, select New -> Configuration ID.

2. Select a folder.

3. Enter a descriptive name for the ID.

4. Enter a description for the ID. This is an optional field.

5. Click Read/Write.

6. Click OK.

The Configuration ID appears.
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7. Type values and select options as described in "The Configuration ID Windows" 
in this chapter.

8. From the File menu, select Save.

The Configuration ID Windows
You define Configuration ID values in the following windows: Configure ID, 
Modeling Buckets, Autobalancing Leaves, and Dynamic Buckets.

Configure ID
The Configure ID window sets the following default values:

Company Name Appears as the heading on reports.

As-of Date Defines the beginning point for processing data. The as-of 
date should match the as-of date on the data you are 
processing. Only data corresponding with the as-of date in the 
active Configuration ID is processed.

Data Directory Determines the default directory for exporting reports and IDs 
to disk.
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Activate Determines which Configuration ID is active. You can have 
only one active Configuration ID at a time. Clicking the 
Activate button makes the displayed Configuration ID the 
active ID for the current user. The same Configuration ID can 
be active in one application but not in another, or active for 
one user but not another. You can save a Configuration ID 
without making it the active ID. This default is saved with 
your user ID so that another user can specify a different active 
Configuration ID without affecting your ID.

Permission 
Settings

Determines the default permission setting for all subsequent 
IDs: 

■ Read/Write—other users can change or delete an ID

■ Read Only—other users can use but not change or delete 
an ID

Folder Name Lists the folders you can access. Selecting a folder makes it the 
default location for subsequent IDs that you create, rename, or 
copy (Save As). This default is saved with your user ID so that 
another user can use the same Configuration ID with a 
different default folder without affecting your ID. See 
Chapter 4, "Overview of IDs" for more information on folders. 

Organizational 
Unit Leaf

Defines which leaf to use as the organizational unit if you 
selected either product/organizational unit or 
product/organizational unit/currency in the Process ID. If 
you specify an obsolete leaf type, the application will not run.

Product Leaf Determines the leaf you use as your Chart of Accounts leaf. 
Many OFSA IDs are defined at the product leaf level. 

Leaf 
Characteristics ID

Sets the default characteristics for each new transaction 
strategy. Each time you create a new transaction strategy in 
the Transaction Strategy ID, the default characteristics will be 
pulled from the Leaf Characteristics ID you specified in the 
active Configuration ID.
Configuration ID 6-3



The Configuration ID Windows
Modeling Buckets
Modeling buckets specify the time periods used for storing and reporting results. 
The Configuration ID modeling buckets set the modeling horizon for date-related 
IDs. When you change the number or frequency of the modeling buckets, existing 
IDs are affected.

You can specify any combination of days, months, and years when setting up the 
buckets. Although all Risk Manager cash flows are generated on a daily basis, they 
are dropped or aggregated into defined modeling buckets when results are stored. 
Reports access information from the modeling buckets and let you aggregate 
buckets. For example, you can define monthly modeling buckets but generate a 
quarterly income statement. On the other hand, you cannot generate a weekly 
balance sheet if all modeling buckets are monthly.

If you want to use different configurations of modeling buckets, such as all monthly 
or all quarterly, you should create a separate Configuration ID for each and use a 
naming convention to identify the distinctions. All date-related assumption IDs 
should be defined and used in the context of a single set of modeling buckets or a 
single Configuration ID.

Processing Errors Total—Specifies the maximum number of error messages you 
want written to the OFSA_PROCESS_ERRORS table.

Per Item—Specifies the maximum number of occurrences of 
each error type you want written to the OFSA_PROCESS_
ERRORS table. For example, specifying 10 will write up to 10 
occurrences of error code 105, 10 occurrences of error code 
110, and so on. See Appendix A, "Risk Manager Error 
Messages" for a list of the error codes and messages generated 
during Risk Manager processing.

Note: The IDs do not adjust dynamically if you change the 
modeling buckets in the Configuration ID.

Note: Before you click the Modeling Buckets/Information button, 
open the spreadsheet control bar to populate the modeling buckets 
quickly. See "Spreadsheet Control Bar" in Chapter 4, "Overview of 
IDs." 
6-4 Oracle Risk Manager Reference Guide



Setting Configuration ID Defaults
Autobalancing Leaves
Autobalancing is an option in the Risk Manager Process ID. To maintain a balanced 
balance sheet, autobalancing simulates the purchase or sale of overnight funds and 
funds for dividends and taxes, and generates retained earnings.

Select an autobalancing leaf type that corresponds to the appropriate account type:

For currency-based processing (processing including currency as an output 
dimension), all autobalancing leaves must be defined for a process to run. For 
processes that do not include currency as an output dimension, the Accumulated 
Translation Balance account does not require setup.

Balance sheet standard reports for Risk Manager use account-type information to 
determine where the balance for a particular leaf falls on the balance sheet. If the 
account types are not consistent, your reports will have unbalanced balance sheets. 

Dynamic Buckets
In the Dynamic Buckets window, define the start dates for dynamic market 
valuations and the start dates and gap buckets for dynamic gap simulations. You 
must set up modeling buckets before dynamic buckets.

Setting Configuration ID Defaults
The following procedures demonstrate some of the Configuration ID settings.

Autobalancing Leaf Account Type

Assets Earning Assets

Liabilities Interest Interest Bearing Liabilities

Retained Earnings Equity

Dividends Dividends

Federal Tax Taxes

State Tax Taxes

Accumulated Translation 
Balance

Equity
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Setting Up Modeling Buckets
In the Configure ID window, do the following:

1. Click the Modeling Buckets/Information button.

2. In the upper left corner, type 10 for the number of modeling buckets (maximum 
is 120).

3. Under Frequency, type 1.

The Frequency column displays the duration of the multiplier. The frequency in 
conjunction with the multiplier displays the duration of the modeling buckets. 
The frequency can be any number from 1 to 999.

4. Under Multiplier, select Monthly.

The Multiplier column lists daily, monthly, or yearly bucket choices.

5. Continue adding frequencies and multipliers as follows:

10 Frequency Multiplier

1 1 Months

2 1 Months

3 1 Months

4 1 Months

5 1 Months

6 1 Months
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After you fill in the frequencies and multipliers, the start and end dates are 
calculated automatically from the as-of date.

6. Scroll right. Under Federal Tax Percentage and State Tax Percentage, type a 
value.

Tax percentages are used when processing with the autobalancing option.Type 
35.00 for 35%. The tax rate entered is interpreted as the tax rate for that bucket 
regardless of the frequency of the bucket. That is, 35% entered for a monthly 
bucket is applied as a 35% monthly rate to the taxable income forecast for that 
month.

7. Under Dividend Amount, type a value. 

Dividend amounts are used during autobalancing calculations. The value you 
enter here will be paid out as dividends for all rate scenarios.

8. Under Dividend Percentage, type a value.

Dividend percentages are used during autobalancing calculations. The 
dividend percentage is defined as a percent of the net income after tax that will 
be paid out as dividends for the period.

Total Dividends = (Dividends Amount + (Dividends Percent x Net Income after Tax)

9. Click OK.

10. From the File menu, select Save.

Setting Autobalancing Leaves
To identify the autobalancing accounts, do the following:

1. Click the Autobalancing Leaves button.

7 3 Months

8 3 Months

Note: The Total Tax amount is defined by Total Taxable Income x 
Tax Rate, where the Taxable Income is defined as SUM ((Income x 
(Percent Taxable, from the Leaf Characteristics ID)) - SUM 
((Expense x (Percent Taxable, from the Leaf Characteristics ID)).

10 Frequency Multiplier
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2. Under Type of Leaf, click Assets.

3. From the Tree Bar, double-click Fed Funds Sold.

The Leaf Number and Leaf Description columns are populated.

4. Continue selecting autobalancing information and click OK.

Dynamic Buckets
To set up three dynamic buckets, do the following:

1. Click the Dynamic Buckets button.

The first dynamic bucket column displays the as-of date specified in the 
Configuration ID. 

2. Click Add two times.

3. Type terms and multipliers as follows:

In the first dynamic column, term is set to 0 days, which allows the start date to 
equal the as-of date. In the second dynamic column, the start date is 3 months 
from the as-of date. In the third dynamic column, the start date is 6 months 
from the as-of date. The start date is calculated automatically.

4. Check Calculate Market Value for all start dates.
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You can calculate market value for any start date. gap, In this example, generate 
market value results will be generated for the as-of date, 3 months in the future, 
and 6 months in the future. 

5. Check Calculate Gap for 3 months in the future.

6. Define the gap buckets.

Type a number to create rows for specifying the gap buckets and specify the 
terms and multipliers. The end date for the first column equals the start date 
defined in the top portion of the Dynamic Buckets window, plus the term 
specified in the gap portion. Each additional end date equals the prior end date 
plus the term specified.

7. Check Update Instrument Data in the 6 months column.

The detailed results of the market valuation from 6 months in the future will be 
written to each instrument record. If you wish to update the detailed 
instrument records with the market value results, you can choose to do so for 
only one start date.

8. Click OK.

9. From the File menu, select Save.
Configuration ID 6-9



Setting Configuration ID Defaults
6-10 Oracle Risk Manager Reference Guide



Data Fi
7

Data Filter ID

A Data Filter ID enables you to narrow the focus of your data for processing. It 
specifically targets the data you want to include or exclude for processing by 
another ID.

This chapter discusses the following topics:

■ Creating and Defining a Data Filter ID

■ Running a Data Filter ID

■ Editing a Data Filter ID

■ Using Data Filters on Multiple Tables

■ Reviewing a Data Filter ID Example

Creating and Defining a Data Filter ID
Use the following instructions to create and define a Data Filter ID. See Chapter 4, 
"Overview of IDs" for further explanation about ID creation and maintenance.

To create a Data Filter ID, perform the following steps:

1. From the File menu, select New -> Data Filter ID to display the New Data Filter 
ID dialog box.

2. Type the name for the ID in the Data Filter ID field.

3. Type a description for the ID in the Description field.

4. Select the permissions for the ID.

5. Click OK to continue, or click Cancel to exit.

The Data Filter ID dialog box appears.
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6. Select the instrument to include in your Data Filter ID from the list of 
instruments. The instrument types are specific to your particular database. The 
three types of instruments are:

7. Type or change the description of the purpose of the Data Filter ID.

Portfolio The Portfolio instrument type enables you to create a 
cross-instrument data filter. Portfolio fields are common to all 
instruments. All other instrument selections automatically 
narrow your focus to just that instrument type. If the filter 
criteria are the same for all instrument tables (for example, As 
of Date or Branch Code), you can use Portfolio as the 
instrument. 

If the filter criteria are different for all applicable instrument 
tables (such as Current Net Book Balance), define the filter 
criteria for the first instrument table, and then select the next 
instrument table from the instrument list and define its 
criteria, and so on.

Multiple 
tables

The Multiple Tables type instrument enables you to create a 
single data filter on multiple instrument tables. You must 
define the filter criteria for each instrument.

Formula The Formula instrument type enables you to filter data 
against a selection derived from a predefined Formula ID. 
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8. Select one or more columns from the Columns box, and click Add to copy your 
selections to the Defined Filter box.

The Defined Filter box displays the columns that you use to define filter criteria. 
To remove a column from the Defined Filter box, select it and click Remove. To 
remove all the columns, click Remove All.

9. Click on the first column in the Defined Filters box and select the Filter Type 
appropriate for that column. Then, enter the criteria appropriate for that 
column in the lower part of the dialog box. Repeat this step for each column in 
the Defined Filter box. See "Defining Filter Types and Criteria" in this chapter 
for an explanation of the different types of filters and criteria that you can use 
with Data Filter IDs.

10. Save the ID.

Defining Filter Types and Criteria
The filter criteria options appear on the lower half of the dialog box when you select 
a column in the Defined Filter box and select a Filter Type. The criteria options 
change depending on the column and the type of filter that you select.

Filter Type
The five filter types differ based on the type of column you select. If the column 
represents a code, you can select a filter type of Code Values, Another Column, or 
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Formula ID. If the column represents a numeric field or date field (a non-code field), 
you can select a filter type of Ranges, Specific Values, Another Column, or Formula.

The filter type determines what criteria characteristics appear for the column that 
you select. 

Filter Criteria
Criteria options change depending on the Filter Type that you select. The data must 
meet the definitions that you define in the filter criteria for each selected column. 
Otherwise, the data cannot pass the filter. For example, you may have two columns 
defined as follows:.

These columns indicate that a record must have a Current Balance greater than 
100,000 and a Current Rate greater than 8.00 in order to pass the filter.

Include/Exclude  After defining the specific Ranges or Values, you must choose 
whether you want to include or exclude the data that meets the defined criteria.

Operators  You use operators for the filter types Another Column and Formula. The 
choices are =, <>, <, >, >=.

Specific Values This filter type presents the Values column. You can 
enter up to 60 specific values.

Ranges This filter type offers From and To columns to enter 
ranges. You can enter the number of ranges that you 
want directly or use the spinner arrows to change the 
number of ranges dynamically. You can enter a 
maximum of 60 ranges.

Another Column This filter type compares the selected column to 
another column.

Formula This filter type compares a column to a value derived 
from a Formula ID.

Code Values This filter type enables you to define specific code 
values for selection.

Column Filter Criteria

Current Balance > 100,000

Current Rate > 8.00
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After you have selected the operator, select the column or Formula ID as 
appropriate to complete the equation.

Code Values  When you select Code Values as the filter type, the codes for the 
selected column appear in the Unselected Codes box. You can use the buttons to 
identify the codes you want to include or exclude in the filter.

Filter Criteria Rules
In order to get the results you want, you must define complete information in the 
Data Filter IDs. Complete information requires the following:

■ Thorough Definitions

You must thoroughly define the criteria for each column that you include in the 
data filter. All values, ranges, other column names, and formulas must be 
complete. If you specify that you want to filter on five specific values and then 
complete only the criteria for the first one, you can still save that Filter ID. 
However, an error message appears if you try to run an ID that uses the 
incomplete Filter ID.

■ Order of Processing

You can control the order of the application of the filter criteria (such as the 
order of the Columns in the Defined Filter box) by using the directional arrow 
buttons to the right of the Defined Filter box.

Implied Filter Criteria
Besides the filter criteria that you have defined, the following filter criteria may be 
automatically included in a process that you generate:

Button Description

Add Moves the highlighted codes to the Selected Codes box

Remove Moves the highlighted codes in the Selected Codes box to the 
Unselected Codes box

Select All Moves all the codes to the Selected Codes box

Remove All Moves all selected codes to the Unselected Codes box

Note: The end result of the filter is not dependent on the order of 
the application of the filter criteria. Each row must pass all criteria.
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■ As of Date 

Although the Oracle Financial Data Manager (FDM) database can contain data 
from an unlimited number of as-of-dates, most Oracle Financial Services (OFS) 
applications automatically filter only those rows from the as-of-date that you 
define in the active Configuration ID.

■ Row Level Security

Your system administrator may limit the rows to which you have access. 

Null Values in the Database
A null value in a column in the database is a column that has no data. You should 
take all necessary steps to avoid having null columns in the database for the follow-
ing reasons:

■ Any null value accessed in a formula results in a null value. For example:

If we define a formula as X + Y, the answer is 150 + null = null. All operations 
(such as +, -, /, *, ^) are handled in this same manner.

■ You cannot define a filter to recognize null values. The Data Filter ID assumes 
that the database does not have any null values. Consequently, you cannot 
define a Data Filter ID to isolate all rows with a null value in a given column.

You can identify null values by using an SQL statement to select all rows 
WHERE <Column> IS NULL.

Running a Data Filter ID
Running the Data Filter ID generates an SQL statement but does not execute the 
statement. The application executes the SQL statement when you run an ID using 
the Data Filter ID.

To process a Data Filter ID, complete the following steps:

Column X Column Y

150 null

Note: Null <> 0, so filtering on 0 does not return rows with null 
values.
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1. From the Process menu, select Run. 

The SQL statement that your Data Filter ID generates displays in a window. 

2. Review the SQL statement to check the results of your Data Filter ID.

3. Click OK to close the SQL statement window.

Editing a Data Filter ID
To edit a Data Filter ID, perform the following steps:

1. From the File menu, select Open -> Data Filter ID.

The Select Filter ID dialog box appears.

2. Select the ID you want to edit.

3. Make your desired changes.

4. Save the ID.

Using Data Filters on Multiple Tables
A Data Filter ID can contain criteria from different tables. Each line in the Defined 
Filter box is a part of the filter that can stand alone as its own filter. Also, each line 
or part of the defined filter can reference a different table.

A part of the filter can reference Portfolio as the table name. Portfolio is a proxy for 
whatever table the current ID is referencing. For example, if the ID using the Filter 
ID is a Data Correction ID, the application replaces Portfolio with the name of 
whatever table the Data Correction ID is correcting. The application may or may not 
apply each line of the filter to the data in a table.

The application applies the filter line if either of the following conditions is true:

■ The table you name explicitly in the filter is the same as the table that the 
application is processing

■ The table in the filter is Portfolio and the table the application is processing 
contains the referenced Portfolio field

The application does not apply the filter line if either of the following conditions is 
true:

■ The table explicitly named in the filter is different from the table that the 
application is processing
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■ The table in the Data Filter ID is Portfolio and the table the application is 
processing does not contain the referenced Portfolio column

The examples in the following table demonstrate these rules. The Table and Column 
combination represents the filter. An X indicates that the application applies the 
filter to the table during processing.

Reviewing a Data Filter ID Example
This example demonstrates how to create a data filter that includes only adjustable 
rate mortgages. You can create a Data Verification ID using the new Data Filter ID 
that verifies the margins on your adjustable rate mortgages. See Chapter 8, "Data 
Verification ID" for more information.

To create the data filter, perform the following steps:

1. From the File menu, select New -> Data Filter ID.

The New Data Filter ID dialog box appears.

2. Type MTG_ARM in the Data Filter ID field.

3. Type Adjustable Rate Mortgages in the Description field.

4. Click Read/Write as the permissions.

5. Click OK.

The Data Filter ID dialog box appears.

6. Select Mortgages from the instrument list.

7. In the Columns box, select Interest Rate Code, and click Add. 

Filter
Commercial Loans 
Table Ledger Stat Table

Table: Commercial Loans

Column: Current Gross Book Balance

X

Table: Ledger Stat

Column: Month 1

X

Table: Portfolio

Column: Original Term to Maturity

X

Table: Portfolio

Column: Organizational Unit ID

X X
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The Interest Rate Code column appears in the Defined Filter box.

8. Select Interest Rate Code in the Defined Filter box. 

This activates the Filter Type options. Code Values appears as the first choice 
because you have selected a code-type column.

9. Select No Index from the Unselected Codes box, and then click Add. 

The selection appears in the Selected Codes box. 

10. Click Exclude These Codes in the Codes options box.

11. Select Process -> Run to verify the SQL statement.

12. Save and close the ID.

When you create the Data Verification ID and apply this Data Filter ID, it limits the 
view to adjustable rate mortgages only.
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Data Verification ID

When you need to edit or verify the data in a database, you often need to view that 
data at the lowest level possible: the row and column level. The Data Verification ID 
enables you to define the specific table, columns, and rows you want to view.

The results of the Data Verification ID appear in the form of a virtual spreadsheet 
that displays a maximum of 32,000 records. Because databases may be much larger 
than this, you should use predefined Data Filter IDs to narrow your focus on the 
database. Refer to Chapter 7, "Data Filter ID" for instructions on how to create a 
Data Filter ID.

This chapter discusses the following topics:

■ Creating and Defining a Data Verification ID

■ Running a Data Verification ID

■ Editing a Data Verification ID

■ Reviewing a Data Verification ID Example

Creating and Defining a Data Verification ID
Use the following instructions to create and define a Data Filter ID. See Chapter 4, 
"Overview of IDs" for further explanation about ID creation and maintenance.

To create a Data Verification ID, perform the following steps:

1. From the File menu, select New -> Data Verification ID to display the New Data 
Verification ID dialog box.

2. Type name for the ID in the Data Verification ID field.

3. Type a description for the ID in the Description field.
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4. Select the permissions for the ID.

5. Click OK to continue or Cancel to exit.

The Data Verification ID dialog box appears.

6. From the Table Types list, select the type of table with which you want to work. 

Your selection determines which tables are available in the Tables list.

7. From the Table list, select the table with which you want to work.

8. From the Filter ID list, select the Data Filter ID or Group Filter ID for the subset 
of data you want to view.

9. Select up to three columns in the Sort By box to define the sort order you want.

Note: The Data Verification ID does not support Risk Manager 
result detail tables.

Note: The virtual spreadsheet displays up to 32,000 records. If the 
records you want to view are outside this range, you must refine 
your filter (Data Filter ID or Group Filter ID) to narrow the focus of 
your view.
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10. In the Columns box, select the columns you want to include in your view and 
click Add. 

The columns move to the Defined View box.

■ To add all the columns to the Defined View box, click Select All and then 
click Add. 

■ To delete a column from the Defined View, select the column and click 
Remove. 

■ To remove all the columns from the Defined View, click Remove All.

11. Use the arrows next to the Defined View box to organize the columns in the 
order you want to see them. 

Each click of an arrow moves the selected columns one position. Raising a 
column in the list moves it to the left in the spreadsheet.

12. Save the ID.

Running a Data Verification ID
To view the results of your Data Verification ID definitions, complete the following 
steps:

1. Select the Run option from the Process menu. 

2. Review the results.

Note: If a column name contains a substring that includes the 
name of another column (such as, Remaining Term and Remaining 
Term Multiplier), then you must add the column with the shorter 
name to the defined view first.
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Edit Spreadsheet On/Off
The Edit spreadsheet On/Off option is available only in Oracle Financial Data 
Manager Balance & Control. If this feature is on, you can edit the data at row level. 
The yellow pencil icon with the red X over it indicates that the OFS application does 
not allow editing.

What the Results Show
In the View window, all values display as they are stored in the database. For 
example, the view displays code values numerically, not with the code value 
translation. This is essential for quality control of the data. If you have invalid 
codes, simply displaying an invalid code description is not sufficient. The actual 
code value is necessary for determining the source of the problem.

Editing a Data Verification ID
To edit a Data Verification ID, perform the following steps:

1. From the File menu, select Open -> Data Verification ID.

The Select Data Verification ID dialog box appears.

2. Select the Group and Data Verification ID you want to edit.

3. Make your desired changes.

4. Save the ID.
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Reviewing a Data Verification ID Example
This example creates a Data Verification ID to verify the margins on adjustable rate 
mortgages. To include only adjustable rate mortgages in the table view, you must 
first create a Data Filter ID (MTG_ARM) that meets these characteristics. See 
"Reviewing a Data Filter ID Example" in Chapter 7, "Data Filter ID" for instructions 
on creating the Data Filter ID for this example.

To create the Data Verification ID, perform the following steps:

1. Select New -> Data Verification ID.

2. Select <ALL> for Group.

3. Type ADJ_RT_MTG_MAR in the Data Verification ID field.

4. Type Verify Adj Rt Mtg Margins as the description.

5. Select Read/Write for Security.

6. Click OK. 

The Data Verification ID dialog box appears. 

7. Select Client Data Tables Table type.

8. Select the Mortgages table.

9. Select Interest Rate Code, Product Type Code, Margin, and Current Gross Rate 
from the Columns box. 

10. Click Add to include these columns in the Defined View box.

11. In the Filter box, select MTG_ARM.

12. Select Interest Rate Code from the first Sort By box to view the margins based 
on the interest rate code. 

13. Run the Data Verification ID to view and verify the results.
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Discount Rates ID

A Discount Rates ID defines the method for discounting projected cash flows for 
market value purposes. For each product and currency, you can choose one of the 
following discount methods:

■ Spot Input

■ Spot Interest Rate Code

■ Forecast (Original Term)

■ Forecast (Remaining Term) 

Creating a Discount Rates ID
To create a new Discount Rates ID, complete the following steps:

1. From the File menu, select New -> Discount Rates ID.

2. Select a folder.

3. Type a descriptive name for the ID.

4. Type a description for the ID. This is an optional field.

5. Click Read/Write.

6. Click OK.

The Discount Rates ID window and tree bar appear.
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The Discount Rates ID Window and Tree Bar
In the tree bar, select the product and the currency for which you want to define a 
discount method.

Discount Method
Select a method from the Discount Method list: 

■ Spot Input

■ Spot Interest Rate Code

■ Forecast (Original Term)

■ Forecast (Remaining Term) 

Hint: Using the default currency to set up assumptions can save 
data input time. At run time, the calculation engine uses 
assumptions explicitly defined for a product and currency 
combination. If assumptions are not defined for a currency, the 
engine uses the assumptions defined for the product and the 
default currency. If the assumptions are the same across some or all 
currencies for a specific product, you can input the assumptions for 
the default currency.
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The following table describes the methods and rate choices:

Cash Flow Definition
The Cash Flow Definition box is used in unique instances to specify the portion of 
the cash flow that is used to calculate a market value. Select from the following:

■ Interest Only—ignores all principal runoff for market value purposes. Use this 
option for off-balance sheet items where principal is equal to notional principal, 
and is therefore not a true cash flow.

■ Mature at Repricing—calculates a market value for a given transaction up to the 
repricing date. For market value purposes only, the transaction is assumed to 
mature on the repricing date.

Cash Flow Interest Type
The Cash Flow Interest Type determines which interest component is included in 
the cash flow definition. The Cash Flow Interest Type can be one of three values:

■ Net Rate

■ Gross Rate

■ Transfer Rate

Method Single Rate Yield Curve

Spot Input Discounts all cash flows by the 
Input Rate.

Not applicable.

Spot Interest 
Rate Code

Discounts each cash flow period 
by the base value (the yield curve 
as of the start dates selected in 
your Configuration ID) of the 
Interest Rate Code chosen.

Discounts each cash flow period by 
the equivalent term rate on the base 
yield curve chosen (the yield curve as 
of the start dates selected in your 
Configuration ID). The term is 
defined by the remaining term of the 
cash flow.

Forecast
(Original Term)

Discounts each cash flow period 
by the forecasted value of the 
single rate chosen.

Discounts each cash flow period by 
the forecasted value of the point on 
the yield curve corresponding to each 
transaction record’s original term.

Forecast
(Remaining 
Term)

Discounts each cash flow period 
by the forecasted value of the 
single rate chosen. Identical to 
Forecast (Original Term) method.

Discounts each cash flow period by 
the forecasted value of the point on 
the yield curve corresponding to the 
remaining term until each cash flow.
Discount Rates ID 9-3



Defining a Discount Rates ID Using Spot Input: An Example
For typical processing, you will use the net rate for the interest component of the 
cash flow. Special processing objectives, such as valuation of the funding center, 
may require you to use the other cash flow interest types.

Interest Rate Parameters
One of the following interest rate parameters is available depending on which 
discount method you select:

■ Input Rate—available when you select Spot Input. Type the rate you want to 
use for market value calculations.

■ Rate Spread—available when you select Spot Interest Rate Code, Forecast 
(Original Term) and Forecast (Remaining Term). Type the percentage difference 
(+ or -) between the selected rate index and the value you want to use for 
market value calculations.

Defining a Discount Rates ID Using Spot Input: An Example
Define a Discount Rates ID for fixed mortgages using the spot input method and a 
spot rate of 9.5%.

1. From the tree bar, select Mortgage Fixed and Default Currency (000).

1. From Discount Method, select Spot Interest Rate Code.

2. From Interest Rate Code, select Treasury Index.

The list of Interest Rate Codes depends on the selected currency from the tree 
bar. If the selected currency is the default currency, all Interest Rate Codes 
appear. For other currency selections, the list of interest rate codes includes only 
interest rate codes whose reference currency is the same as the selected 
currency.

3. In Rate Spread, type 1.0000. 

A spread of 1% calculates a discount rate up to 1% above the selected interest 
rate. Type a negative number for a spread below the interest rate.

4. From Cash Flow Interest Type, select Net Rate.
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5. From the File menu, select Save.

Discount Rate Examples
The following examples assume the interest rate has a format of zero coupon yield 
with annual compounding. The instrument used in each example is an annual-pay, 
2-year instrument originated on the as-of date. See the Oracle Financial Services 
Technical Reference Manual for details on discount factor derivation in cash flow 
calculations.

Spot Input
In the Spot Input method, the discount factor does not vary with interest rate 
scenarios. The discount factor calculations assume the input interest rate to reflect a 
format of zero coupon yield, annual compounding, and actual/actual accrual basis.

Spot Input Rate = 6.00%

The formula for the market value of the account, for any rate scenario, is: 

Market Value = Cash Flow1/(1 + 0.06)+ Cash Flow2/((1 + 0.06)^2)

Cash Flow1 is the cash flow at the end of year 1. Cash Flow2 is the cash flow at the 
end of year 2. 
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Spot Interest Rate Code with Yield Curve
In the Spot Interest Rate Code method, the discount factor depends on the time of 
the cash flow, but does not vary with interest rate scenario.

Interest Rate Code = Treasury Yield Curve

The formula for the market value of the account, for any rate scenario, is: 

Market Value = Cash Flow1/(1 + 1 Year Treasury)+ Cash Flow2/((1 + 2 Year 
Treasury)^2)

Cash Flow1 is the cash flow at the end of year 1. Cash Flow2 is the cash flow at the 
end of year 2. The values for 1 Year Treasury and 2 Year Treasury reflect the values 
from the historical interest rate data, beginning with the as-of date.

Forecast Remaining Term with Yield Curve
The Forecast Remaining Term method uses forecasted interest rate data to 
determine the discount factor.

Interest Rate Code = Treasury Yield Curve

The formula for the market value of this account is: 

Market Value = Cash Flow1/(1+ 1Year Treasury Rate at the 1 year point in the 
forecast) + Cash Flow2/((1+ 2 Year Treasury Rate at the 2 year point in the 
forecast)^2)

Forecast Original Term with Yield Curve 
The Forecast Original Term method uses the forecasted interest rate data to 
determine the discount factor.

Interest Rate Code = Treasury Yield Curve

The formula for the market value of the account is: 

Market Value = Cash Flow1/(1+ 2 Year Treasury Rate at the 1 year point in the 
forecast) + Cash Flow2/((1+ 2 Year Treasury Rate at the 2 year point in the 
forecast)^2)

Cash Flow1 is the cash flow at the end of year 1. Cash Flow2 is the cash flow at the 
end of year 2. Note that Cash Flow1 is discounted at the 2 year Treasury rate. The 2 
Year rate is used with this method, because the Forecast Original Term method 
always uses the term equivalent to the original term of the instrument.
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Forecast Balance ID

This chapter discusses modeling of new business activity through the Forecast Bal-
ance ID. Included are assumption setup and processing.

Within a Forecast Balance ID, you specify the amount of new activity generated per 
modeling bucket on each product within each active currency. To create a new busi-
ness assumption, you select from seven available forecasting methods. You can fur-
ther tailor the new business assumptions to meet your expectations of future 
originations, including the timing of new business and the effect of interest rates on 
new business amounts. 

This chapter includes four sections:

■ Forecasting Methods

■ Rate-Volume Modeling

■ Creating a Forecast Balance ID

■ Examples of Forecast Balance Assumptions

Forecasting Methods
The new business methods within the Forecast Balance ID determine how new 
business assumptions are applied per product leaf within each active currency. They 
consist of:

■ No New Business

■ Target End Balance

■ Target Average Balance

■ Target Growth Percent
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■ New Add Balance

■ Rollover

■ Rollover with New Add

For the Target Growth, Target End, and New Add methods, you select one of two 
timing options to indicate when new business for a new account should be origi-
nated. The two options are:

■ Distributed Option: Risk Manager solves for the origination date of the new 
business account to reach an expected average balance, assuming even 
distribution of new business throughout the modeling bucket. For each 
modeling bucket, this calculation results in an average balance amount that is 
midway between the beginning balance and the ending balance. 

■ Bucket End Method: Risk Manager generates new originations at the end of the 
modeling bucket. Adding new business at the end of the modeling bucket is 
effective in terms of processing time, but may result in irregular average 
balances and interest accruals over the bucket.

For the Target Average method, the system automatically determines the timing of 
new originations to ensure that the user-input target is achieved. For Rollover busi-
ness, the system assumes that the rollover occurs at the time of runoff of existing 
accounts. 

The application of each new business method, including how different timing 
options are applied, is described below:

No New Business
No New Business (forecasting zero changes in balances) is the default method for 
the Forecast Balance ID. This method allows runoff without replacement of the 
paid-down balances.

Note: For distributed originations of Target Growth and Target 
End balances, Transaction Strategies and future origination in the 
current position may impact the distributed originations calcula-
tion. Because the origination date on Transaction Strategy and cur-
rent position accounts cannot be modified, the timing algorithm 
may not be able to find an origination date for the remaining new 
business which achieves the expected average balance.
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Target End Balance
Use the Target End Balance method to define the total expected balance by the end 
of each modeling bucket. The new origination amount and the timing of origina-
tions within each modeling bucket are determined during processing, as described 
below:

New Origination Amount 
The new origination amount per bucket is calculated as:

Target Ending Balance - Beginning Balance - Total Runoff + Transaction Strategy Originations + 
Current Position Originations 

New Business Timing
For the Target End method, you can choose either the At Bucket End timing option 
or the Distributed timing option.

At Bucket End: The new origination amount is added on the final date in the 
bucket. Interest starts accruing on the next day, the first date of the next bucket.

Distributed: The new origination amount is added on the calculated date(s) which 
allow the average balance to equal the beginning balance plus the ending balance 
divided by two, accounting for timing of runoff and other originations occurring 
during the modeling bucket.

Target Average Balance
Use the Target Average Balance method to define the expected average balance per 
modeling bucket. The new origination amount and the timing of originations 
within each modeling bucket are determined during processing, as described 
below:

New Origination Amount
The new origination amount per bucket is calculated as 

2*(Target Average Balance - Bucket Beginning Balance) + Total Runoff - Transaction Strategies 
Originations - Current Position Originations
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New Business Timing
The new origination amount is added on the calculated date(s) which allow the 
average balance to equal the user-input target average. This calculation accounts for 
timing of runoff and other originations occurring during the modeling bucket.

Target Growth Percent
Use the Target Growth Percent method to define the expected percentage change in 
the balance over each modeling bucket, expressed as a percent of the bucket’s ini-
tial balance. A target growth assumption of zero creates a flat balance sheet, only 
originating enough new business to offset runoff on existing accounts. The new 
origination amount and the timing of origination are determined during process-
ing, as described below:

New Origination Amount
The new origination amount per bucket is calculated as:

(Beginning Balance * (1 + Target Growth Percent)) - Beginning Balance - Total Runoff + 
Transaction Strategy Originations + Current Position Originations 

New Business Timing
For the Target Growth method, you can choose either the At Bucket End timing 
option or the Distributed Originations timing option.

At Bucket End: The new origination amount is added on the final date in the 
bucket. Interest starts accruing on the next day, the first date of the next bucket.

Distributed: The new origination amount is added on the calculated date(s) which 
allow the average balance to equal the beginning balance plus the ending balance 
divided by two. This calculation accounts for timing of runoff and other origina-
tions occurring during the modeling bucket.

New Add Balance
The New Add Balance method defines the absolute amount of new business that is 
added within a bucket. The new origination amount and the timing of origination 
are determined during processing, as described below:

New Origination Amount
The new origination amount is equal to the user-input new add balance.
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New Business Timing
For the New Add method, you can choose either the At Bucket End timing option 
or the Distributed Originations timing option.

At Bucket End: The new origination amount is added on the final date in the 
bucket. Interest starts accruing on the next day, the first date of the next bucket.

Distributed: The new origination amount is added at the mid-point of the model-
ing bucket. If the modeling bucket contains an uneven number of days, the origina-
tion will is apportioned evenly over the two days in the middle of the bucket.

Rollover
Use the Rollover method to base the amount of new business on the rollover (rein-
vestment of principal on a given or like products) of existing business. You can roll 
any combination of prepayments, maturing balances, and principal runoff from a 
product into itself or into another product. For multiple currency processing, roll-
over processing occurs within each individual currency. Rollover cannot occur 
between two currencies. The new origination amount into a particular target leaf 
and the timing of that origination are described below.

New Origination Amount
For a single target leaf within a single currency, the new origination amount 
depends on the rollover sources, which are product leaves of the same currency 
whose runoff drives the amount of new business generated into the target leaf. For 
each rollover source, you must also define the components of principal runoff you 
would like to roll over. Your choices are:

Total: Total runoff includes runoff from all three categories of run-off: scheduled 
principal payments, prepayments, and maturing balances.

Prepay: Prepay includes runoff from prepayments, early repayment of principal 
balances.

Maturity: Maturity incorporates payment of principal on the maturity date, above 
that incorporated in the scheduled principal payment. Balloon payments and final 
principal repayment of non-amortizing instruments are included in this category.

Payment: Payment runoff includes scheduled principal payment on an amortizing 
instrument.

For each combination of source leaf and runoff type, you can input a different roll-
over percent. The new origination amount within a modeling bucket equals the run-
off amounts multiplied by the percentage rollover for all source leaves.
Forecast Balance ID 10-5



Forecasting Methods
Timing of Rollover
All runoff from sources is added as new business into the target leaf with the proper 
currency at the average time of runoff. 

The average time of runoff is calculated by taking an average of the runoff date 
weighted by the amount of runoff for all instruments which make principal pay-
ments during the modeling bucket.

Rollover with New Add
Use the Rollover with New Add method to apply both rollover assumptions and 
new add assumptions to a single product within a single currency. It allows new 
business to be driven by reinvestment of existing accounts plus an expectation of 
new business amounts. The New Add method and the rollover method are applied 
independently, with the New Add applied first. See the details under Rollover and 
New Add, described previously, for a definition of how each method works.

Account Types and New Business 
The availability of a new business method depends on the account type of the prod-
uct leaf. The account type of a product leaf comes from its associated Common COA 
ID. Setup requirements for each account types are described below:

■ Interest Bearing Accounts: All forecasting methods are available. The following 
account types are classified as interest bearing:

■ Earning asset

■ Interest bearing liability

■ Off balance sheet receivable

■ Off balance sheet payable

■ Income Statement Accounts: The only method available is New Add. For these 
accounts, input the desired income statement value for each bucket. The 
following account types are classified as income statement:

Note: Rollover of runoff components, prepayment, payment, or 
maturity requires that those components exist in the output data 
set. In a scenario-based Process ID, you must select those financial 
elements from the optional Financial Element Details set. Other-
wise, no new business is generated from those runoff components. 
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■ Non-interest income

■ Non-interest expense

■ Interest income

■ Interest expense

■ Balance Sheet Accounts: The only method available is New Add. For balance 
sheet accounts, the input amount is interpreted as a balance. The following 
account types are classified as balance sheet:

■ Other asset

■ Other liability

■ Equity

Rate-Volume Modeling
Customer demand for new products often depends on interest rates (either the 
absolute level of interest rates or the spread between two rate indices). You can 
model this behavior by selecting a rate-volume assumption. Once you have selected 
the rate-volume assumption, you must define additional parameters which control 
how interest rates affect new business levels. 

Rate-Volume Assumptions
There are three rate-volume options to choose from:

No Relationship
If you want new business amounts to stay constant regardless to the interest rate 
environments, select this option.

Rate-Level Dependent
The Rate-Level dependent relationship allows you to change new business behav-
ior for different values of a single indicator interest rate. The indicator interest rate, 
referred to as the Base Interest Rate, is defined by an Interest Rate Code, a term 
selection, and a rate lag. 

Interest Rate Code: The Interest Rate Code identifies the reference yield curve or 
rate index whose forecasted value determines the new business amount. You can 
select the Interest Rate Code from all available interest rate codes for the selected 
currency, as defined within FDM Rate Manager. The list of Interest Rate Codes 
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includes only codes with a reference currency equivalent to the currency selected in 
the Floating Tree Bar.

Term Selection: If the selected Interest Rate Code is a yield curve, you must also 
select a term. Your term choices depend on the definition of the Interest Rate Code 
within FDM Rate Manager. Note that the selection automatically defaults to the 
shortest available term.

Rate Lag: If you want the base interest rate calculation to perform a lookback func-
tion, you can input a rate lag. The new business assumption lookup uses the fore-
casted interest rates as of a date within the current modeling bucket less the rate lag. 

If the timing of new business is End of Bucket, the lookup function uses the last day 
of the modeling bucket less the rate lag. For all other cases, the mid-point of the 
bucket less the rate lag is used. 

Rate-Spread Dependent
With the Rate-Spread dependent relationship, you can input new business assump-
tions for different spreads between two indicator interest rates. You define the first 
indicator interest rate, the Base Interest Rate, as described previously. The second 
indicator interest rate, the Alternate Interest Rate, also requires definition of an 
Interest Rate Code, a term selection, and a rate lag.

The rate spread equals the Alternate Interest Rate minus the Base Interest Rate.

Rate Tiers
Once you have selected a rate-volume relationship and defined your base and alter-
nate interest rates, you must define rate tiers. Rate tiers provide the lookup values 
for which different new business assumptions can be input. The rate tiers are dis-
played within the input tables as a dimension along the top of the table.

Lookup Method
The lookup method determines which new business assumption is selected from 
the input values when the forecasted interest rate falls between two rate tiers.

There are two methods to choose from: 

Interpolate: If you select Interpolate, the new business assumption is an interpo-
lated value, using straight line interpolation, calculated from the assumptions asso-
ciated with the two nearest interest rate tiers. The interpolation uses a simple 
straight line interpolation formula.
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Range: If you select Range, Risk Manager selects the new business assumption as 
the closest assumption associated with the rate tier which is less than or equal to the 
forecasted interest rate.

Creating a Forecast Balance ID
To create a new Forecast Balance ID, complete the following steps:

1. From the File menu, select New -> Forecast Balance ID.

2. Select a folder.

3. Type a descriptive name for the ID.

4. Type a description. This is an optional step.

5. Click OK.

The Forecast Balance ID dialog opens on the Method Page. Four additional pages 
can be accessed through the buttons across the top. The Floating Tree Bar also 
appears, with the top section displaying product leaves and the lower section dis-
playing active currencies.

You must begin the assumption setup on the Method Tab and work your way 
through the remaining tabs, as needed. To input new assumptions for a particular 
product leaf and currency, follow the steps detailed under each Page heading, 
described next:

Method Page
The Method Page is used to define the Forecast Balance method per product leaf 
and currency. On this page you define the New Business method, the timing option, 
and the type of rate-volume relationship. An example of the Method page appears 
below:
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Follow the steps listed below to complete this information.

1. Select a product leaf in the top section of the Floating Tree Bar.

2. Select a currency in the lower section of the Floating Tree Bar. Only active 
currencies, as defined through FDM Rate Manager, are displayed in this list. For 
single currency installations, the currency selection will default to the single 
listed currency.

3. Select your preferred New Business Method. If you select Target End, Target 
Growth, or New Add, note that the Timing selection is enabled. 

4. Select your preferred Timing option. (Target End, Target Growth, or New Add 
only)

5. Select the type of Rate-Volume Relationship you want to model. If the 
relationship is Rate Spread or Rate Level, the Rate Tiers page is enabled. In this 
case, see the following steps listed for Rate Tiers Page.

Rate Tiers Page
On the Rate Tiers page you define the indicator interest rate(s), establish the rate 
tiers, and select a lookup method. If you have selected No Relationship on the 
Method Page, this page is not accessible. An example of the Rate Tiers page appears 
below:
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To complete the assumption setup for rate sensitive new business, complete the fol-
lowing steps:

1. Click on the Rate Tiers button located at the top of the Forecast Balance screen. 
The Rate Tiers Page appears.

2. Select an Interest Rate Code for the Base Interest Rate. The list of interest rate 
codes depends on the currency selected in the Floating Tree Bar. If the list 
appears incomplete or incorrect, check the definition of the reference currency 
for each Interest Rate Code in FDM Rate Manager.

3. Select a term for the Base Interest Rate from the list of available terms. The term 
list depends on the interest rate code selected in step 2. 

4. Input the desired rate lag for the Base Interest Rate by inputting an integer and 
selecting a time unit in which the rate lag is denominated (Days, Months, or 
Years).

5. Define the Alternate Interest Rate (available for Rate Spread Relationship only) 
by selecting an interest rate code, selecting a term, and inputting a rate lag, as 
described for the base interest rate in steps 2 - 4. 

6. Define your rate tiers. If you have chosen the Rate Level method, input values 
for the base interest rate. If you have chosen the Rate Spread relationship, input 
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spreads between the base interest rate and the alternate interest rate. Follow the 
steps defined below:

a. Enter a rate tier into the first cell in the Rate Tiers listbox.

b. Choose Add to add another rate tier. An additional input cell appears.

c. Continue adding cells and inputting rate tiers until all desired rate tiers 
have been defined. For quick input of assumptions you can also use the 
spreadsheet control bar. See Chapter 4, "Overview of IDs" for more 
information.

d. To remove a rate tier, highlight the cell to be removed and select Remove. 
The currently selected rate tier disappears.

7. Select a Lookup Method.

New Volume Detail Page
The New Volume Detail Page is used to input new volume assumptions for the 
methods:

■ New Add

■ Target End

■ Target Average

■ Target Growth

■ New Add component of the Rollover with New Add method

On this page you select the range of modeling buckets and input balance or percent-
age assumptions for each modeling bucket within this bucket range. An example of 
the New Volume Detail page appears below:
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To complete your new volume assumptions, complete the following steps:

1. Move to the input spreadsheet by selecting the New Volume Detail button on 
the top of the Forecast Balance ID interface. The New Volume Detail input 
screen appears.

2. Select the modeling bucket start and end range.The default Bucket Range 
includes all modeling buckets. To forecast new business in a subset of the 
modeling horizon, reduce the bucket range by increasing the bucket start date 
or decreasing the bucket end date. As you change the bucket start and/or the 
bucket end, the spreadsheet adjusts accordingly to display only buckets within 
the selected range.

3. Go to the cell corresponding to the first modeling bucket. If rate-volume 
relationships are used, this cell also corresponds to the first rate tier. Input the 
targeted value. For New Add, Target End, and Target Average, input an 
amount. For Target Growth, input a percent. The percent should represent the 
percentage growth within the modeling bucket. It should not represent an 
annualized amount.

4. To maximize the input area, double click on the plus sign (+) located in the 
top-left corner of the input spreadsheet. The input area increases to cover the 
entire ID.
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5. After maximizing the input area, return to the regular input screen by clicking 
on the minus sign (-) located in the top-left corner of the input spreadsheet. The 
ID returns to its regular size.

6. Use the spreadsheet control functionality to quickly update values within the 
input spreadsheet. For more information, see Chapter 4, "Overview of IDs".

Rollover Setup Page
In the Rollover Setup Page, input the setup details necessary for definition of roll-
over percentages. This page includes two required inputs: source product leaves 
and bucket ranges. An example of the Rollover Setup page appears below:

Follow the steps below to define source product leaves and bucket ranges. Remem-
ber that these values only apply to the selected currency.

1. Display the Rollover Setup Page by selecting the Rollover Setup button located 
at the top of the Forecast Balance ID interface.

2. Select the source product leaves. The source leaf is defined by the combination 
of a product leaf and runoff types. Complete the following steps to define all 
source leaves:
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a. Select a product leaf from the list of Available Leaves and add it to the list of 
Source Leaves. By default, Total Runoff is selected as the Runoff Type for 
this leaf.

b. If Total Runoff is not the appropriate runoff type, change the runoff type to 
the proper values for the highlighted source product leaf. 

c. Continue adding product leaves and defining runoff types until all source 
leaves have been defined.

3. Define the input bucket ranges. You only need to define multiple bucket ranges 
if you want to vary rollover assumptions by modeling buckets. The bucket 
ranges defined here only apply to rollover occurring from the source leaf to the 
target leaf. You must have at least one bucket range defined. Typically, you 
define a bucket range from the first modeling bucket to the last modeling 
bucket, covering the entire modeling horizon. To define a bucket range, 
complete the following steps:

a. Select a start bucket date for the first date range.

b. Select an end bucket date for the first date range.

c. Select Add to add a bucket range which begins on the first date of the start 
bucket and ends on the last date of the end bucket.

d. Select a new start date for the next date range. You can select from any 
buckets that are not encompassed by a defined bucket range. Modeling 
buckets which are a part of an existing bucket range do not appear in this 
list. Existing bucket ranges are indicated with a dotted line (<---->). 

e. Select an end date for the next date range. You cannot create overlapping 
modeling buckets. To prevent this, the list of available bucket end dates 
only includes modeling buckets which follow consecutively from the 
selected start bucket.

f. Continue adding bucket ranges until all desired ranges have been defined.

Rollover Detail Page
On the Rollover Detail Page you input rollover percentages. The rollover percent-
ages represent the percent of the runoff amount from the source (leaf and runoff 
type for the selected currency) which generates new business into the target leaf for 
the selected currency.

An example of the Rollover Detail Page appears below:
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1. Select the button Rollover Detail. The Rollover Detail Page appears. 

2. Select a bucket range from the list of available Bucket Ranges at the top of the 
interface.

3. Go to the first cell on the input spreadsheet. Input the appropriate rollover 
percentage for this combination of bucket range, source (and rate tier).

4. For a larger input area, maximize the screen. Click the plus sign (+) located in 
the top left corner of the spreadsheet. The bucket range selection disappears.

5. To reduce the input area and return to the original interface, click the minus 
sign (-) located in the top left corner of the spreadsheet. This enables you to see 
the bucket range selection again.

6. Continue inputting rollover percents for each source, as displayed in the rows 
of the spreadsheet, and for each rate tier, as displayed in the columns of the 
spreadsheet.

7. For quick update of inputs, use the Spreadsheet Control Bar. For more 
information see Chapter 4, "Overview of IDs".

8. If you have defined more than one bucket range, select the next bucket range 
and enter the appropriate rollover percentages.

9. Continue inputting rollover percentages until all cells for all bucket ranges are 
defined.

10. To save the ID before moving to the next product leaf, select he Save icon on the 
horizontal toolbar, or choose File/Save from the menu bar.

Editing the ID
You can modify or edit an existing ID by opening it, making the changes and then 
saving it as either a:
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■ Different ID with a new name, or

■ The same ID name

To edit your ID, perform the following steps:

1. Choose File/Open/Forecast Balance ID. The Select Forecast Balance ID dialog 
appears. 

2. Choose the ID for modification and make changes as outlined earlier in this 
chapter.

3. Choose Save or Save As, from the File menu, to save or create a new ID.

Naming IDs
Generally, it is best to use an ID naming convention that creates different groups of 
IDs. This keeps track of which IDs were created, in the context of specific modeling 
buckets.

The Active Configuration ID
Assumptions that you define when creating an ID are based on a specific modeling 
horizon, which is defined in the active Configuration ID. 

Example
■ If you define an ID based on a Configuration ID with a monthly modeling 

horizon, your results are calculated in monthly time periods.

■ If you redefine that same ID, using a different Configuration ID with a weekly 
modeling horizon, your results are calculated in weekly time periods.

If assumptions in your Forecast Balance ID are based on a modeling horizon that is 
different from the horizon defined in the active Configuration ID, inaccurate data 
will result. You should verify that date-sensitive IDs are consistent with the active 
Configuration ID.

Examples of Forecast Balance Assumptions
Below are two examples describing how to input assumptions into the Forecast Bal-
ance ID for a product using the target growth method and a product using the roll-
over capabilities.
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Target Growth Example
The following example describes how to model the effect of interest rate changes on 
growth in a consumer auto loans product. We will input values that cause the 
growth rate of consumer auto loans to decrease as interest rates increase. 

1. Create a new Forecast Balance ID.

2. Select the product leaf Consumer Auto Loans from the product list within the 
Floating Tree Bar. 

3. Select US Dollars in the currency selection of the Floating Tree Bar.

4. Select Target Growth as the New Business method.

5. Select Distributed as the Timing option.

6. Select Rate-level dependent as the Rate-Volume relationship. The completed 
Method information should appear as shown in the example below:

7. Click on the Rate Tiers button.

8. Define the Base Interest Rate. 

a. Select Treasury Curve as the Interest Rate Code. 

b. Input 36 and select Months as the term. 

c. Leave the Rate Lag as the default (0 Days).

9. Define the Rate Tiers.

a. Go to the first cell in the Rate Tiers list.

b. Leave the value at 0%.
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c. Select the Add button to add a new cell. Move the cursor to the new cell 
and input the value 4%.

10. Leave the lookup method at the default (Interpolate).

11. Click on the New Volume Detail button. Note that the Rate Tiers you have 
defined appear as columns across the top of the spreadsheet.

12. Click on the Spreadsheet Control Bar icon to open the spreadsheet control.

13. In the first cell, corresponding to the first modeling bucket and a rate level of 
0%, input a target growth percent of 6.000%. 

14. Use the Spreadsheet Control to input the rest of the values in this column.

a. Highlight the first cell and all other cells in the 0% rate column. 

b. The Spreadsheet Control options become enabled. The 6.000% value 
displays in the initial value field, 0.000% displays in the increment field, 
and the method displays Increment by Value. Leave these values 
unchanged.

c. Select Run to update all values in the 0% rate tier column to equal 6.000%. 

15. In the first row and the second column, corresponding to the first modeling 
bucket and a rate level of 4%, input a target growth percent of 2.500%. 

16. Repeat the Spreadsheet Control procedure for copying this value to the rest of 
the column. The completed target growth percentages should appear as 
displayed below:
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Rate Sensitive Rollover Example
This example shows how to input rollover behavior for holders of CDs denomi-
nated in US Dollars. As the yield curve steepens, holders of shorter term CDs 
increasingly choose to roll their money into longer term CDs. 

1. Create a new Forecast Balance ID.

2. Select the product leaf CDs 60 months from product selection within the 
Floating Tree Bar.

3. Select US Dollars from the currency selection within the Floating Tree Bar.

4. Select the New Business method Rollover.

5. Define the Rate-Volume relationship as Rate-Spread Dependent.

6. Go to the Rate Tiers page.

7. Define the Base Interest Rate. 

a. Select Treasury Curve as the Base Interest Rate Code.

b. Select 6 months as the base term. 

c. Leave the default rate lag at 0 months. 

8. Define the Alternate Interest Rate. 

a. Select Treasury Curve as the Alternate Interest Rate Code.

b. Select 60 months as the alternate term. 

c. Leave the default rate lag at 0 months.

9. Input the following as rate tiers, -2.000%, 0.000%, and 2.000%, representing the 
spread between the 5 year Treasury bonds and 6 month Treasury bills. The rate 
tiers will indicate the following at process time

■ an inverted yield curve

■ a flat yield curve

■ an upward sloping yield curve.

10. Leave the Lookup Method as interpolate. The completed Rate Tier information 
should match the example provided below:
10-20 Oracle Risk Manager Reference Guide



Examples of Forecast Balance Assumptions
11. Go to the Rollover Setup page.

12. Select the 6 month and 60 month CD product as your source product leaves.

a. Highlight the CD 60 months product in the Available Leaves list.

b. Select Add to move the product to the Source Leaves list.

c. Highlight the CD 6 month product in the Available Leaves list.

d. Select Add to move the product to the Source Leaves list. 

e. Leave the Runoff Type for each of these leaves as the default (Total Runoff).

13. Define a single bucket range, encompassing the entire modeling horizon. 

a. Verify that the selected start bucket is bucket 1. This should be the default 
option.

b. Verify that the selected end bucket is bucket 120. This should be the default 
option.

c. Select Add to create this bucket range The selected rollover sources and 
bucket information should appear as shown in the example:
Forecast Balance ID 10-21



Examples of Forecast Balance Assumptions
14. Go to the Rollover Detail Page. On this page, the Rollover Sources are displayed 
as rows going down the table. The rate spreads are displayed as columns going 
across the top of the table. The single bucket range is displayed in the bucket 
range field.

15. Go to the first cell in the spreadsheet corresponding to CDs 6 month and a 
-2.00% spread. Input a rollover amount of 0.000% into this cell.

16. Go to the next cell corresponding to CDs 6 months and a 0% spread. Input 10% 
rollover into this cell.

17. Go to the final cell in this row, corresponding to CDs 6 months and a 2.000% 
spread. Input 30% rollover.

18. Go the next row corresponding to CDs 60 months.

19. Input the following values for the 60 months CD product: 10% rollover for a 
-2% spread, 20% rollover for a 0% spread, and 110% rollover for a 2% spread. 
The rollover information should match the example shown below:
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Processing New Business in an RM Process ID
To process the assumptions you have input, the Forecast Balance ID must be 
selected in a Risk Manager Process ID. The output process selections defined within 
the Process ID determine which forecast balance assumptions per currency are 
used. If processing output is product-only, forecast balance assumptions for the 
reporting currency are processed. New business assumptions for all other curren-
cies are ignored. If the output is product and currency, forecast balance assump-
tions for each product and currency combination are processed.

See Chapter 20, "Process ID" for more information.
Forecast Balance ID 10-23



Examples of Forecast Balance Assumptions
10-24 Oracle Risk Manager Reference Guide



Forecast R
11

Forecast Rates ID

The Forecast Rates ID calculates future interest rates and future currency exchange 
rates. Use interest rate forecasts to project cash flows, including pricing new busi-
ness, repricing existing business, calculating prepayments, and determining dis-
count methods. Use currency exchange rate forecasts to account for the effects of 
currency fluctuations on income.

The Forecast Rates ID uses interest rate and currency codes stored in Rate Manager, 
including all the active and reporting currencies and the primary, or functional, cur-
rency at your institution. See the Oracle Financial Data Manager Rate Manager Refer-
ence Guide for how to define interest rates and currency exchange rates.

This chapter describes how to create a Forecast Rates ID to forecast cash flows and, 
if you work with multiple currencies, to model relationships between interest rates 
and exchange rates. Topics include:

■ Creating a Forecast Rates ID

■ Currency Forecast Methods

■ Interest Rate Forecast Methods

Creating a Forecast Rates ID 
1. From the File menu, select New -> Forecast Rates ID.

2. Select a folder.

3. Type a descriptive name for the ID.

4. Type a description for the ID. This is an optional field.

5. Click Read/Write.

6. Select a reporting currency.
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7. Click OK.

Features of the Forecast Rates ID
The reporting currency you selected when creating the Forecast Rates ID appears in 
the title bar. Each forecast scenario you create, up to nine, will appear under Cur-
rent Scenarios. Forecast scenarios use the date buckets specified in the active Con-
figuration ID.

The active currencies from Rate Manager are listed under Currency Codes. The 
selection under Currency Codes is the same as the reporting currency when you are 
not forecasting exchange rates. The list of IRCs under Interest Rate Codes is depen-
dent on the selected currency. The IRCs, including a reference IRC for each cur-
rency, are loaded from Rate Manager. When you select a currency other than the 
reporting currency, the options under Currency Forecast Method provide several 
ways to model relationships between exchange rates and interest rates. See "Cur-
rency Forecast Methods" for more information.
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The IRCs for all active currencies (and reporting currencies, a subset of the active 
currencies) are listed under Interest Rate Codes. The options under Rate Forecast 
Method provide several ways to model the effects on portfolio cash flows due to 
interest rate changes. See "Interest Rate Forecast Methods" for more information.

Currency Forecast Methods
The following currency forecast methods are available when you select a currency 
(other than the reporting currency) from the Currency Codes list.

Examples of Currency Forecasting
The examples below use the following data to demonstrate currency forecast meth-
ods: 

■ Reporting currency = U. S. dollars (USD is shown in the title bar)

■ Local currency = Australian dollars (converting from Australian dollars (AUD) 
to USD)

■ Exchange rate loaded from Rate Manager = 1.7 AUD to 1 USD (rate in effect on 
the as-of date, 12/31/93)

■ Modeling period = 01/01/1994 to 12/31/2003

As you follow the steps, substitute similar data at your site if this particular data is 
not available. 

Select To

Flat Forecast no change in the exchange rate for all dates beginning with 
the as-of date.

Structured Change Forecast exchange rates as an incremental change from the previous 
period.

Direct Input Type exchange rates to use in forecasting.

The following methods are available when the selected currency has an associated reference 
IRC as defined in Rate Manager:

Parity Forecast the exchange rate between two currencies based on interest 
rate forecasts for the reference IRC associated with each of the 
currencies.

Forward Forecast the exchange rate required to maintain a no arbitrage 
condition between two currencies.
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To Begin  For all examples, begin by doing the following:

1. Create a new Forecast Rates ID with USD as the reporting currency. (See 
"Creating a Forecast Rates ID" in this chapter.)

2. In the Forecast Rates ID window, add (or rename) a scenario:

a. Click Add (or Rename).

b. Type a name for the scenario.

c. Click OK.

Flat Method  Calculate the exchange rate of Australian dollars to $1 U. S., modeling 
no change in the exchange rate during the modeling period.

In the Forecast Rates ID window, do the following:

1. From Currency Codes, select AUD: Australian Dollar.

2. From Currency Forecast Method, click Flat.

3. Click View.

Under Rate Value, you will see the exchange rate: $1.7 AUDs equal $1 USD. This 
rate is applied uniformly to all date buckets, based on the rate in effect at the 
as-of date in the active Configuration ID.
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4. Click Close.

5. From the File menu, select Save.

Structured Change  Model a change in the exchange rate so that the rate increases by a 
total of 0.5% over five months, levels off for seven months, and then drops a total of 
0.25% over nine months.

In the Forecast Rates ID window, do the following:

1. From Currency Codes, select AUD: Australian Dollar.

2. From Currency Forecast Method, select Structured Change.

3. Click Define.

4. Add rows and type bucket numbers and rate changes as follows:

Start Bucket End Bucket From Date To Date Total Rate Change

1 5 01/01/94 05/31/94 0.50
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5. Click OK.

6. Click View.

The Rate Value column shows the forecasted exchange rates. Notice that the 
0.5% total rate change over five 1-month buckets produces a 0.1% increase in 
each month until 05/31/1994, after which the rate remains constant until 
12/31/1994. The 0.25% decrease from 01/01/95 to 09/30/95 is apportioned 
over the three buckets, producing a 0.0833 decrease for each 3-month bucket 
(each bucket is 1/3 of the total rate change period).

7. Click Close. 

8. From the File menu, select Save.

6 12 06/01/94 12/31/94 0.00

13 15 01/01/95 09/30/95 -0.25

Start Bucket End Bucket From Date To Date Total Rate Change
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Direct Input  Model a change in the exchange rate so that rates reflect a stronger U. S. 
dollar during the spring of 2000.

In the Forecast Rates ID window, do the following:

1. From Currency Codes, select AUD: Australian Dollar.

1. From Currency Forecast Method, select Direct Input.

2. Click Define.

3. Type rate values for the following dates:

4. Click OK.

5. Click View.

The rate values you typed in step 3 are applied.

From Date To Date Rate Value

03/01/2000 03/31/2000 2.10

04/01/2000 04/30/2000 2.40

05/01/2000 05/31/2000 2.65
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6. Click Close.

7. From the File menu, select Save.

Parity  Model a period of rising interest rates for the U. S. and Australian dollars. Use 
the parity method to forecast the exchange rate of Australian dollars to $1 U. S. Par-
ity is calculated based on the forecast interest rates of the reference IRCs of the Aus-
tralian dollar and the U. S. dollar.

In the Forecast Rates ID window, forecast changes in the U. S. dollar interest rate:

1. From Currency Codes, select USD: US Dollar.

2. From Interest Rate Codes, select Treasury Index.

3. From Rate Forecast Method, click Direct Input.

4. Click Define.
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5. Type interest rate changes for 06/01/2000 through 12/31/2001 as follows:

6. Click OK.

In the Forecast Rates ID window, forecast changes in the Australian dollar reference 
interest rate:

1. From Currency Codes, select AUD: Australian Dollar.

2. From Interest Rate Codes, select IRC AUD1.

3. From Rate Forecast Method, click Direct Input.

4. Click Define.

5. Type interest rate changes for 06/01/2000 through 12/31/2001 as follows:

6. Click OK.

In the Forecast Rates ID window, view the forecasted exchange rate:

1. From Currency Forecast Method, click Parity.

2. Click View.

The Rate Value column shows the forecasted exchange rate of Australian 
dollars to $1 U. S.

From Date To Date 1 Month 3 Month 6 Month 12 Month

Base 5.0000 5.2000 5.4500 5.5500

26 06/01/2000 06/30/2000 6.0000 6.2000 6.4500 6.5500

27 07/01/2000 12/31/2000 7.0000 7.2000 7.4500 7.5500

28 01/01/2001 12/31/2001 8.0000 8.2000 8.4500 8.5500

From Date To Date 1 Day 7 Day 30 Day 2 Month 1 Year

Base 4.1380 4.2375 4.5125 4.5689 5.1250

26 06/01/2000 06/30/2000 5.1380 5.2375 5.5125 5.5689 6.1250

27 07/01/2000 12/31/2000 6.1380 6.2375 6.5125 6.5689 7.1250

28 01/01/2001 12/31/2001 7.1380 7.2375 7.5125 7.5689 8.1250
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3. From the File menu, select Save.

Forward  Forecast the exchange rates required to maintain equilibrium between the 
U. S. and Australian dollars. The forecast is based on the historical interest rates 
from the reference IRC of each currency. This example assumes that the following 
reference IRCs have been assigned in Rate Manager:

■ U. S. dollar: Treasury Index

■ Australian dollar: IRC AUD1

In the Forecast Rates ID window, do the following:

1. From Currency Codes, select AUD: Australian Dollar.

2. From Currency Forecast Method, click Forward.

3. Click View.

The Rate Value column shows the forward exchange rate of Australian dollars 
to $1 U. S.
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4. From the File menu, select Save.

Interest Rate Forecast Methods
The following interest rate forecast methods are available.

Select To

Flat Forecast no change in the interest rate for all dates beginning with 
the as-of date.

Structured Change Forecast rate changes, for any modeling period or interest rate term, 
such as:

■ +100 basis points on Day 1

■ -200 basis points over the first 6 months

■ Yield curve rotation (short point decreasing, long point 
increasing)
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Examples of Interest Rate Forecasting
As you follow the steps in the examples, substitute similar data at your site if this 
particular data is not available. See "To Begin" in this chapter to set up the examples.

Flat  View U. S. dollar interest rates forecasted for the Treasury Index.

1. From Currency Codes, select USD: US Dollar.

2. From Interest Rate Codes, select Treasury Index.

3. From Rate Forecast Method, click Flat.

4. Click View.

The Interest Rate View window displays the rates forecasted for the Treasury 
Index.

Direct Input Type interest rates directly, for any modeling period or interest rate 
term.

Implied Forward Forecast interest rates based on the yield-curve interest rates in effect 
at the as-of date and consistent with the modeling bucket definitions.

Change from Base Make incremental changes to an existing forecast scenario.
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Structured Change  Model a gradual increase for six months in U. S. dollar interest 
rates. 

1. From Currency Codes, select USD: US Dollar.

2. From Interest Rate Codes, select Treasury Index.

3. From Rate Forecast Method, click Structured Change.

4. Click Define.

5. Type the following interest rate changes: 

6. Click OK.

7. Click View.

8. The rate increases you typed in step 5 are apportioned equally over six months. 
Therefore, in monthly buckets 21–26, you will expect to see the following 
increments added to the Treasury Index interest rates: 

The interest rates in buckets 21–26 reflect the increases.

Start 
Bucket

End 
Bucket From Date To Date

1 
Month

3 
Month

6 
Month

12 
Month

1 21 26 01/01/2000 06/30/2000 1.0000 1.250 1.500 1.750

1 Month 3 Month 6 Month 12 Month

1/6 of 1.000 = 0.1667 1/6 of 1.250 = 0.2083 1/6 of 1.500 = 0.2500 1/6 of 1.750 = 0.2917
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9. From the File menu, select Save.

Direct Input  To use the Direct Input method, see "Structured Change" with the fol-
lowing modifications: 

■ In step 3, click Direct Input

■ In step 5, type interest rates (forecasted rates for each bucket rather than 
forecasted rate changes over a period of one or more buckets).

Implied Forward  View U. S. dollar interest rates forecasted from the Treasury Index 
rates and terms in effect at the as-of date and consistent with the modeling buckets.

1. From Currency Codes, select USD: US Dollar.

2. From Interest Rate Codes, select Treasury Index.

3. From Rate Forecast Method, click Implied Forward.

4. Click View.
11-14 Oracle Risk Manager Reference Guide



Generating Graphs of Rates
5. Click Close.

6. From the File menu, select Save.

Change from Base  Select a forecast rates scenario that you have already defined and 
saved and change it by typing incremental changes to rates. For example, you might 
want to forecast scenario 7 based on incremental changes to the rates in scenario 5.

Generating Graphs of Rates
You can use Copy and Paste commands to copy data from a Forecast Rates ID view 
to a spreadsheet for graphical analyses. The following shows a graph of a yield 
curve rotation generated through any graphical package.
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Formula ID

A Formula ID is a user-defined tool that supplements other IDs and enables you to 
further and more flexibly manipulate data. Formula IDs have three different uses:

■ To specify a calculated column that the Oracle Financial Services (OFS) 
application derives from other columns in the database

■ To calculate assignments in data correction

■ To create calculated conditions in data and relationship filters.

For example, you want to calculate a weighted average rate that requires a calcula-
tion involving total net balance and the current rate on each individual account. You 
can use a Formula ID to define this calculation.

The OFS applications handle a Formula ID like any database column. The applica-
tions display all Formula IDs under the Formula selection in the instrument table 
lists, however.

This chapter discusses the following topics:

■ Using the Formula ID Window

■ Creating a Formula ID

■ Editing a Formula ID

■ Reviewing Formula ID Examples

Using the Formula ID Window
The Formula ID window comprises elements that you use to build formulas.
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The formula elements are:

■ Operators and Operands

■ Function Types and Functions

■ Constants

■ Tables and Output Columns

Only those formula elements that you can add logically at the next point of a for-
mula are available for use. The OFS application disables or hides the formula ele-
ments that are not applicable.

You use the formula elements as you need them. For example, you may need a for-
mula to calculate the weighted average of your commercial loans. You must first 
select Mathematical as the function type and WAvg as the function before you select 
the columns under the Commercial Loans table. However, you can build a formula 
that does not require a function. It may need only operators and operands.

The following sections describe the formula elements and provide basic informa-
tion on how to use them.
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Operators and Operands
Operators and Operands are displayed as buttons across the top of the Formula ID 
window.

The operands available are left parenthesis, right parenthesis, and comma. Paren-
theses group segments of a formula to make logical sense. The comma separates 
statements of a function.

The mathematical operators available are:

■ +

■ -

■ *

■ /

■ =

■ >

■ <

■ <>

■ >=

■ <=

You can use these operators to apply mathematical operators to the formula.

Add enables you to add the currently highlighted database column or operator to 
build the formula.

Function Types and Functions
You select the type of function for your formula from the Type list. The choices are: 

■ Mathematical Functions

■ Date Functions

■ String Functions

■ Other Functions

The type of function you select determines the choices available in the Function box. 
These unique functions of the Formula ID enable you to perform various opera-
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tions on the data. The following tables list each available function. Detail on the 
operations of each function follows the table in which it appears.

Mathematical Functions
When you select Mathematical as the function type, you can use the following 11 
functions from the Functions box:

The following descriptions provide detailed information about the mathematical 
functions, including examples.

Absolute Value: Returns the positive value of the database column

Example: ABS (-3.5) = 3.5.

ABS function syntax:

{ABS( } followed by {EXPR1 without any embedded or outermost left-right 
parentheses pair} followed by { )}

For example, ABS(F), ABS(F + C), ABS(F + C * R + F) are possible. However, 
ABS((F + C + R)), ABS((F + (MAX * CEILING))) are not possible.

Ceiling: Rounds a value to the next highest integer

Example: 3.1 becomes 4.0, 3.0 stays the same

Syntax: Ceiling(column or expression)

Function Notation

Absolute Value ABS()

Ceiling CEILING()

Greatest GREATEST(column or expression, column or expression)

Least LEAST(column or expression, column or expression)

Maximum MAX()

Minimum MIN()

Natural Log LN(number)

Power POWER(coeffecient, exponent)

Round ROUND (number, precision)

Sum SUM()

Weighted Average WAvg (column being averaged, weight column)
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Greatest: Returns the greater of 2 numbers, formulas, or columns

Syntax: Greatest(column or expression, column, or expression)

Least: Returns the lesser of 2 numbers, formulas, or columns

Syntax: Least(column or expression, column or expression)

Maximum: Returns the maximum value of a -database column

Syntax: Max(Column)

Minimum: Returns the minimum value of a -database column

Syntax: Min(Column)

Natural Log: Returns the natural logarithm of a number

Natural logarithms are based on the constant e (2.71828182845904).

Syntax: LN(number) where number is the positive real number for which you 
want the natural logarithm

Examples:

LN(86) equals 4.454347

LN(2.7182818) equals 1

Power: Raises one value to the power of a second

Syntax: Power(x, y) returns x raised to the power of y

POWER function syntax:

{POWER(} followed by {EXPR1 without any embedded or outermost left-right 
parentheses pair followed by {,} followed by {EXPR1 without any embedded or 
outermost left-right parentheses pair} followed by { )}

Valid examples:

POWER(F, R)

POWER(F + C * R, F / R)

Note : You cannot use the Maximum and Minimum functions as 
calculated columns or in Data Correction Rules. The Maximum, 
Minimum, Sum, and Weighted Average functions are multi-row 
formulas. They use multiple rows in calculating the results.
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Invalid examples:

POWER((F/R), F + R)

POWER((F + C), (C * R))

POWER(F + POWER, R)

POWER( MAX, C) 

Round: Rounds a value to a number of decimal places

Syntax: Round(x, n) returns x rounded to n decimal places

Sum: Sums the total value of a database column. Sum is a multi-row function, in 
contrast to +, which adds 2 or more values in a given row (not column)

Syntax: Sum(Column).

Weighted Average: Takes a weighted average of one database column by a second 
column

Syntax: WAvg(Column A, Column B)

Example: 

WAvg(DEPOSITS.CUR_NET_RATE,DEPOSITS.CUR_BOOK_BAL)

WAvg cannot appear in any expression.

If you have two formulas called F1 and F2, both of which are WAvg functions, 
then you can form a third formula F3 as F1 + F2. If F3 is chosen as a calculated 
column, then an error message appears and the SQL code is not generated for 
that column. This is similar for nested WAvg functions if F3 is WAvg and it has 
F1 or F2 or both as its parameters.

Date Functions
Four functions are available when you select Date as the function type:

Function Notation

Build Date BUILDDATE(CCYY,MM,DD)

Go Month GOMONTH(date,number of months)

Month MONTH(number)

Year YEAR(date)
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The following descriptions provide detailed information about the date functions, 
including examples.

Build Date: Requires three parameters, (CCYY,MM,DD) (century and year, month, 
day). It returns a valid data and enables you to build a date from components.

Example: BuildDate(95,11,30) is invalid (invalid century). BuildDate(1995,11,30) 
is valid. 

Go Month: Advances a date by x number of months.

Syntax: GOMONTH(Date column, Number of months to advance) 

Example:

GOMONTH(DEPOSITS.ORIGINATION_DATE,DEPOSITS.ORG_TERM)

Go Month does not know the calendar. For example, it cannot predict the last 
day of a month. Typical functionality is illustrated in the following table:

GOMONTH function syntax:

{GOMONTH( } followed by {F | C | R} followed by {,} followed by {EXPR1 
without any embedded or outermost left-right parentheses pair} followed by {)}

Valid examples:

GOMONTH(F, F + R + C)

GOMONTH(F, R)

Invalid examples:

CAUTION: If the parameters are entered incorrectly, the date is 
invalid.

Date Column # of Months GOMONTH Comment

1/31/94 1 2/28/94 Because 2/31/94 does not exist

1/15/94 2 3/15/94 Exactly 2 months:15th to 15th

2/28/94 3 5/28/94 Goes 28th to 28th: does not know that 31st 
is the end of May

6/30/94 -1 5/30/94 Goes back 30th to 30th: does not know that 
31st is end of May
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GOMONTH(F + (R + C), MAX)

GOMONTH((F * C), F)

GOMONTH followed by {+ | -} followed by {F | C | R} is the only 
expression possible with GOMONTH.

Month: Month(x) returns the month in x, where x is a numbered month.

Month(Column) returns the month in the column, where the column is a date 
column.

Examples: 

Month(9) returns September.

Month(Origination Date) returns the month of the origination date.

Year: Year(x) returns the data for year x.

Year(Column) returns the year in the column, where the column is a date 
column.

Example: Year(Origination Date) returns the year of the origination date.

String Functions
Only one function is available when you select String as the function type:

Other Functions
Two functions are available when you select Other as the function type:

The following descriptions provide detailed information about the other functions, 
including examples.

Function Notation Description

Trim All ALLTRIM() Trims leading and following spaces, enabling 
the software to recognize numbers (entered in 
All Trim) as a numeric value, which can then 
be used in calculating

Function Notation

If statement IF(logical_test, value_if_true, value_if_false)

Lookup LOOKUP(original table column,lookup table column, return column)
12-8 Oracle Risk Manager Reference Guide



Using the Formula ID Window
If: Use If, then logic in a formula. The syntax for the If function is: 

If(Condition, Value if True, Value if False).

Example: 

If(LEDGER_STAT.Financial= 110, LEDGER_STAT.Month 1 Entry,0)

IF function syntax:

{IF( } followed by EXPR2 followed by {> | < | <> | = | >= | <=} followed by 
EXPR2 followed by {{,} followed by EXPR followed by ),} followed by EXPR}n 
followed by {)} where n = 1, 2, 3, .....

The IF function should always have odd number of parameters separated by 
commas. The first parameter is an expression followed by a relational operator, 
which is in turn followed by an expression.

For example, IF(((MAX + SUM) >= 30), F, POWER) is valid.

Lookup: Enables you to assign values equal to values in another table for data cor-
rection.

LOOKUP function syntax:

Lookup(O1,L1,O2,L2,...On,Ln,R) where 

O=Column from Original table

L=Column from Lookup table

R=Column to be Returned

So the previous statement would read:

where O1=L1 and O2=L2... Returned value R

LOOKUP function should always have an odd number of parameters separated 
by commas and with a minimum of 3 parameters.

Valid examples:

LOOKUP(F, R, R)

LOOKUP(F, R, F, F, F)

Invalid examples:

Note: Avoid embedding multiple individual formulas in subse-
quent formulas. This can create an invalid formula.
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LOOKUP(F)

LOOKUP(F, R)

LOOKUP(F + R, (F + R), MAX)

Constants
The Constant box enables you to apply a constant value to the formula. You type a 
value into the box and click Insert Constant to insert the value of a constant into the 
formula.

Tables and Output Columns
The Tables box enables you to select the table that holds a specific database column 
you want to include in a formula. Once you select a table, the application displays 
the columns associated with that table in the Output Columns box.

You can use the Formula table to access any previously defined formulas.

Output Columns (Data Elements)
To use a column (a data element) in the formula, select that column and then click 
Add in the Operand box, or double-click on the column name to add it to the for-
mula.

Formula Box
The Formula box displays the formula as you create it.

Note: Lookup is used exclusively for data correction.
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Edit Options
The Edit box and option buttons provide full control of formula editing.

Clear
The Clear option clears the entire formula box of all logic.

Delete
The Delete option deletes the parts of the formula that you select. Select the for-
mula element that you want to delete and click Delete.

Insert
The Insert option inserts operators, operands, or constants into the formula at the 
cursor position. To insert an element, complete the following steps:

1. Place your cursor in the formula where you want to insert an element, and click 
Insert.

2. Select the item you want to insert. Double-click a column or function, or click 
the operator button and then click Add. 

Your insertion element appears in the Edit box for verification.

3. Press Insert again. 

A warning dialog appears.

4. Click Yes to insert, or click No to reselect your insertion element. You can click 
Cancel to cancel the operation.

Replace
The Replace option replaces a formula element that you select. To replace a formula 
element, complete the following steps:

1. Select the formula element that you want to replace, and click Replace.

Note: You cannot delete any portion of a formula if the deletion 
results in leaving an invalid formula.

Note: You cannot insert expressions, operators, or constants that 
result in leaving an invalid formula.
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2. Select the replacement item. Double-click a column or function, or click the 
operator button and then click Add. 

Your replacement element appears in the Edit box for verification.

3. Click Replace again. 

A warning dialog appears.

4. Click Yes to confirm the replacement, or click No, and reselect your replacement 
element.

5. Click Cancel to cancel the operation.

Null Values in the Database
A null value in a column in the database is a column that has no data. You should 
take all necessary steps to avoid having null columns in the database for the follow-
ing reasons:

■ Any null value accessed in a formula results in a null value. For example:

If we define a formula as X + Y, the answer is 150 + null = null. All operations 
(such as +, -, /, *, ^) are handled in this same manner.

■ You cannot define a filter to recognize null values. The Data Filter ID assumes 
that the database does not have any null values. Consequently, you cannot 
define a Data Filter ID to isolate all rows with a null value in a given column.

You can identify null values by using an SQL statement to select all rows 
WHERE <Column> IS NULL.

Note: You cannot replace a selected element that results in leav-
ing an invalid formula.

Column X Column Y

150 null

Note: Null <> 0, so filtering on 0 does not return rows with null 
values.
12-12 Oracle Risk Manager Reference Guide



Creating a Formula ID
Formula ID Creation Hints
The Formula ID is a flexible method for creating formulas. Consequently, you have 
the potential to define a formula that does not make sense. Consider the following 
recommendations when creating a Formula ID:

■ Do not use a column out of context. For example, do not use a character field in 
a numeric calculation.

■ Each formula should contain only columns from the same database table 
(except for certain Ledger_Stat table columns).

■ An implied filter exists when creating a Formula ID with columns in the 
LEDGER_STAT table. LEDGER_STAT table formulas include if/else decode 
logic based on the Configuration ID as of date. 

Example: If the formula is Month_01 - 100, a filter includes Year_S equal to the 
as of date/year. This formula works as follows:

Year_S = 1994, then Month_01 - 100, else 0.

Creating a Formula ID
Use the following instructions to create and define a Formula ID. See Chapter 4, 
"Overview of IDs" for further explanation about ID creation and maintenance.

To create a Formula ID, perform the following steps:

1. From the File menu, click New.

A list of the IDs that are available for the product you are using appears.

2. Select the Formula ID.

 The New Formula ID dialog box appears.

3. Type the name for the ID in the Formula ID field.

4. Select Folder.

5. Type in the Formula ID and Description fields, as required.

6. Select the permission level of the ID, as required.

Note: Formula ID Names cannot contain spaces or special charac-
ters, such as dash (-) or slash (/).
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Read/Write is the default.

7. Click OK to continue.

The Formula ID window appears.

8. Build the formula using the formula elements. 

See "Using the Formula ID Window" in this chapter for information on using 
the formula elements in the Formula ID window.

9. Save the ID.

Editing a Formula ID
To edit a Formula ID, perform the following steps:

1. From the File menu, click Open.

A list of the IDs that are available for the product you are using appears.

2. Select the Formula ID.

 The Select Formula ID dialog box appears.

3. Type the name of or select the ID and Formula ID that you want to edit.

4. Click OK to continue.

The Formula ID window appears.

5. Make the editorial changes.

6. When you finish the editing, save the ID.

Reviewing Formula ID Examples
The following four examples demonstrate how you can use the Formula ID to 
achieve various results.

Example 1  Use If, Then Logic to Determine Average Daily Balance
The following steps create a Formula ID that calculates the Average Daily Balance 
for January from the Ledger Stat table.

1. From the File menu, click New.

A list of the IDs that are available for the product you are using appears.

2. Select the Formula ID.
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 The New Formula ID dialog box appears.

3. Select All from the Folder.

4. Type JAN_ADB in the Formula ID field.

5. Type Avg Dly Bal-Jan in the Description field.

6. Click Read/Write.

7. Click OK to continue.

The Formula ID window appears.

8. Select Ledger Stat from the Tables box.

9. Select Other from the Type box.

10. Double-click If from the Functions box.

11. Select Financial Element ID from the Output Columns box and click Add in the 
Operand box.

12. Click the = (equal operator) from the Operand box.

13. Type 140 in the Constant box, and then click Insert Constant.

14. Click the , (comma operand) from the Operand box.

15. Select Month_01 from the Output Columns box and click Add in the Operand 
box.

16. Click the , (comma operand) from the Operand box.

17. Type 0 in the Constant box, and then click Insert Constant.

18. Click the ) (close parenthesis operand) from the Operand box.

Example 2  Current Net Book Balance
The following steps create a Formula ID that calculates the current net book bal-
ance for Commercial Loans. This ID multiplies the current gross book balance by 
the percent owned (Gross Book Balance * Percent Owned):

1. From the File menu, click New.

A list of the IDs that are available for the product you are using appears.

Note: The Oracle Financial Data Manager (FDM) database carries 
the percent sold, so the percent owned must be calculated.
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2. Select the Formula ID.

 The New Formula ID dialog box appears.

3. Select All from the Folder.

4. Type CL_NETBKBAL in the Formula ID field.

5. Type CL Net Book Bal in the Description field.

6. Click Read/Write.

7. Click OK to continue.

The Formula ID window appears.

8. Select Commercial Loan from the Tables box.

9. Select Current Gross Book Balance from the Output Columns box, and then 
click Add in the Operand box.

10. Click the * (multiply operator) from the Operand box.

11. Click the ( (open parenthesis operand) from the Operand box.

12. Type 100 in the Constant box and then click Insert Constant.

13. Click the - (minus operator) from the Operand box.

14. Select Percent Sold from the Output Columns box, and then click Add in the 
Operand box.

15. Click the ) (close parenthesis operand) from the Operand box.

16. Click the / (divide operator) from the Operand box.

17. Type 100 in the Constant box, and then click Insert Constant.

18. Click the ) (close parenthesis operand) from the Operand box.

Example 3  Average Current Net Book Balance
The following steps create a Formula ID that calculates the average current net book 
balance for each row in a Commercial Loan Stratification Report:

1. From the File menu, click New.

A list of the IDs that are available for the product you are using appears.

2. Select the Formula ID.

 The New Formula ID dialog box appears.
12-16 Oracle Risk Manager Reference Guide



Reviewing Formula ID Examples
3. Select All from the Folder.

4. Type CL_AVGNETBK in the Formula ID field.

5. Type CL Avg Net Bk Bal in the Description field.

6. Click Read/Write.

7. Click OK to continue.

The Formula ID window appears.

8. Select Commercial Loan from the Tables box.

9. Select Mathematical from the Type box.

10. Double-click WAvg in the Functions box.

11. Select Current Net Book Balance from the Output Columns box, and then click 
Add in the Operand box.

12. Click the , (comma operand) from the Operand box.

13. Select Record Count from the Output Columns box, and then click Add in the 
Operand box.

14. Click the ) (close parenthesis operand) from the Operand box.

Example 4  Weighted Average Current Net Rate 
The following steps create a Formula ID that calculates the weighted average cur-
rent net rate for each row in a Commercial Loan Stratification Report.

1. From the File menu, click New.

A list of the IDs that are available for the product you are using appears.

2. Select the Formula ID.

 The New Formula ID dialog box appears.

3. Select All from the Folder.

4. Type CL_AVGNETRATE in the Formula ID field.

5. Type CL Avg Cur Net Rate in the Description field.

6. Click Read/Write.

7. Click OK to continue.

The Formula ID window appears.
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8. Select Commercial Loan from the Tables box.

9. Select Mathematical from the Type box.

10. Double-click WAvg in the Functions box.

11. Select Current Net Rate from the Output Columns box, and then click Add in 
the Operand box.

12. Click the , (comma operand) from the Operand box.

13. Select Current Net Book Balance from the Output Columns box, and then click 
Add in the Operand box.

14. Click the ) (close parenthesis operand) from the Operand box.

15. Save and close the ID.
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Formula Leaves ID

With the Formula Leaves ID you can model a product leaf using the results of the 
cash flow, gap, and market value processes to recalculate and change system-gener-
ated data. You can also model a product leaf outside of the cash flow engine, using 
formulas to create financial element values. The Formula Leaves ID uses a spread-
sheet to define all formulas.

For example, you may want to model the ending balance of a particular account as 
110% of the ending balance of a second account. You can also vary the balance level 
of an account as interest rates change. These relationships are defined in a Formula 
Leaves ID. 

There are three formula types: 

■ Cash flow

■ Dynamic gap

■ Market value

Rate financial element results are stored as a rate times balance amount, not a rate. 
The rate is also weighted as specified. For a list of financial elements, see the Oracle 
Financial Services Technical Reference Manual.

Creating a Formula Leaves ID
To define a Formula Leaves ID, complete the following steps:

1. From the File menu, choose New/Formula Leaves ID.

2. Use the drop-down lists to choose the Group and Leaf Types.

3. Type a descriptive name for the ID.

4. Type a description for the ID. This is an optional field.
aves ID 13-1
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5. Click Read/Write.

6. Click OK.

The Formula Leaves ID screen appears with the name of the ID shown on the top of 
the screen and a floating Tree Bar next to it.

Defining a Formula Leaves ID
You can define a formula for any leaf. If there is data that is processed for the leaf 
selected, your formula generates an additional row of data, identified as a result 
type of Formula. This row stores the incremental change to the existing data. For 
more information, see the section "Process Flow" in the chapter.

Select a Leaf
On the Tree Bar, select the leaf for which you want to define a formula. You can 
define a formula for any leaf. 

Process ID 
With the Formula Leaves ID, you can preview the results of any formula you are 
creating. This preview is based on the Process ID you select. The default Process ID 
is None. To process results through the Formula Leaves ID, select it in the Process 
ID.
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Scenario 
In conjunction with the Process ID, select which respective rate scenario to view. If 
no rate scenario is chosen, you will not be able to preview results.

Formula Leaves
There are three types of Risk Manager results: Cash Flow, Dynamic Gap and Mar-
ket Value. Select the type by clicking on the dialog box that displays Cash Flow and 
highlight your selection from the menu.

Once you have selected the type of results you want to simulate, click the Add Leaf 
button to enter the Leaf ID number and Description of the product leaf you wish to 
create. You may enter the Leaf ID number directly or highlight the leaf in the Tree 
Bar and click twice. Additional leaves may be added by repeating the above pro-
cess.

To open the formula section of the ID, click the Use button beside the leaf to be 
modeled and then click the Open button. An additional window will appear dis-
playing a spreadsheet template. The name of the product leaf you have selected 
appears in the window title bar.

If you would like to define a standard formula account type, you can populate the 
set of financial elements you need by selecting a Financial Type. To do this, click on 
the Financial Type box. Select the type of formula you wish to create. This will auto-
matically add rows in the spreadsheet for all relevant financial elements.

Note: Selecting a Financial type will replace all rows defined in 
the spreadsheet.
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The display of Financial Elements is a template. You can add, delete or replace ele-
ments. To move elements up or down within the spreadsheet, highlight the row 
number of the financial element and click the Move Down or Move Up button.

The Financial Type is a tool to help you enter a set of financial elements quickly. The 
selections are not saved as part of the ID. When you exit the ID, and re-enter later, 
None will be displayed.

Adding a Financial Element
To add a financial element, complete the following steps:

1. To increase the number of rows in the spreadsheet, click the up spinner arrow.

2. Place the cursor on the row you wish the new element to be created.

3. Select the financial element from the drop down list. Highlight desired element, 
and click Add. The new element appears in the selected row.

When you select a rate or term related financial element, its associated balance is 
inserted automatically.

Deleting a Financial Element
Consider reporting and autobalancing when deleting financial elements. For 
instance, defining a beginning balance and ending balance without an average bal-
ance will produce unusual autobalancing values, as all balances are used in the 
autobalancing process.

To delete a financial element, complete the following steps:

1. Highlight the row containing the financial element to be deleted. 

2. Move the financial element to the bottom of the list of financial elements by 
clicking the Move Down button. 

3. Delete the last row by clicking the down spinner arrow to reduce the number of 
rows in the spreadsheet by one.

Note: When creating formulas on rate financial elements, you 
must retain the associated balance financial element. If the associ-
ated balance financial element is removed, the end result for these 
rate and term financial elements will be zero, because they will be 
weighted by a zero balance.
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Process Flow
Before you begin entering formulas, it is important to understand how Formula 
Leaves IDs are processed in Risk Manager. Following are the rules regarding the 
flow of processing in Formula Leaves IDs:

■ Risk Manager processes each leaf from the Formula Leaves ID from the top of 
the list down.

This is important for chaining the results of formula leaves. If you refer to a for-
mula leaf listed above your formula leaf, you will be referencing the post-com-
puted answer. If, however, you refer to a formula leaf listed below your formula 
leaf, you will be referencing the pre-computed answer (if any).

■ Within each Formula Leaf, Risk Manager processes Market Value results, then 
Cash Flow, then Gap 

This is important because Market Value (Static) results can be accessed within 
both Cash Flow and Gap formulas.

RM only computes the Market Value and Gap sections of the Formula Leaves 
ID if the appropriate Processing Options are selected in the RM Processing ID. 
There is one exception: The as-of-date bucket in the Market Value section (e.g. 
the current position amount) will always be processed when the Formula 
Leaves processing option is selected.

■ Within a given Formula Leaf, The Formula Leaves ID process row by row verti-
cally within the first bucket to the end and then it begins processing at the top 
of the next bucket.

This is very important to understand before you begin setting up your formu-
las. Because of the way Formula Leaves ID processes, you cannot use a result in 
your formula on row 1 that is computed on row 8. However, you may use a 
result from row 8 of the first bucket in a formula in row 1 of the second bucket.

■ the Formula Leaf process adds an additional row for each formula. This row 
stores the change in value. It does not delete existing results. This enables For-
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mula Leaf IDs to be processed multiple times without losing the initial data 
generated through standard processing.

Defining Coefficients
Coefficients can be defined prior to opening a formula leaf, or while setting up a 
formula within the spreadsheet. You may define your entire formula leaf for a par-
ticular Chart of Account Leaf and then go back and set up your coefficients. You 
simply need to remember which user-defined code you used in your formula.

To define a coefficient, complete the following steps:

1. Click the Coefficients button, located on the initial Formula Leaves ID screen. 

Note that the dialog’s title bar displays the financial type. Coefficients are 
defined by result set type: Cash Flow, Gap or Market Value. You can use coeffi-
cients for any one of the formula leaves. However, you cannot use Cash Flow 
coefficients in Gap or Market Value formulas. You must define coefficients 
within their respective result set types.

Coefficients defined for Cash Flow formulas can vary by modeling date buck-
ets, as defined in your Configuration ID. Coefficients defined for Gap formulas 
can vary by Gap date buckets, as defined in your Configuration ID. Coeffi-
cients defined for Market Value formulas are static; they do not vary by bucket.

Note also that you cannot input historical coefficients (prior to the as of date). If 
you need to access historical values, you either can key the lagged values 
directly into the formulas, or create a separate coefficient where the first bucket 
is actually the oldest historical lag that you wish to access, and modify the lag 
parameters in the formulas accordingly.

2. To add coefficients, increase the number of rows in the spreadsheet by clicking 
the up spinner arrow. 

3. Assign the coefficient a number code. It can be any 3-digit code you like. Enter 
the code in the code column.

4. Enter a description of what the coefficient represents. 

5. Enter your coefficients. Use the Tab key to move to the next cell, and add 
coefficients as desired.

Deleting Coefficients
To delete a coefficient, use the down spinner to delete coefficient rows. Each time 
you reduce the number of rows by one, the last row is deleted.
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Entering Formulas
Now you are ready to enter formulas. Place the cursor in the row, click once and 
type the formula.

After you have completed entering a formula, press Enter. The formula will be dis-
played in the window above. You cannot edit in this window, but you can review 
your input and identify any errors. 

If you make a syntax error, an error message appears to warn you.

To make a correction, or to edit a formula, double click in the formula row and edit 
the formula.

The dialog allows you to enter an invalid formula. It will warn you, but you are 
allowed to exit the spreadsheet without correcting the error. This creates an invalid 
result when processing. To avoid invalid results, correct the error when you are 
warned.

Replicating Formulas in the Spreadsheet
To replicate formulas in the spreadsheet, use the standard Windows convention for 
Copy (Ctl-C), Cut (Ctl-X), and Paste (Ctl-V). Additionally, you can use the Spread-
sheet Control Bar to copy the formula for one financial element (or row in the 
spreadsheet) at a time.

Preview 
The preview option allows you to review your formula results prior to executing 
the formula leaf in a Process ID. As mentioned above, the results that will be 
accessed in the Preview will be the results of the Process ID and rate scenario you 
selected in the Processing ID window on the initial Formula Leaves ID dialog.

After you have entered the formula, you can preview the result by clicking the Pre-
view button. The formulas will be calculated and the results displayed in spread-
sheet
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The preview button becomes an edit key. To edit the formula, press the edit button.

Save the ID
Save your ID by selecting the Save icon on the horizontal toolbar, or choose 
File/Save from the menu bar.

Editing a Formula Leaves ID
To edit a Formula Leaves ID, from the File menu, choose Open, and select Formula 
Leaves ID. Alternatively, click the Open icon on the horizontal toolbar, and the For-
mula Leaves ID icon on the vertical toolbar. The Select Formula Leaves ID dialog 
appears. Select the ID you want to edit. With the ID open, make your changes fol-
lowing the principles described earlier in Define a Formula Leaves ID. 

Save your ID after you make your edits. You can use the Save As... option in the File 
menu to save your edited ID under a new name.

Formula Leaves Functions
Formula Leaves ID has its own unique functions which allows the user to access the 
various financial elements. 

Quick Reference
The following table can be used as a quick reference guide for the Formula Leaves 
functions. For more detail on each function, see "Detailed Descriptions" following 
the table.

Note: When previewing a formula that accesses another formula 
leaf using the FE, GFE, or SFE functions, you will not get the same 
answer as when you process unless you have already processed 
that prior formula leaf. This is because it is looking for post-com-
puted results. If you are simply previewing, there are no post-com-
puted results for the prior leaf.

Function
(F.E.=Financial Element) Formula

Use in 
Cash 
Flow

Use in 
Gap Use in MV

Cash Flow F.E. FE(Leaf, FE, Lag) Yes No No
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Detailed Descriptions

FE (Leaf,FE,Lag)

Used in Cash Flow Formulas only
The FE function returns the value of the Financial Element for the Leaf specified as 
stored in the Cash Flow results table.

Syntax:

Cash Flow Current Leaf F.E. CLFE (FE, Lag) Yes No No

GAP F.E. GFE(Leaf, FE, Lag) No Yes No

Gap Current Leaf F.E. GCLFE(Leaf, FE, Lag) No Yes No

Static F.E. SFE(Leaf,FE) Yes Yes Yes

Static Current Leaf F.E. SCLFE(FE) No No Yes

Cash Flow Coefficient K(Coeff, Lag) Yes No No

GAP Coefficient GK(Coeff, Lag) No Yes No

Static Coefficient SK(Coeff) Yes Yes Yes

Rate RT(IRC, Lag, Term, 
Mult)

Yes No No

Days in Bucket DAYS(Bucket) Yes No No

Month of the Bucket MONTH( ) Yes No No

Where: FE Function Name

LEAF Product leaf number desired. If the leaf value is greater than 
nine digits, it must be input with a decimal point or the 
answer will return zero. (Example: Leaf value 
123456789012345 returns a 0 value. Leaf 123456789012345.00 
returns an accurately calculated value.)

FE Financial Element Code number (see table above)

Function
(F.E.=Financial Element) Formula

Use in 
Cash 
Flow

Use in 
Gap Use in MV
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If the leaf value is the same as the formula leaf you are modeling, it will read what 
was in the Cash Flow results table before processing the formula leaf you are pro-
cessing. To access the values as they change during the calculation, use CLFE. 

CLFE (FE,Lag)

Used in Cash Flow Formulas only
The CLFE Function returns the value of the financial element of the current leaf in 
memory. This function allows you to use the result of a prior calculation within the 
Formula Leaves ID which does not reside in the Cash Flow Results table. CLFE dif-
fers from FE (same leaf) because it accesses the computed value of the financial ele-
ment, not what was in the results table when processing began.

Syntax:

Lag Relative to Formula Leaves ID buckets. May be positive or 
negative.

0 = Current bucket

-1 = Previous bucket

1 = Next bucket

etc.

Note: To access the results from multiple leaves, you must add 
together multiple FE functions (e.g. FE(995,100,0) + FE(996,100,0) 
+...)

Where: FE Function Name

Lag Relative to Formula Leaves ID buckets. May be positive or 
negative. 

0 = Current bucket

-1 = Previous bucket

 1 = Next bucket

etc.
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GFE (Leaf,FE,Lag)

Used in Gap Formulas Only
The GFE function returns the value of the financial element of the leaf specified as 
stored in the Gap results section of the Cash Flow table.

Syntax:

If the leaf value is the same as the formula leaf you are modeling, it will read what 
was in the Cash Flow Results table before processing the formula leaf you are pro-
cessing. To access the values as they change during the calculation, use GCLFE.

GCLFE (FE,Lag)

Used in Gap Formulas Only
The GCLFE Function returns the value of the financial element of the current leaf in 
memory. This function allows you to use the result of a prior calculation within the 

Where: GFE Function Name

LEAF Chart of Accounts Leaf number desired. If the leaf value is 
greater than nine digits, it must be input with a decimal point 
or the answer will return zero. (Example: Leaf value 
123456789012345 returns a 0 value. Leaf 123456789012345.00 
returns an accurately calculated value.)

Note: To access the results from multiple leaves, you may add 
together multiple GFE functions (E.g. GFE(995,660,0) + 
FE(996,660,0) +...)

FE Financial Element Code number (see Table Above)

Lag Relative to Formula Leaves ID buckets. May be positive or 
negative

0 = Current bucket

-1 = Previous bucket

 1 = Next bucket

etc.
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Formula Leaves ID which may not reside in the Gap results section of the Cash 
Flow table. It differs from GFE (same leaf) because it accesses the computed value of 
the financial element, not what was in the results table when processing began.

Syntax:

K (Coeff,Lag)

Used in Cash Flow Formulas only
The K Function allows the use of a user defined coefficient to be used in the formu-
las. Coefficients may be defined for each individual modeling bucket. This feature 
provides for ease of use and flexibility in building of Formula Leaves ID formulas.

Syntax:

Where: FE Function Name

Lag Relative to Formula Leaves ID buckets. May be positive or 
negative. 

0 = Current bucket

-1 = Previous bucket

 1 = Next bucket

etc.

Where: K Function Name

Coeff User defined Coefficient Code number

Lag Relative to Coefficient defined buckets 

0 = Current bucket

-1 = Previous bucket

 1 = Next bucket

etc.
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GK (Coeff,Lag)

Used in Gap Formulas Only
The GK Function allows the use of a user defined coefficient to be used in the for-
mulas. Coefficients may be defined for each individual gap bucket. This feature pro-
vides for ease of use and flexibility in building of Formula Leaves ID formulas.

Syntax:

Similar to the Cash Flow functions, the GAP functions allow you to access Market 
Value related results data. Market Value Results are sometimes referred to as Static 
results. The Market Value functions SFE and SK can be used in a Cash Flow for-
mula to populate a cash flow financial element. For example, you can specify the 
current position information for a particular leaf and calculate a percentage growth 
over that position.

SFE (Leaf,FE)

Used in all Formula Types
The SFE function Returns the value of the Financial Element of the Leaf specified as 
stored in the Results_Master table. 

Syntax:

Where: GK Function Name

Coeff User defined Coefficient Code number

Lag Relative to Coefficient defined buckets 

0 = Current bucket

-1 = Previous bucket

 1 = Next bucket, etc.

Where: SFE Function Name

LEAF Chart of Account Leaf number desired. If the leaf value is 
greater than nine digits, it must be input with a decimal point 
or the answer will return zero. (Example: Leaf value 
123456789012345 returns a 0 value. Leaf 123456789012345.00 
returns an accurately calculated value.)
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If the leaf value is the same as the formula leaf you are modeling, it will read what 
was in the Cash Flow Results table before processing the formula leaf you are pro-
cessing. To access the values as they change during the calculation, use SCLFE. 

SCLFE (FE)

Used in Market Value Formulas Only
The SCLFE Function returns the value of the financial element of the current leaf in 
memory. This function allows you to use the results of a prior calculation within the 
Formula Leaves ID which may not reside in the results table. It differs from SFE 
(same leaf) because it accesses the computed value of the financial element, not 
what was in the results table when processing began.

Syntax:

SK (Coeff)

Used in all Formula Types
The SK Function allows the use of a user defined coefficient to be used in the formu-
las. This features provides for ease of use and flexibility in building of Formula 
Leaves ID formulas.

Syntax:

Note: To access the results from multiple leaves, you must add 
together multiple SFE functions 
(e.g. SFE(995,2001) + SFE(996,2001) +...)

Where: SCLFE Function Name

FE Financial Element Code number (see table above)

Where: SK Function Name

Coeff User defined Coefficient Code number
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RT (IRC, Lag, Term, Mult)

Used in Cash Flow Formulas only
The RT function returns the value of the Forecasted Interest Rate Code from the 
Forecast Rate ID utilized in the Processing ID.

Syntax:

Example:
The 1 Year point on the Treasury Yield Curve (110) with no lags = RT(110,0,1,3)

Where: RT Function Name

IRC Interest Rate Code used in Historical and Forecast Rate ID.

Lag Relative to Formula Leaves ID buckets. May be positive or 
negative. 

 0 = Current bucket

-1 = Previous bucket

 1 = Next bucket

etc.

Term Point on the yield curve. 

Mult Numeric code for multipliers 

1 = Days

2 = Months

3 = Years

The Term/Mult combination must be exact, even for interest rate 
codes with a single point. If the interest rate code has a 1 Y point, 
you cannot refer to it as the 12 M point. You must use 1 Y. Refer to 
the chapters Historical Rates ID or Forecast Rates ID elsewhere in 
this Guide for exact Term/Multiplier definition.
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DAYS (Lag)

Used in Cash Flow Formulas Only
The DAYS function returns the number of days in the current modeling bucket or a 
range of modeling buckets. For example, if you defined 60 monthly modeling buck-
ets in the Confiq. ID. The DAYS function will return the number of days in its 
respective bucket, i.e. January; 31 days, February; 28 days. Conversely, if you had 
defined each modeling bucket to be a period of just 2 weeks, the DAYS function 
would return 14.

Syntax:

The Lag feature in the DAYS function works differently than the other functions. 
Where lag normally identifies from which bucket relative to the current bucket to 
extract data, in the DAYS function it works as a parameter for accumulation. For 
example, a lag of -1 will take the number of days in the previous bucket and add it 
to the number of days in the current bucket, i.e. Results: 59.

MONTH()

Used in Cash Flow Formulas Only
The MONTH function returns the numeric value of the month of the 1st day of the 
current modeling bucket. Example: Current modeling bucket is January; MONTH() 
will return 1. If the modeling bucket is Jan-1 through Mar-31, MONTH( ) will also 
return 1.

Syntax:

Where: DAYS Function Name

Lag Relative to Formula Leaves ID buckets. May be positive or 
negative.

Bucket 1- January Bucket 2 - February Bucket 3 - March

31 days 28 days 31 days

DAYS (0) Result: 31 DAYS(-1) Result: 59 DAYS(-2) Result: 90

Where: MONTH Function Name

() open/cls parentheses
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Additional Functions
As well as system defined Functions, the Formula Leaves ID also utilizes the stan-
dard mathematical, logical and relational operands and functions.

Mathematical Functions

Relational Operators

Abs:  Returns the positive value of the expression.

Example: Abs(-3.5) = 3.5.

Max: Allows you to return the maximum value of the expression.

Syntax: Max(Expr, Expr).

Min:  Allows you to return the minimum value of the expression.

Syntax: Min(Expr, Expr).

Power:  Allows you to raise one value to the power of a second.

Syntax: Pwr(x, y) -- returns x raised to the power of y.

Round:  Allows you to round a value to a number of decimal places.

Syntax: Round(x, n) -- returns x rounded to n decimal places.

Log:  Allows you calculate the log of the expression

Syntax: Log(x, n) -- returns the n log of x.

IF:  Allows you define if conditionals.

Syntax: If(Boolean Expr, x, 0) -- returns x if true, 0 if false.

Operator Description

= Equal

> Greater than

< Less than

>= Greater than Equal

<= Less than Equal
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Numeric Operators

Logical Operators

Examples

Cash Flow: Leaf B = 2 * Leaf A

In this example, we are defining Cash Flow formula leaf with results that are twice 
the level of leaf value 105. We have inserted a row for every interest related cash 
flow financial element. Each of the formulas uses the FE( ) function to access the 
same financial element from leaf 105 with no lags.

Operator Description

+ Addition

- Subtraction

* Multiplication

/ Division

Operand Description

AND Both conditions must be 
true

OR Either condition can be 
true
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Cash Flow: Simple Account Type

In the example above, we have defined an account type to be a simple account type 
with net rates only. The following table describes the formulas used for each finan-
cial element:

Financial Element Bucket 1 Bucket 2... Explanations

60 Beginning Balance sfe(103,2002) CLFE(100,-1) Bucket 1: Using the SFE( ) formula, we can 
access the current position beginning balance 
(fe = 2002) from the same leaf value (in this 
example our formula leaf value = 103)

Buckets 2 - on: Using the 
CLFE( ) formula we access 
the ending balance from 
the prior bucket.

80 Beginning Net Rate sfe(103,2005) CLFE(120,-1) Bucket 1: Using the SFE( ) formula, we can 
access the current position beginning net rate 
(fe = 2005) from the same leaf value (in this 
example our formula leaf value = 103)

Buckets 2 - on: Using the 
CLFE( ) formula we access 
the ending net rate from 
the prior bucket.

210 Total Runoff 1000 1200 In this example, total runoff is input by the 
user.

230 Total Runoff Net Rate 9.5 9.6 In this example, total runoff rate is input by 
the user.

340 New Add Balance 1000 1200 In this example, new add balances are input 
by the user.
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Gap: Leaf B = 2 * Leaf A

In this example, we are defining a Gap formula leaf whose results are twice the level 
of Leaf value 105. We have inserted a row for every gap financial element. Each for-
mula uses the GFE( ) function to access the same financial element from leaf 105 
with no lags.

360 New Add Net Rate RT(500,0,1,2) RT(500,0,1,2) We are using the RT( ) function to access the 
value from the 1 M point on interest rate code 
= 500 from the current bucket (i.e. no lags)

100 End Balance CLFE(60,0) - 
CLFE(210,0) + 
CLFE(340,0)

CLFE(60,0) - 
CLFE(210,0) + 
CLFE(340,0)

We use the CLFE( ) function to define the 
equation Ending Balance = Beginning Balance 
- Total Runoff + New Add Balances

120 Ending Net Rate (CLFE(60,0) * 
CLFE(80,0) - 
CLFE(210,0) * 
CLFE(230,0) + 
CLFE(340,0) * 
CLFE(360,0)) / 
(CLFE(100,0))

(CLFE(60,0) * 
CLFE(80,0) - 
CLFE(210,0) * 
CLFE(230,0) + 
CLFE(340,0) * 
CLFE(360,0)) / 
(CLFE(100,0))

Similar to the ending balance, we use the 
CLFE( ) function to compute the associated 
ending rate.

140 Average Bal (CLFE(60,0) + 
CLFE(100,0)) / 2

(CLFE(60,0) + 
CLFE(100,0)) / 2

We use the CLFE( ) function to compute the 
average balance as (Beginning Balance + 
Ending Balance) / 2

160 Average Net Rate (CLFE(80,0) + 
CLFE(120,0)) / 2

(CLFE(80,0) + 
CLFE(120,0)) / 2

We use the CLFE( ) function to compute the 
average net rate as (Beginning Net Rate + 
Ending Net Rate) / 2

440 Interest Accrued CLFE(140,0) * 
CLFE(160,0) * 
DAYS(0) / 365

CLFE(140,0) * 
CLFE(160,0) * 
DAYS(0) / 365

We use the CLFE( ) and DAYS( ) functions to 
compute the interest accrual as Average 
Balance * Average Rate * Number of Days in 
Bucket/365

Financial Element Bucket 1 Bucket 2... Explanations
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Examples
Gap: Gap Override

In this example, we are computing (or overriding) the gap runoff and gap runoff 
rates by accessing the beginning balance (financial element = 2002) from each gap 
start date, and multiplying it by a gap coefficient (coefficient code value = 1). In this 
case, we must make sure that the sum of the coefficients for all gap buckets = 1. In 
other words, we are allocating 100% of the gap runoff across all gap buckets.

Gap override may be used for accounts whose gap runoff pattern may not be 
reflected accurately by generating cash flows, and for which you would like to 
input an assumed runoff pattern.

For example, you may have an administered rate portfolio that you model with a 
floating rate. The cash flow generated gap profile will have all runoff in the first 
bucket. Although the rate can change on any day, it does not in reality. Therefore, 
you may want to use Gap override to spread the runoff over a longer period.

Market Value

In this example, we are using the Market Value formula leaf section to input cur-
rent position information and start dates for the formula leaf. By using the SFE( ) 
formula in either the Gap or Cash Flow sections, we can access these current posi-
tion values.

Financial Types Matrix
For a list of financial elements, see the Oracle Financial Services Technical Reference 
Manual.
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Group Filter ID

With the Group Filter ID, you group multiple data filters into a single ID. Using this 
ID, you can combine complex data groups in a single operation.

This chapter presents the following topics:

■ Creating and Defining a Group Filter ID

■ Editing a Group Filter ID

Creating and Defining a Group Filter ID
To create a Group Filter ID, complete the following steps:

1. From the File menu, select New -> Group Filter ID.

2. Select a folder.

3. Type a descriptive name for the ID.

4. Type a description for the ID. This is an optional field.

5. Click Read/Write

6. Click OK.
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Editing a Group Filter ID
7. From the Filter Type list, select Data Filter.

8. From the Filter ID list, select a predefined Filter ID and click Add. The selected 
Filter ID appears in the Group Filter List box.

9. Repeat step 8 until you have selected all the Filter IDs that this Group Filter ID 
requires.

10. From the File menu, select Save.

Editing a Group Filter ID
To edit a Group Filter ID, complete the following steps:

1. From the File menu, select Open -> Group Filter ID.

2. From the Group Filter ID list, select the filter you want to edit and click OK.

3. Edit the Group Filter ID using the Add, Remove, Update, and Clear List but-
tons. (Update replaces a highlighted ID in the Group Filter List with the 
selected ID in the Filter ID list.)

4. From the File menu, select Save.
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Leaf Characteristics ID

The Leaf Characteristics ID is used to define payment, pricing and repricing charac-
teristics for new business. It is also used to specify general calculation attributes for 
both existing accounts and new business.

Creating a New Leaf Characteristics ID 
To create a new Leaf Characteristics ID, complete the following steps:

1. From the File menu, select New -> Leaf Characteristics ID

2. Select a folder.

3. Type a descriptive name for the ID.

4. Type a description for the ID. This is an optional field.

5. Click Read/Write. 

6. Click OK.

The Leaf Characteristics ID screen appears:
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Standard Leaf Characteristics Fields
The Clear button clears all input assumptions for the selected product and currency.

Standard Leaf Characteristics Fields
The six standard leaf characteristics fields listed in the top section of the Apply To 
column are as follows:

Option Adjusted Spread The option adjusted spread is used during stochastic processing 
only. It is an adjustment to the stochastic discount factor used in 
calculating market value and value at risk. Valid values for this 
spread are between -5.000% and 5.000%, but a value less than 
2.00% is recommended for best results. For more information 
about the calculation of discount factors, see the Oracle Financial 
Services Technical Reference Manual. 

Model with Gross Rates This option is used for participated instruments which are not 
fully owned by the institution. For these instruments, both a net 
and a gross rate will be calculated within the cash flow engine 
and both gross and net rate financial elements will be output. 
The gross rate will be used for prepayment and amortization. 
The net rate will be used for income simulation and the 
calculation of retained earnings in the autobalancing process. 

Interest Credited This option allows interest payments to be capitalized as 
principal on simple/nonamortizing instruments.
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Defining a Leaf Characteristics ID
To define a Leaf Characteristics ID, complete the following steps:

1. From the Tree Bar, choose the product leaf you want to define.

2. From the Tree bar, choose the currency code you want to define. 

To define assumptions for all currencies with the selected product, choose the 
default currency (000).

3. Type a value for each mandatory field. See "Relationship Triggers" in this 
chapter for more information.

Percent Taxable Percent Taxable specifies the percent of income or expense that is 
subject to the tax rates defined in the Configuration ID. This is 
used with the Autobalancing option in the Process ID. Percent 
taxable should be set up for each product and reporting currency 
or product and default currency combination.

Currency Gain/Loss 
Basis

Currency Gain/Loss Basis determines how exchange rate 
fluctuations are reflected in financial element results for this 
product and currency combination. The choices are:

■ Temporal

■ Historical Basis

■ Current Rate

See the Oracle Financial Services Technical Reference Manual for 
more information on the cash flow calculations associated with 
currency gain/loss recognition techniques.

Pay-Equivalent 
Compounding 
Convention

In most cases, interest rates are not adjusted for the differences 
in pay-basis between the quote basis of the pricing index and the 
payment frequency of the account to which the index is 
assigned. Some instruments, notably Canadian mortgages, 
follow a convention that the interest rates are adjusted. In this 
case, the Pay-Equivalent Compounding Convention should be 
set to Semi-Annual Quoting Convention. For other accounts, the 
Convention should be set to Do Not Adjust.
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Defining a Leaf Characteristics ID
Mandatory input fields are displayed in white and the non-editable fields are 
gray. If necessary, use the scroll bar located at the far right of the Leaf 
Characteristics section to view all available fields.

4. From the File menu, select Save.

Relationship Triggers
In the Leaf Characteristics ID, some instrument characteristics are interrelated. 
When input of a particular characteristic is unnecessary as a result of characteristics 
in other fields, the unnecessary field is disabled. The following table describes the 
relationships.

Hint: Using the default currency to set up assumptions can save 
data input time. At run time, the calculation engine first uses 
assumptions explicitly defined for the product and currency 
combination. If assumptions are not defined for that currency, the 
engine uses the assumptions defined for the product and the 
default currency. If the assumptions are the same across some or all 
currencies for a particular product, you can input these 
assumptions for the default currency.

Leaf 
Charac.

Trans. 
Strat. Field Value Behavior

YES YES Amortization 
Type Code

Conv. Fixed,

Conv. Adjust.,

Adjst/Ng Amrt

Always interest in arrears, therefore 
disables Interest Type.
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Defining a Leaf Characteristics ID
YES YES Amortization 
Type Code

Conv. Fixed, 
Rule-of-78’s

No repricing occurs, therefore 
disables repricing characteristics, 
e.g.,

Adjustable Type Code

Repricing Frequency and Multiplier

Tease Period Freq. and Multiplier

Tease Discount

Rate Set Lag Freq. and Multiplier

Minimum Rate Change

Rate Cap Life

Rate Floor Life

Rate Increase Period and Life

Rate Decrease Period and Life

Rate Change Round Type & Percent

Negative Amortization fields (only 
enabled for Adjst/Ng Amrt--see 
below)

YES YES Amortization 
Type Code

Adjst/Ng Amrt Enables Negative Amortization 
fields:

Payment Change Freq. & Multiplier

Payment Increase Period & Life

Payment Decrease Period & Life

Neg. Am. Eq. Frq., Mult., & Limit

YES YES Amortization 
Type Code

Any 
User-Defined 
Payment 
Pattern

Payment Frequency is defined in 
Pattern, therefore disables Payment 
Frequency and Multiplier in this ID

YES YES Adjustable Type 
Code

Fixed, Floating, 
or any 
User-Defined 
Repricing 
Pattern

Repricing Frequency is not 
applicable, or it is defined 
elsewhere, therefore disables 
Repricing Frequency and Multiplier

Leaf 
Charac.

Trans. 
Strat. Field Value Behavior
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Defining a Leaf Characteristics ID
YES YES Adjustable Type 
Code

Any 
User-Defined 
Repricing 
Pattern

Several of the repricing 
characteristics are defined 
elsewhere, therefore they are 
disabled in this ID (e.g., Interest 
Rate Code, Transfer Rate Interest 
Rate Code, etc.). Only periodic 
increase and decrease, rate change 
minimum, and rounding are 
enabled

NO YES Adjustable Type 
Code

Any 
User-Defined 
Repricing 
Pattern

Disables Rate Pricing Option

YES YES Repricing 
Frequency

0 No repricing occurs, therefore 
disables repricing characteristics 
(listed above under "Amortization 
Type Code ... Conv. Fixed")

YES NO Model with 
Gross Rates

Off Net Margin Flag options are only 
necessary when modeling with 
different gross and net rates, 
therefore disables Net Margin Flag

YES YES Rate Change 
Rounding Type

"No Rounding" 
or "Truncate"

Rounding does not apply, therefore 
disables Rate Change Rounding 
Percent

NO YES Rate Pricing 
Option (when 
active)

Assign during 
processing

Disables direct input Rate fields 
(net, gross, and transfer rate)

YES YES Currency Allows display of Interest Rate 
Codes and Transfer Rate Interest 
Rate Codes for which the selected 
currency is the reference currency. 
In Leaf Characteristics, Default 
Currency (’000’) allows all Interest 
Rate Codes, regardless of currency

Leaf 
Charac.

Trans. 
Strat. Field Value Behavior
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New Business Fields
Following is a listing of new business fields used in the Leaf Characteristics IDs. 

New Business Fields Description

ACCRUAL BASIS The basis on which the interest accrual on an account is 
calculated. The choices are as follows: 

■ 30/360

■ Actual/360

■ Actual/Actual

■ 30/365

■ 30/Actual

■ Actual/365

ADJUSTABLE TYPE Determines the repricing characteristics of the new business 
record. The choices consist of all standard OFSA codes and all 
additional user-defined reprice patterns created through the 
Reprice Pattern interface. The standard OFSA codes are as 
follows:

■ Fixed

■ Floating

■ Adjustable

AMORTIZATION TYPE Method of amortizing principal and interest. The choices consist 
of all standard OFSA codes and all additional user-defined 
codes created through the Payment Pattern interface. The 
standard OFSA codes are the following:

■ Conventional Fixed

■ Conventional Adjustable

■ Adjustable Negative Amortization

■ Non-Amortizing

■ Rule of 78’s

■ Level Principal
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New Business Fields
COMPOUNDING 
BASIS

Determines the number of compounding periods per payment 
period. The choices are the following:

■ Daily

■ Monthly

■ Quarterly

■ Semi-Annual

■ Yearly

■ Continuous

■ Simple

■ At Maturity

INTEREST TYPE Determines whether interest is calculated in arrears or advance. 
There are two interest types:

■ Interest in Arrears

■ Interest in Advance

For conventional amortization products, interest in arrears is the 
only valid choice.

INTEREST RATE CODE Defines the pricing index to which interest rate is contractually 
tied. The interest rate codes that appear as a selection option 
depend on the choice of currency from the Tree Bar. The interest 
rate code list is restricted to codes which have the selected 
currency as the reference currency. If the default currency is 
chosen, all interest rate codes are available as a selection.

MINIMUM RATE 
CHANGE

The minimum required change in rate on a repricing date.

NEGATIVE 
AMORTIZATION 
EQUALIZATION 
FREQUENCY

Frequency at which current payment necessary to fully amortize 
the instrument is re-computed.

NEGATIVE 
AMORTIZATION 
EQUALIZATION 
MULTIPLIER

Units (days, months, or years) of negative amortization 
equalization multiplier.

NEGATIVE 
AMORTIZATION 
EQUALIZATION 
LIMIT

Maximum negative amortization allowed, as a percent of 
original balance. E.g., if principal balance should never exceed 
125% of original balance, this column would equal 125.0.

New Business Fields Description
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New Business Fields
NET MARGIN FLAG The setting of the net margin flag affects the calculation of net 
rate. The two settings are: 

Floating Net Rate - the net rate reprices in conjunction with the 
gross rate, at a value net of fees.

Fixed Net Rate - the net rate equals a fixed fee equal to the net 
margin.

ORGINAL DEFERRED 
AMORTIZATION 
PERCENT

The initial deferred balance expressed as a percent of original 
par balance.

PAYMENT CHANGE 
FREQUENCY

The frequency at which the payment amount is recalculated for 
adjustable negative amortization instruments.

PAYMENT CHANGE 
MULTIPLIER

Units (days, months or years) of payment change frequency.

PAYMENT DECREASE - 
PERIOD

Maximum payment decrease allowed during a payment change 
cycle of a negative amortization instrument. 

PAYMENT DECREASE - 
LIFE

Maximum payment decrease allowed during life of an 
adjustable rate instrument.

PAYMENT 
FREQUENCY

Frequency of payment (P&I, Interest or Principal). For bullet 
instruments, use zero.

PAYMENT 
MULTIPLIER

Units (days, months or years) of payment frequency.

PAYMENT INCREASE - 
PERIOD

Maximum payment increase allowed during a payment change 
cycle on a negative amortization instrument. 

PAYMENT INCREASE - 
LIFE

Maximum payment increase allowed during the life of a 
negative amortization instrument. 

RATE CAP LIFE Maximum rate allowed during life of the instrument.

RATE CHANGE 
ROUNDING PERCENT

Percent to which the rate change on an adjustable instrument in 
rounded.

RATE CHANGE 
ROUNDING TYPE

Method used for rounding of interest rate codes. The choices are 
as follows: no rounding, truncate, round up, round down, round 
nearest.

RATE DECREASE 
PERIOD

Maximum amount rate can decrease during the repricing period 
of an adjustable rate instrument.

New Business Fields Description
Leaf Characteristics ID 15-9



New Business Fields
RATE DECREASE LIFE Maximum amount rate can decrease during the life of an 
adjustable rate instrument, used to calculate the rate floor based 
on the forecasted rate scenario. If both rate decrease life and rate 
floor are defined, the process uses the more restrictive rate. 

RATE FLOOR LIFE Minimum rate for life of the instrument.

RATE INCREASE 
PERIOD

Maximum interest rate increase allowed during the cycle on an 
adjustable rate instrument.

RATE INCREASE LIFE Maximum interest rate increase allowed during the life of an 
adjustable rate instrument, used to calculate rate cap based on 
forecasted rates scenario. If both rate increase life and rate cap 
are defined, the process uses the more restrictive rate.

RATE SET LAG 
FREQUENCY

Period by which the payment recalculation lags the date of the 
interest rate used for calculation.

RATE SET LAG 
MULTIPLIER

 Units (days, months, or years) of rate set lag frequency.

REPRICING 
FREQUENCY

Contractual frequency of rate adjustment.

REPRICING 
MULTIPLIER 

Units (days, months, or years) of repricing frequency.

TEASE DISCOUNT The tease discount is used in conjunction with the original rate 
to calculate the tease rate. The tease rate is the original rate less 
the tease discount.

TEASE PERIOD 
FREQUENCY

The tease period frequency is used to determine the length of 
tease period. 

TEASE PERIOD 
MULTIPLIER

Units (days, months, or years) of tease period frequency.

TRANSFER RATE 
INTEREST RATE CODE 

The interest rate code will be used to calculate the transfer rate 
for new business. The list of interest rate codes is restricted to 
interest rate codes with the reference currency equivalent to the 
currency selected from the Tree Bar. If the default currency is 
selected from the Tree Bar, interest rate codes for all active 
currencies are shown.

New Business Fields Description
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Maturity Strategy ID

A Maturity Strategy ID defines the term distribution of new business added during 
each forecast period. Maturity strategies are set at the product and currency levels.

For new volumes generated during the simulation, you will define the maturity and 
amortization terms applied to the balances originated in each period, as well as 
specify a maturity distribution for the volumes originated.

For example, mortgage originations may be divided into 25% 5 Year Term/30 Year 
Amortization, 25% 7 Year Term/30 Year Amortization, and 50% 30 Year Term/30 
Year Amortization. You define the set of maturity assumptions to apply to all new 
accounts and select that Maturity Strategy ID when running a simulation.

Creating a Maturity Strategy ID
To create a Maturity Strategy ID, complete the following steps:

1. From the File menu, select New -> Maturity Strategy ID.

2. Select a folder.

3. Type a descriptive name for the ID.

4. Type a description for the ID. This is an optional field.

5. Click Read/Write.

6. Click OK.

The Maturity Strategy ID window and tree bar appear.
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The Maturity Strategy ID Window and Tree Bar
The Maturity Strategy ID Window and Tree Bar
The Maturity Strategy ID uses the modeling period defined in the active 
Configuration ID. You should verify that your modeling horizon and assumptions 
are consistent with the active Configuration ID.

From the product section of the tree bar, select the product for which you would like 
to define a Maturity Strategy ID. From the currency section, select a currency or use 
the default.

Each date range will have its own set of maturity strategies that you define in the 
Terms box. 

Hint: Using the default currency to set up assumptions can save 
data input time. At run time, the calculation engine first uses 
assumptions explicitly defined for the product and currency 
combination. If assumptions are not defined for that currency, the 
engine uses the assumptions defined for the product and the 
default currency. If the assumptions are the same across some or all 
currencies for a particular product, you can input these 
assumptions for the default currency.
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The Maturity Strategy ID Window and Tree Bar
Date Buckets
Click the Date Bucket number spinner to select the number of maturity strategy 
date ranges that are required during the forecast period. 

The # column is used to calculate the starting and ending dates. The # column 
defines which modeling bucket is used to calculate these dates. The modeling 
buckets are defined in the Configuration ID. 

In the following example, the "1" in the first row of the # column indicates that the 
first modeling bucket in the Configuration ID is used to calculate the Start Date. In 
the # column of the second row, "28" represents the twenty-eighth modeling bucket 
in the Configuration ID, from which the End Date in row 1and the Start Date in row 
2 are calculated.

Terms
The Terms columns are used as follows:

For each Date Bucket defined, the maturity terms must be specified. For example, 
new business may be added in two terms: 5 year and 10 year maturities. 

Note: The Start Date value in the first row is always set equal to 
the first modeling date, the as-of date plus 1 day, and the End Date 
value in the last row always equals the last day of the modeling 
horizon as defined in the Configuration ID.

Maturity Maturity (= term)

Multiplier: Maturity multiplier (= days, months, years)

Amortization: The amortization term will default to the maturity 
term. The amortization term should always be 
greater than or equal to the maturity term.

Multiplier: Amortization multiplier (= days, months, years)

Percent: The percentage of new business at the specified term 
and maturity for the associated date bucket. 
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The Maturity Strategy ID Window and Tree Bar
Entering Terms: An Example
1. Click on the Date Buckets row to be defined.

2. Set the Terms number spinner box to 2.

3. Enter the maturity amounts of 60 and 120 and the associated multipliers of 
months in the Maturity and Multiplier columns. (5 Y and 10 Y can also be used).

4. Define the amortizations and their associated multipliers in the Amortization 
and Multiplier columns. (The amortization term and multiplier default to the 
same values as the maturity term and multiplier.)

5. In the Percent column, type the percent for each maturity. For example, 60 
months may be 30% of new business, while 120 month maturities represent the 
remaining 70%. The allocation percents must total 100%.

6. From the File menu, select Save.

Reviewing Maturity Strategies
To review maturity strategies, click on a date bucket to display the defined maturity 
strategies. The maturity strategy is displayed for one bucket at a time.
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Prepayment ID

This chapter explains the function and use of Prepayment IDs within cash flow pro-
cessing. The following topics are included:

■ Prepayment ID assumptions

■ Calculation methods

■ Creating, defining, and editing a Prepayment ID

Prepayments are paid by either accelerating principal payments or refinancing. 
Using Prepayment IDs, you specify assumptions about prepayment rates for spe-
cific products. Once defined, the assumptions are stored at the individual product 
leaf level. Risk Manager uses the assumptions detailed in the ID to calculate cash 
flows.

Prepayment ID Assumptions
When creating a Prepayment ID, you make assumptions about calculation meth-
ods, cash flow, market rates, terms, prepayment rates, and seasonality. The assump-
tions you enter depend on the calculation method you select—constant, 
prepayment table, or arctangent calculation. For example, when you select the con-
stant calculation method, the market rate options are unavailable because a flat pre-
payment rate is used. With the prepayment table method, however, the market rate 
and spread are required because of market fluctuation dependencies.

The Prepayment ID window has six areas for entering assumptions.

■ Calculation Method

■ Cash Flow Treatment

■ Market Rate Definition
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Prepayment ID Assumptions
■ Associated Term

■ Prepayment Rate Definition

■ Seasonality

Calculation Method
There are three methods for calculating prepayments:

■ Constant calculation

■ Prepayment table calculation

■ Arctangent calculation

One ID can contain more than one method of calculation for different products. A 
single product, however, is assigned using only one method within an ID; one leaf, 
one calculation method. Prepayment assumptions within an individual leaf can 
vary based on origination date ranges.

The default option None on the Calculation Method list is used to indicate that a 
product leaf is not affected by prepayment assumptions. None notifies the system to 
bypass prepayment processing for the individual leaf. The three methods for calcu-
lating prepayments are discussed in the following sections. 
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Prepayment ID Assumptions
Constant Calculation Method
The constant method calculates a flat percentage of the current balance. The per-
centage you enter applies to all instruments within the origination date range.

Prepayment Table Calculation Method
With this method, you use a predefined Prepayment Table ID to model the impact 
of multiple characteristics on prepayment expectations. Prepayment tables can be 
based on age, term, or rate characteristics. You can assign a prepayment table to a 
number of different products to use in cash flow transfer pricing and cash flow fore-
casting. You can also assign a different prepayment table to each origination date 
range in the Prepayment ID. If you have not already created a Prepayment Table ID, 
see Chapter 18, "Prepayment Table ID" for instructions.

Arctangent Calculation Method
The arctangent calculation method uses the arctangent function to describe the rela-
tionship between prepayment rates and spreads (the coupon rate less the market 
rate).

User-defined coefficients adjust this function to generate differently shaped curves. 
Specifically, 

CPRt = k1 - (k2 * ATAN(k3 * (-Ct/Mt + k4))), where CPRt = annual prepayment rate in period t

Ct = coupon in period t

Mt = market rate in period t

k1, k2, k3, k4 = user-defined coefficients

Using the coefficients k1 = 0.3, k2 = 0.2, k3 = 10.0, and k4 = 1.2, the skewness and 
steepness of the arctangent prepayment curve are defined.

CPR(t)
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Prepayment ID Assumptions
Each coefficient affects the curve in a different manner. K1 defines the midpoint of 
the prepayment curve, affecting the absolute level of prepayments. Adjusting the 
value creates a parallel shift of the curve up or down.

K2 impacts the slope of the curve, defining the change in prepayments given a 
change in market rates. A larger value implies greater overall customer reaction to 
changes in market rates.
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Prepayment ID Assumptions
K3 impacts the amount of torque in the prepayment curve. A larger K3 increases the 
acceleration, implying that customers react more sharply when spreads reach the 
hurdle rate.

K4 defines the hurdle spread, the spread at which prepayments start to accelerate. 
When the spread ratio = k4, prepayments = k1. 
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Prepayment ID Assumptions
Cash Flow
The cash flow options are Refinance or Curtailment.

■ Refinance: keeps payment amounts after prepayment consistent with a portfo-
lio-based assumption. This reduces the scheduled payment amount on each 
loan and maintains the same maturity term.

■ Curtailment: changes the periodic payment amounts due. The prepayments are 
treated as accelerated payments, with a payoff earlier than the originally sched-
uled terms.

Market Rate Definition
The market rate represents the forecasted interest rate. You will select an interest 
rate code from the Index list and type a spread, expressed as a percentage, in the 
Spread field. Spread is the difference between the customer rate and the market 
rate. The Market Rate Definition section is not available with the constant calcula-
tion method.

Associated Term
The associated term determines which point on the yield curve will be used as the 
equivalent market rate. Choose one of the following: 

■ Remaining Term: the number of months until the instrument matures. 

■ Reprice Frequency: the frequency with which the instrument reprices. This will 
default to original term on a fixed-rate instrument.

■ Original Term: the number of months originally scheduled for the life of the 
instrument.

The Associated Term section is active when you use either the prepayment table or 
arctangent calculation method.

Prepayment Rate Definition
When you select the constant calculation method, the prepayment rate is defined as 
a constant annual rate and expressed as a percentage, by origination date. You will 
determine the prepayment percentage that you want applied to instruments in the 
origination date range.
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When you select the prepayment table calculation method, you will supply a coeffi-
cient and select one of the predefined prepayment tables. The coefficient is the num-
ber by which the prepayment rate (specified in the prepayment table) will be 
multiplied. The coefficient applies to all instruments within the specified origina-
tion date range.

Example: Assume the following Prepayment Table ID.

For an instrument with a term of 36 months and a coefficient of 0.8500, the system 
calculates 85% of the original term prepayment rate of 15%. Thus the instrument is 
assigned a prepayment rate of 12.75%.

When you select the arctangent calculation method, you supply coefficients for the 
arctangent formula (see "Arctangent Calculation Method" in this chapter) to define 
the shape of your curve.

Original Term Prepayment Rate

12 5

24 10

36 15

60 20
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.

For all calculation methods, the first cell in the Start Origination Date column and 
all cells in the End Origination Date column are protected. This ensures that all the 
possible origination dates are included in cash flow calculations. Dates in the End 
Origination Date column are supplied by the system when you tab to or click an 
End Origination Date cell.

Seasonality
Seasonality adjustments are made when, based on financial histories and experi-
ences, you expect the amount of prepayments made on given instruments to 
increase in certain months and decrease in other months. Seasonality factors are 
multiplied by the annualized prepayment rate. A deannualized rate is calculated 
during processing.

For each month, the default seasonality factor is 1.0000. When the seasonality func-
tion is active, you can change any of the factors. When the function is disabled, the 
factors are grayed out and cannot be adjusted. 

To enter seasonality factors, complete the following steps:

1. Check the Seasonality box.

2. For each month you want to change, delete the default factor and type the new 
factor. The number cannot exceed 99.9999.

Creating a New Prepayment ID
To create a new Prepayment ID, complete the following steps:

1. From the File menu, select New -> Prepayment ID.

2. Select the Folder and Leaf Types from the lists.

Note: If you uncheck Seasonality after entering new factors, the 
new factors will be deleted.
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Defining a Prepayment ID
3. Type a descriptive name for the ID.

4. Type a description for the ID. This is an optional field.

5. Click Read/Write.

6. Click OK.

All prepayment rates entered into a Prepayment ID are constant annualized rates. 
Prepayment rates are deannualized when applied to individual transactions during 
processing, with the exception of the 100% Rule. When you input a prepayment rate 
of 100%, prepayment in full is triggered.

Defining a Prepayment ID
To define Prepayment ID assumptions, complete the following steps:

1. From the Tree Bar, select the product leaf you want to define prepayment 
assumptions on.

2. From the Calculation Method list, select Constant, Prepayment Table, or 
Arctangent. (See "Calculation Method" in this chapter.)

3. In the Cash Flow Treatment section, select Refinance or Curtailment. (See "Cash 
Flow" in this chapter.)

4. If the Market Rate Definition section is available, select values for Index and 
Spread. (See "Market Rate Definition" in this chapter.)

5. If the Associated Term section is available, select from Remaining Term, Reprice 
Frequency, or Original Term. (See "Associated Term" in this chapter.)

6. In the Prepayment Rate Definition section (see "Prepayment Rate Definition" in 
this chapter), do the following:

■ In the first cell (upper left corner), click the up/down arrows or type a 
number to specify how many prepayment rates you want to define.

■ Position the cursor in row 2 of the Start Origination Date column. Row 1 of 
the Start Origination Date column does not change.

■ Type the beginning date.

■ Click the End Origination Date column of the previous row to have the end 
date supplied for you. The system inserts a date one day before the Start 
Origination Date in the next row.

If you selected Constant from the Calculation Method list:
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■ In the Percent column, type the prepayment rate that you want applied to 
instruments in the origination date range.

■ For each row, continue supplying start and end origination dates and 
prepayment rate percentages.

If you selected Prepayment Table from the Calculation Method list:

■ In the Coefficient column, type the number by which the prepayment rate 
will be multiplied. The coefficient applies to all instruments within the 
specified origination date range.

■ From the list in the Prepayment Table column, select a predefined 
prepayment table.

■ For each row, continue supplying start and end origination dates and a 
coefficient, and select a prepayment table from the list.

If you selected Arctangent from the Calculation Method list:

■ In the K1 through K4 columns, type the coefficients for the arctangent 
formula.

■ For each row, continue supplying start and end origination dates and 
values for K1 through K4.

7. If the Seasonality section is available, change the factor for any month. (See 
"Seasonality" in this chapter.)

8. Save the Prepayment ID.

Editing a Prepayment ID
To edit a Prepayment ID, complete the following steps:

1. From the File menu, select Open -> Prepayment ID.

2. Select the ID you want to edit and click OK.

3. With the ID open, make changes as previously described.

4. From the File menu, select Save As to rename the ID.

Note: For any of the calculation methods, if you need to change 
an end date, click any cell in the End Origination Date column to 
refresh the dates.
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5. Type the new name in the Prepayment ID box and click OK.

Note: Renaming the edited Prepayment ID will preserve the 
original Prepayment ID for you to use as a basis for other edited 
versions.
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Prepayment Table ID

Prepayment Table IDs are useful for defining complex payment structures in a Pre-
payment ID. You can create prepayment tables based on term, age, or interest rate 
characteristics, and use the same prepayment table across multiple Prepayment IDs 
and products, eliminating redundant data entry.

Prepayment Table Structure
You define prepayment tables by specifying:

■ Dimension type: Uses instrument characteristics or interest rate measures that 
you specify to calculate prepayment runoff

■ Lookup method: Determines how a prepayment rate is calculated

■ Dimension values: Defines points at which prepayment rates are calculated

Dimension Types
Dimensions define how term and repricing parameters and interest rates influence 
prepayment behavior. One table can contain up to three dimensions. Nine dimen-
sions are available. The term and repricing dimensions are:

■ Original term: The contractual term of the instrument

■ Reprice frequency: The number of months between instrument repricing

■ Remaining term: The number of months until the instrument matures

■ Expired term (also known as age): The number of months since the instrument 
was originated

■ Term to reprice: The number of months until the next repricing of the instru-
ment
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Prepayment Table Structure
The interest rate dimensions are:

■ Coupon rate: The current gross rate on the instrument

■ Market rate: The forecasted rate representing alternate funding

■ Rate difference: The spread between the current gross rate and the market rate

■ Rate ratio: The ratio of the current gross rate to the market rate

Lookup Methods
The lookup method determines how prepayment rates will be calculated. The 
lookup method options are:

■ Interpolation: Calculates a value between two known prepayment rates in the 
table

■ Range: Applies a prepayment rate for instruments in a range of ages 

Example: The table shows that an instrument with an age of 30 months is halfway 
between 10% and 15%. Using interpolation, the calculated prepayment rate is 
12.5%. Using the range method, the prepayment rate is 10%, the rate that applies to 
the range from 24 to 35.9999 months.

The graphs show the difference between interpolation and range lookup.

Age Prepayment Rate

12 5

24 10

36 15

60 20

20

5

Interpolated

20

5
AgeAge

0           12                60 0           12                60
Range

Prepayment
Rate
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Defining the Prepayment Table
Dimension Values
Dimension values define points at which you want to calculate prepayment rates. 
For example, for the original term, you may enter values of 12 months, 24 months, 
36 months, and 48 months for a particular instrument or product.

Defining the Prepayment Table
You will set up a Prepayment Table ID by first creating a new table, a shell that you 
will fill in. Next you will add dimensions—terms and rates—to define the table. 
Finally you will add prepayment rates to the table.

Creating a New Prepayment Table ID
To create a new Prepayment Table ID, complete the following steps:

1. From the File menu, select New -> Prepayment Table ID.

2. Select a folder.

3. Type a descriptive name for the ID.

4. Type a description for the ID. This is an optional field.

5. Click Read/Write.

6. Click OK.

You are now ready to add dimensions to the Prepayment Table ID.

Adding Dimensions to the Prepayment Table ID
With dimensions, you specify instrument and environment characteristics. You 
must add all dimensions before entering prepayment rates. Adding dimensions 
after entering prepayment rates will erase current prepayment rates.

Adding the First Dimension
To add the first dimension, complete the following steps:

1. Click Add Dimension. The first dimension is defined as the row dimension.
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.

2. In the Dimension Definition dialog box, select a Dimension Type from the list.

3. Click a Lookup Method.

4. Click the box across from the OK button and type a value for a term or rate, 
depending on whether you selected a term or a rate dimension.
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5. Click Add to add another term or rate; then click the box and type the value. 
Continue adding values until the dimension structure is complete.

6. Click OK. The first dimension values appear as rows in the table.

7. From the File menu, select Save.

Adding the Second Dimension
To add an optional second dimension, complete the following steps:

1. Click Add Dimension across from Column. The second dimension is defined as 
the column dimension.

2. Click Yes to ignore the warning. It does not apply if you have not yet entered 
prepayment rates.

3. Repeat steps 2 through 7 from "Adding the First Dimension" in this chapter. The 
second dimension values appear as columns in the table.
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Adding the Third Dimension
To add an optional third dimension, complete the following steps:

1. Select Add Dimension across from Page.

2. Click Yes to ignore the warning. It does not apply if you have not yet entered 
prepayment rates.

3. Repeat steps 2 through 7 from "Adding the First Dimension" in this chapter. The 
third dimension values appear as individual pages.
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You are now ready to add prepayment rates to the table.

Adding Prepayment Rates to the Table
To change the default prepayment rates of 1.0000, complete the following steps:

1. Click each prepayment rate you want to change and type the value.

You cannot change the dimension values (the first row and the first column) 
here. See "Editing Dimensions" in this chapter for more information.

2. From the File menu, select Save.

Editing Dimensions
You can edit a dimension either before or after entering prepayment rates. The pre-
payment rates are not erased when you edit dimensions.

To edit a dimension type, lookup method, or dimension value, complete the follow-
ing steps:

1. Click Edit Dimension for a Row, Column, or Page.

2. In the Dimension Definition dialog box, make the desired changes. (See "Add-
ing Dimensions to the Prepayment Table ID" for more information.)
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3. Click OK.

4. From the File menu, select Save.

Deleting Dimension Values
You can delete dimension values at any time. Associated prepayment rates are also 
deleted.

To delete dimension values, complete the following steps:

1. Click Edit Dimension for a Row, Column, or Page.

2. In the Dimension Definition dialog box, click the cell to be deleted and click 
Delete.

3. Click OK.

4. From the File menu, select Save.

Deleting Dimensions
You can delete an entire dimension by setting Dimension Type (in the Dimension 
Definition dialog box) to None. You must delete Page Dimension before Column 
Dimension, and Column Dimension before Row Dimension.
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Pricing Margin ID

A Pricing Margin ID is a set of pricing margin assumptions for all products. Pricing 
margins are defined period by period for each product and, potentially, each 
currency. The pricing margin applies to newly originated volumes defined in the 
Forecast Balance ID.

When you require more complex definitions of pricing margins to model an 
account, user-defined repricing patterns can be used. See Chapter 27, "User-Defined 
Repricing Pattern" for more information.

Creating a Pricing Margin ID
To create a new Pricing Margin ID, complete the following steps:

1. From the File menu, select New -> Pricing Margin ID.

2. Select the folder.

3. Enter a descriptive name for the ID.

4. Enter a description for the ID. This is an optional field.

5. Click Read/Write.

6. Click OK.

The Pricing Margin ID and Tree Bar appear.
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7. Type dates and values as described in "The Pricing Margin ID Window and Tree 
Bar" in this chapter.

8. From the File menu, select Save.

The Pricing Margin ID Window and Tree Bar
In a modeling scenario, you may want to price new business for an account at a 
margin above or below a market interest rate code. For example, you can model a 
premium paid on CDs in relation to a market yield curve by adding a pricing 
margin to the interest rate code defined in the Leaf Characteristics ID. For example, 
if you want a rate that is 25 basis points above the market yield curve, you will type 
0.25 as the pricing margin during the modeling period.

The Pricing Margin ID uses the modeling period defined in the active Configuration 
ID. You should verify that your modeling horizon and assumptions are consistent 
with the active Configuration ID.
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From the product section of the tree bar, select the product for which you would like 
to define a Pricing Margin ID. From the currency section, select a currency or use 
the default.

Start Date and End Date
When the Pricing Margin ID opens, the Start Date and End Date columns are 
automatically populated. The date ranges represent the Modeling Date buckets 
as defined in the Configuration ID. See Chapter 6, "Configuration ID" for more 
information. Any new business originated within these dates is modeled using 
the margins defined in the Pricing Margin ID. New business added for each 
date bucket will have the same net, gross, and transfer margin for its life. The 
margins on a particular instrument will not change as the instrument ages.

Gross Margin
The Gross Margin you define is added to the Interest Rate Code specified in the 
Leaf Characteristics ID to define the gross rate on new business.

Net Margin
The Net Rate is affected by the setting Net Margin Flag in the Leaf 
Characteristics ID. If Net Margin Flag is set to Floating Net Rate, then Net Rate 
is equal to the Interest Rate Code plus the Net Margin specified here. If the Net 
Margin Flag is set to Fixed Net Rate, then Net Rate is equal to Net Margin.

Transfer Rate Margin
If you are modeling with transfer rates, the margin specified will be added to 
the transfer rate interest rate code specified in the Leaf Characteristics ID to 
determine the transfer rate for new business. See "Input Data for a 
Scenario-Based Process ID" in Chapter 20, "Process ID" for more information.

Hint: Using the default currency to set up assumptions can save 
data input time. At run time, the calculation engine first uses 
assumptions explicitly defined for the product and currency 
combination. If assumptions are not defined for that currency, the 
engine uses the assumptions defined for the product and the 
default currency. If the assumptions are the same across some or all 
currencies for a particular product, you can input these 
assumptions for the default currency.
Pricing Margin ID 19-3



The Pricing Margin ID Window and Tree Bar
19-4 Oracle Risk Manager Reference Guide



P

20

Process ID

When all of the assumptions for a forecast are defined, the Process ID performs 
calculation processes and generates a results set. A Process ID requires the input in 
four different pages, including:

■ Calculation

■ Input/Assumption

■ Process Mode

■ Audit

Defining options within each of these pages creates a unique Process ID for 
individual forecasting objectives.

This chapter discusses the creation of a Process ID, the differences between 
Scenario-based and Stochastic Process ID types and the input required to set up 
such a Process ID. It is organized by:

■ Creating a Process ID

■ Input Data for a Scenario-Based Process ID

■ Input Data for a Stochastic Process ID

■ Running a Process ID

■ For a server run of a Risk Manager Process, the Processing Status is displayed in 
the Server Status Update window. The status of the process inserts a row with 
the Process ID name in the Job Description column. A number of status is 
updated during and after the execution of the process. For more information see 
"Server Status" in Chapter 4, "Overview of IDs".
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Creating a Process ID
Creating a Process ID
To define a Process ID, complete the following steps: 

1. From the File menu, choose New/Process ID. The New Risk Manager Process 
ID screen appears.

2. Use the drop-down lists to choose Folder and Leaf Type. Pressing Tab moves 
the cursor from one field to the next.

3. Enter a descriptive name for the ID in the Risk Manager Process ID field.

4. Check the Processing Mode option. Check Scenario-based or Stochastic to set 
up a Scenario-based Process ID or Stochastic Process ID. The selection of 
Processing Mode drives the creation of the Process ID.

5. Select a reporting currency.

6. Enter a description for the ID. This is an optional field.

7. Check the Read/Write option.
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Input Data for a Scenario-Based Process ID
The Process ID screen appears with the ID name, processing mode, and reporting 
currency displayed in the title bar.

Input Data for a Scenario-Based Process ID
Scenario-based processing generates output based on a set of user-defined forecast 
rate scenarios.

Calculation Page
Click the Calculation tab for options:
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Calculation Elements
Define specific financial calculations.

Market Value  Market values can be calculated for the as-of-date and other dates in 
the future. These forward dates are defined in the Configuration ID, and are shared 
with gap calculation. For more information on setting up dynamic start dates, see 
Chapter 6, "Configuration ID".

You must define a Discount Rates ID prior to generating Market Value results.

Discount Rates ID  This ID defines the method for discounting projected cash flows in 
Risk Manager in a scenario-based process. For each leaf value, you can choose one 
of four different methods. These methods include:

■ Spot Input

■ Spot Interest Rate Code

■ Forecast (Original Term)
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■ Forecast (Remaining Term) 

For more information on discount rates, see Chapter 9, "Discount Rates ID" 

Gap  Select Gap to generate static and dynamic gap results. To use this option, you 
must first define dynamic start dates in the Configuration ID.

Gap profiles contain bucket-based runoff and reprice information. The information 
represents current position for static gap. For dynamic gap, it represents the balance 
sheet as of the dynamic gap date. A special set of financial elements is produced for 
gap.

Transfer Pricing  During processing, the model tracks transfer rates and transfer 
pricing charges/credits on individual transactions. This information is aggregated, 
per leaf, as financial elements and written to the results tables. Examples of transfer 
pricing financial elements include: 

■ Beginning transfer rate

■ Ending transfer rate

■ Average transfer rate

■ Transfer pricing charge/credit 

Interest Rate Assumption
Defines the interest rate environments.

Forecast Rates ID  Forecasting assumptions on how interest rates rise or fall, based on 
history and forecasting calculations. Only Forecast Rates IDs with the same 
reporting currency as the Process ID appear. See Chapter 11, "Forecast Rates ID" for 
more information.

Functional Dimensions
Defines the stratification of the financial output results.

Product  Outputs results for each product, denominated in the reporting currency.

Product/Organizational Unit  Outputs results for each combination of product and 
organizational unit, denominated in the reporting currency.

Product/Currency  Outputs results for each combination of product and currency. 
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Product/Organizational Unit/Currency  Outputs results for each combination of product, 
organizational unit, and currency. 

Input/Assumptions Page
Click the Input/Assumptions tab for options:

Note: When you select the organizational unit as an output 
dimension, new business (from the Forecast Balance ID, Pricing 
Margin ID and Maturity Strategy ID) cannot be modeled.

Also note that when you select the currency as an output 
dimension, you can also check Consolidate to Reporting Currency 
on the Process page to output results consolidated to the reporting 
currency.
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Instrument Tables
Tables used to store account level information in the OFSA database.

Filter ID Type
Defines the type of filters to select a subset of the account level information 
contained in the instrument tables. The three filter types supported are data, group 
and tree filters.

Filter ID
This ID is used to narrow the focus of your portfolio for processing.

Leaf Characteristics ID
An ID used to define cash flow characteristics for specific products. 

For more information, see Chapter 16, "Leaf Characteristics ID".

Prepayment ID
With this function you can specify assumptions about prepayment rates for specific 
products. When a prepayment ID is selected within a Process ID, prepayment 
calculations are triggered. See Chapter 17, "Prepayment ID" for more information.

Transaction Strategy ID
With this ID you can: 

■ Model instrument data not captured through the standard extract process. 

■ Assess impact on potential deals through what-if analysis. 

■ Balance your balance sheet when slight discrepancies exist.

■ Test the impact of various hedging strategies that are integrated with basic 
scenario modeling assumptions. 

■ Add specific instrument records to a processing run without changing the 
actual instrument data. 

Note: In order to perform cash flow calculations, you must select 
at least some account-level data through instrument tables, new 
volume activity, or the Transaction Strategy ID.
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A Tree Filter ID may be applied to select a subset of the new business defined in the 
Transaction Strategy ID.   For more information, see Chapter 22, "Transaction 
Strategy ID".

New Volume Activity
Defines the timing, pricing margin and balances of new business added into your 
portfolio.

Forecast Balance ID  With this ID you can specify the volume of new activity 
generated for specific products, currencies, and modeling buckets. If you select a 
Forecast Balance ID, the output dimensions available (on the Calculation tab) are 
Product and Product/Currency. A Tree Filter ID may be applied to select a subset of 
the new business defined in the Forecast Balance ID. See Chapter 10, "Forecast 
Balance ID" for more information.

Pricing Margin ID  Use this ID to indicate the pricing margin being added to an 
interest rate code for new business, during each modeling bucket. 

Since pricing margins are defined bucket by bucket for each product and currency, 
the margin defined in bucket two can be different than that applied in bucket one. A 
set of Pricing Margin Assumptions for all products is called a Pricing Margin ID. 
See Chapter 19, "Pricing Margin ID" for more information.

Maturity Strategy ID  Use this ID to define the original and amortization terms of new 
business added during each modeling bucket. Maturity Strategies are set at the 
product and currency level. See Chapter 16, "Maturity Strategy ID" for more 
information.

Autobalancing
Use autobalancing to maintain a balanced balance sheet, and generate retained 
earnings, dividends and taxes. Product leaves used during the autobalancing 
process must be defined within the Configuration ID, including:

■ Assets

■ Liabilities Interest

■ Retained Earnings

■ Dividends

■ Federal Tax

■ State Tax
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■ Accumulated Translation Balance

If you do not completely define the required autobalancing leaves in the 
Configuration ID, an error message is generated during processing. For more 
information, see "Autobalancing Leaves" in Chapter 6, "Configuration ID"

Formula Leaves ID
Use a Formula Leaves ID to model cash flow, gap, and market value results on a 
product leaf. These results can be new or can override system generated data. If you 
select a Formula Leaves ID, the only output dimension available (on the Calculation 
tab) is Product. A Tree Filter ID may be applied to select a subset of the calculations 
defined in the Formula Leaves ID. See Chapter 13, "Formula Leaves ID" for more 
information.

Process Mode Page
Click the Process Mode tab for options:
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Location
Defines the location of processing.

Client  Client is a stand-alone personal computer with a range of features, capable of 
full processing functionality.

Server  Server is a time-sharing architecture where processing takes place in a 
mainframe-type environment. The server is either a mainframe, or personal 
computer. Because a server is generally a more powerful system, processing usually 
occurs faster when using this architecture.

Data Component
Defines the result sets to be calculated.

Entire Process  All current positions, new business, autobalancing and formula 
leaves results are calculated.

Selective Reprocess  With selective reprocessing you can run a subset of the process 
to replace invalid products and to add new products. With Selective Reprocess, the 
Reprocessing Components are enabled to selected components for reprocessing. 
When the Process ID is executed, the data in the result tables are not immediately 
deleted. The data for the selected subset is replaced, but the rest of the results 
remain intact.

Reprocessing Components
You can specify the components to be selectively reprocessed. You can reprocess 
both a subset of the product leaves and a component within the process 
components. When two Tree Filter IDs are defined, the process uses the intersection 
of the two sets of leaves.

A Tree Filter ID is used to define which products require reprocessing. Note that the 
Tree Filter defined in the Selectively Reprocess section is in addition to any filters 
attached to the process. The filter defined in the main screen establishes the main 
criteria for what is processed within a Process ID. The Tree Filter within the 
Selectively Reprocess section determines the subset of the standard process to be 
recalculated in reprocess mode.

The order of processing is as follows:

■ Current Position

■ New Business/Transaction Strategies
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■ Autobalancing

■ Formula Leaves

You cannot change the functional dimension when you selectively reprocess (an 
error message will result).

Current Position  To replace current position results, select this option. Use a selective 
reprocessing tree filter to replace/add-to a subset of the current result product 
leaves.

New Business/Transaction Strategies  Selective reprocessing on new business affects 
results processed from Transaction Strategies and Forecast Balance IDs.

Autobalancing Accounts  After selective reprocessing changes the result set, the 
balance sheet should be re-balanced. By selecting this option, former autobalancing 
results are deleted and new results are recalculated and added to the result set.

Formula Leaves  By selectively reprocessing Formula Leaves, the former Formula 
Leaf results are deleted and new results are added in their place.

Tree Filter ID for Reprocessing  This is used to define which products require 
reprocessing.

Optional Table Output
Defines additional output table for reporting.

Transform Result Table  Use this option to transform the data into Oracle Discoverer 
tables. This option is only available with server processing.

Consolidate to Reporting Currency  Use this option to output results consolidated to the 
reporting currency. This option is available when you select the Product/Currency 
or Product/Organizational Unit/Currency output dimension on the Calculation 
tab.

Audit Page
Click the Audit tab for options:
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Financial Element Details
Financial Element Output selections determine the set of financial elements that are 
written to the results detail tables. If no selections are made, only the base set of 
financial elements are written. The selection of financial element details have no 
impact on calculations. It simply defines the detail of output.

Refer to the Oracle Financial Services Technical Reference Manual for details on which 
financial elements belong in each set.

Repricing Balance and Rates  Provides information about repricing activity.

Runoff Components  Provides information about scheduled principal payments.

Prepayment Rates and Runoff  Provides information about prepayment activity.
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New Origination Balance and Rates  Provides information about forecasted new 
originations.

Cash Flows
Defines the cash flow to be written for auditing purposes.

Detail Cash Flow  Select Detail Cash Flow option to record the cashflows and 
repricing events occurring for the first five records processed. For each record, daily 
results are written to the PROCESS_CASH_FLOWS table. The data in this table uses 
the RESULT_SYS_ID, which identifies the Process ID used. 

For more information on interpreting results, see the Oracle Financial Services 
Technical Reference Manual. 

Rates

Forecast Rates  Select Forecast Rates to write forecast exchange and interest rates to 
the following tables: OFSA_EXCHANGE_RATES_AUDIT and OFSA_INTEREST_
RATES_AUDIT. See the Oracle Financial Services Technical Reference Manual for 
information on the table structures.

Define a Process ID Using Scenario-Based Processing
To define a Scenario-based Process ID, complete the following steps:

1. Select Calculation page.

2. Select desired calculation elements: Market Value and Discount Rates ID, Gap 
and Transfer Pricing.

3. Select a Forecast Rates ID from the drop-down list. Because this is a required 
field, the selection defaults to the first ID in the list.

4. Under Functional Dimensions, click Product.

5. Select Input/Assumptions page.

6. Highlight one or more Instrument Tables to select current account level 
information.

Note: If no Financial Element Details are selected, only the base 
set of financial elements will be written even when there are 
repricing and prepayment events or new volume activity.
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7. Choose a Filtering Type from the drop-down list. The default Filtering Type is 
<None>.

8. Choose a Filter ID if you are using any Filtering Type other than <None>.

9. Select a Leaf Characteristics ID from the drop-down list. Since it is a required 
selection, the selection defaults to the first ID on the list. 

10. Select a Prepayment ID if desired.

11. Select a Transaction Strategy ID if desired.

12. Select a Forecast Balance ID if desired. Your selection will enable Pricing Margin 
ID and Maturity Strategy ID.

a. Select a Pricing Margin ID.

b. Select a Maturity Strategy ID.

13. Choose Autobalancing if desired.

14. Select a Formula Leaves ID if desired.

15. Select Process Mode page.

16. Choose either Client or Server in the Location section. The default location is 
Server.

17. Choose either Entire Process or Selectively Reprocess in the Data Component 
section. The default component is Entire Process.

a. Select Reprocessing Components if Selectively Reprocess is chosen.

b. Select Tree Filter ID for Reprocessing if desired.

18. Choose Transform Result Table if you want to output transformed table under 
server processing.

19. Select Audit page.

20. Select the Financial Element Details if desired. If none is chosen, only the basic 
set of financial elements will be written into the result detail table.

21. Choose Detail Cash Flow if desired.

22. From the File menu, select Save.

Example of Creating a Scenario-Based Process ID
The following is an example on how to define a Scenario-based Process ID for 
Market Value and Transfer Pricing Calculations with new business and prepayment 
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assumptions. The calculations are set up to process on a subset of the data from 
Instrument Tables.

In the Process ID window, do the following:

1. Select the Calculation page.

2. Check the Market Value box. The Discount Rates ID will be enabled at this 
point. Select "TREASURY CURVE" Discount Rates ID from the drop-down list.

3. Check the Transfer Pricing box.

4. Select "UP 500 BASIS" Forecast Rates ID from the drop-down list.

5. Under Functional Dimensions, click Product.

6. Select the Input/Assumptions page.

7. Select "Mortgages" Instrument Table.

8. Select Filter ID Type, "Data Filter", from the drop-down list

9. Select Filter ID, "FIXED RATE MTG".

10. Select "BASE LINE" Leaf Characteristics ID.

11. Select "PSA" Prepayment ID.

12. Select "NEW MTG PROD" Forecast Balance ID from the drop-down list. 

13. Select "BASIC MARGIN" Pricing Margin ID.

14. Select "LONG TERM MTG" Maturity Strategy ID.

15. Select the Process Mode page.

16. Select Client radio button. This performs calculations on your PC instead of the 
server. The default is server.

17. Select Entire Process radio button. This is the default when creating a new 
Process ID.

18. Select the Audit page.

19. Check the Prepayment Rates and Runoff box. This generates detail prepayment 
financial output.

20. Check the New Origination Balance and Rates box. This generates detail new 
volume activity financial output.

21. From the File menu, select Save.
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Input Data for a Stochastic Process ID
Stochastic Processing differs from Scenario-Based Processing in that it generates 
Earnings, Market Value and Value at Risk by Monte Carlo simulations. Rates 
scenarios are generated based on a Term Structure model, which describes how the 
interest rate curve changes over time. Before instrument records are processed, 
balance and payment fields are first translated to the reporting currency, and then 
reported in the reporting currency.

Calculation Page
Click the Calculation tab for options:
20-16 Oracle Risk Manager Reference Guide



Input Data for a Stochastic Process ID
Calculation Elements
Defines processing of a specific financial calculation.

Earnings at Risk  Earnings at Risk uses the Monte Carlo rate generator to generate a 
series of rate paths which is applied to instrument records to produce earning 
forecasts. This option writes out two standard result sets: average leaf earnings and 
average total portfolio earnings. Average leaf earnings is written out to EAR_LEAF_
AVG_xxx whereas average total portfolio earnings is written out to EAR_TOTAL_
AVG_xxx with xxx denoting the system id number of the process.

Market Value  Market Value is calculated per rate scenario for each Product Leaf. The 
result Market Value is the total Market Value over number of rate paths per Product 
Leaf. The results are stored in TM Stochastic Market Value.

Value at Risk  Value at Risk measures the probability of changes in value of the 
current position data, occurring over specified time horizons, displayed in the 
interface as the At Risk period.

When the users selects the Value at Risk calculation option in a process ID and 
subsequently run that ID, the software will in addition to calculating the current 
market value, calculate the change in market value for each rate path and rank these 
changes in market value for each product leaf and for the entire balance sheet. 
These results are stored in two tables: TM Stochastic Value at Risk and TM 
Stochastic Total VAR.

At Risk Period  The At-Risk period defines the time period over which changes in 
market value are calculated.

Stochastic Processing Parameters
You define the term structure model used for rate path simulations.

Note: To run Monte Carlo simulations, you must select at least 
one of the calculation elements: Earnings at Risk, Market Value or 
Value at Risk.

Note: When Value at Risk is selected, market value is also written 
to TM Stochastic Market Value table.
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Valuation Curve  For the valuation curve, select the best proxy of the risk-free yield 
curve. The best candidate is a government bond curve since governments do not 
usually default on their debt. Only IRCs associated with the reporting currency of 
the Process ID will appear.

Term Structure Model  A term structure model is used to describe how risk-free rates 
will evolve over time. Each term structure model forecasts either the real interest 
rate or the risk-neutral rate. Models that forecast risk-neutral rates are called 
no-arbitrage models. The following models are available: 

■ Merton—real interest rate model

■ Ho and Lee—no arbitrage model

■ Vasicek—real interest rate model

■ Extended Vasicek— no arbitrage model

See the Oracle Financial Services Technical Reference Manual for more information on 
term structure models.

Smoothing Method  Smoothing is the drawing of a smooth, continuous line through 
observable market data points. Because there are an infinite number of these lines 
passing through a given set of points, additional criteria must be added to the 
smoothing process to achieve the desired term structure. The following methods are 
available:

■ Cubic Spline of Yields

■ Linear Interpolation

A cubic spline is a series of third degree polynomials that have the form:

y     =    a  +  bx  +  cx2  +  dx3

These polynomials are used to connect the dots formed by observable data. The 
polynomials are constrained so they fit together smoothly at each knot point (the 
observable data point.) This means that the slope and the rate of change in the slope 
with respect to time to maturity have to be equal for each polynomial at the knot 
point where they join. If this is not true, there is a kink in the yield curve and they 
are continuous but not differentiable.

Two more constraints make the cubic spline curve unique. The first restricts the 
zero-maturity yield to equal the 1-day interest rate. The second restricts the yield 
curve at the longest maturity to be either straight (y"=0) or flat (y'=0). 
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The cubic spline method also extrapolates the original yield curve outside its 
domain of definition. The resulting smoothed yield curve is constant and equal to 
the:

■ First term yield for first term

■ Last term yield for last term

Linear interpolation uses linear yield curve smoothing. Linear yield curves are 
continuous but not smooth; at each knot point there is a kink in the yield curve. You 
many not want to use a linear yield curve with a model that assumes the existence 
of a continuous forward rate curve, due to the nonlinear and discontinuous knot 
points of a linear yield curve.

Rate Index ID  A Rate Index ID establishes a relationship between the risk-free rates 
and other interest rate indices. For more information, see Chapter 21, "Rate Index 
ID".

Number of Rate Paths  The number of rate paths specifies the number of Monte Carlo 
simulations to execute. The valid range is from 1 to 2000. The default is 200.

Random Number Generation Method
To run Monte Carlo simulations, you must specify the random number generator 
algorithm for the rate path generation.

Low Discrepancy Sequences  Low-discrepancy sequences, also known as 
quasi-random sequences, are designed to prevent clustering of generated numbers; 
this results in achieving better accuracy than pseudo-random sequences when 
applied to numerical problems; integration in high dimensions, and so on.

Pseudo Random Sequences  Pseudo Random sequences are the traditional random 
numbers generated by most compilers. They are designed to do well on some 
statistical tests: low autocorrelation, high period before the sequence repeats itself.

Input/Assumptions Page
The Input/Assumptions options for stochastic processing are the same as for 
scenario-based processing, with the following exception: Autobalancing is available 
in stochastic processing only when you select Earnings at Risk on the Calculation 
page. See "Input/Assumptions Page" under "Input Data for a Scenario-Based 
Process ID" in this chapter.

T ≤
T ≥
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Process Mode Page
Click the Process Mode tab for options:

Location
Defines the location of processing.

Client  Client is a stand-alone personal computer with a range of features, capable of 
full processing functionality.

Server  Server is a time-sharing architecture where processing takes place in a 
mainframe-type environment. The server is either a mainframe, or personal 
computer. Because a server is generally a more powerful system, processing usually 
occurs faster when using this architecture.

Detail Earnings
Option to write detail earnings results for each rate path. This option is only 
available when Earnings at Risk is chosen in the Calculation page.
20-20 Oracle Risk Manager Reference Guide



Input Data for a Stochastic Process ID
Product Leaf Earnings  Output detail earning calculations for each rate path 
simulation per product. Results are written to EAR_LEAF_DTL_xxx where xxx is 
the system id number of the process.

Portfolio Earnings  Outputs detail earning calculations for each rate path simulation 
for the total portfolio. Results are written to EAR_TOTAL_DTL_xxx where xxx is 
the system id number of the process.

Audit Page
Click the Audit tab for options:

Cash Flows
Defines the cash flow to be written for auditing purposes.

Detail Cash Flow  Select Detail Cash Flow option to record the cashflows and 
repricing events occurring for the first five records processed. For each record, daily 
results are written to the PROCESS_CASH_FLOWS table. The data in this table uses 
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the RESULT_SYS_ID, which identifies the Process ID used. For more information on 
interpreting results, see the Oracle Financial Services Technical Reference Manual. 

Rates
Defines rates to be written during the Monte Carlo simulation for auditing 
purposes.

1-Month Rates  Select this option to view the rate paths generated during the 
stochastic processing run. When selected, 360 monthly rates are output to the TM 
Stochastic Rates table, for each rate path.

Define a Process ID Using Stochastic Processing
To define a Scenario-based Process ID, complete the following steps:

1. Select Calculation page.

2. Choose the Calculation Elements that need to be executed. The available choices 
are Earnings at Risk, Market Value and Value at Risk. 

a. If Value at Risk is chosen, you must input at Risk Period. Input the At Risk 
Period by entering a period and use the drop-down list to select a period 
definition of either days, months, or years.

3. Select a Valuation Curve in the drop-down list. Because this is a required field, 
the selection defaults to the first Valuation Curve in the list.

4. Select a Term Structure ID in the drop-down list. Because this is a required field, 
the selection defaults to the first ID in the list.

5. Select a Rate Index ID in the drop-down list. Because this a required field, the 
selection defaults to the first ID in the list.

6. Enter a valid number in Number of Rate Paths by typing in a number or 
clicking the spinner. The valid range for Number of Rate Paths is 1 to 2000. The 
default is 200.

7. Choose a Random Number Generation Method. The default is Low 
Discrepancy Sequences.

8. Select the Input/Assumptions page.

Note: This process can be extremely time consuming and 
database space intensive when processing large numbers of rate 
paths.
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9. Highlight one or more Instrument Tables to select current account-level 
information.

10. Choose a Filtering Type from the drop-down list. The default Filtering Type is 
<None>.

11. Choose a Filter ID if you are using any Filtering Type other than <None>.

12. Select a Leaf Characteristics ID from the drop-down list. Because it is a required 
selection, the selection defaults to the first ID on the list. 

13. Select a Prepayment ID if desired.

14. Select a Transaction Strategy ID if desired.

15. Select a Forecast Balance ID if desired. Your selection will enable Pricing Margin 
ID and Maturity Strategy ID.

a. Select a Pricing Margin ID.

b. Select a Maturity Strategy ID.

16. Choose Autobalancing if desired.

17. Select Process Mode page.

18. Choose either Client or Server in the Processing Location section.

19. Choose Detail Earnings options if Earnings at Risk is selected in the Calculation 
page.

20. Select Audit page.

21. Select Detail Cash Flow if desired.

22. Select 1 Month Rates. Note that the processing of this option may be time 
consuming and database space intensive.

23. From the File menu, select Save.

Example of Creating a Stochastic Process ID
The following exemplifies how to define a Stochastic Process ID for Earnings at Risk 
and Value at Risk Calculations with prepayment assumptions. The calculations are 
set up to process on a subset of the data from Instrument Tables.

After you create a Process ID with Stochastic Process Mode, do the following:

1. Select the Calculation page.

2. Check the Earnings at Risk box.
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3. Check the Value at Risk box. The At Risk Period will be enabled at this point. 

4. Input 2 months as the At Risk Period.

5. Select "Risk Free Curve" as the Valuation Curve from the drop-down list.

6. Select "EXT VASICEK" as Term Structure ID from the drop-down list.

7. Select "BASE RATE INDEX" Rate Index ID from the drop-down list.

8. Input 100 as the Number of Rate Paths.

9. Choose Low Discrepancy Sequences a Random Number Generation Method. 
Default is Low Discrepancy Sequences.

10. Select the Input/Assumptions page.

11. Select "Mortgages" Instrument Table.

12. Select Filter ID Type, "Data Filter", from the drop-down list

13. Select Filter ID, "ADJ RATE MTG".

14. Select "BASE LINE" Leaf Characteristics ID.

15. Select "PSA" Prepayment ID.

16. Select the Process Mode page.

17. Select Client. This will perform calculations on your PC instead of the server. 
Default is server.

18. Select Portfolio Earnings. This will output detail earnings for the total portfolio 
per rate path simulation.

19. Select Audit page.

20. Choose Detail Cash Flow. This will output detail cash flow for auditing 
purposes.

21. From the File menu, select Save.

Running a Process ID
To run a Process ID, complete the following steps:

1. Choose Process/Run from the file menu.

2. Choose OK to continue or Cancel to exit the dialog without processing.
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The Processing Status Dialog
During a client run of a Risk Manager Process, the Processing Status dialog appears. 
This dialog resets the counter for each type of operation performed and tracks the 
progress of all the steps performed during a Risk Manager Process. The final screen 
displays the Total Processing Errors as well as the Total number of records 
processed.

For a server run of a Risk Manager Process, the Processing Status is displayed in the 
Server Status Update window. The status of the process inserts a row with the 
Process ID name in the Job Description column. A number of status is updated 
during and after the execution of the process. For more information see "Server 
Status" in Chapter 4, "Overview of IDs". 
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Rate Index ID

The purpose of the Rate Index ID is to establish a relationship between your 
risk-free interest rate codes (IRCs) and each of the other interest rate codes or indi-
ces. With this relationship is established, you can forecast rates on any instrument 
tied to an IRC and as the risk-free rates change, the change in non risk-free interest 
rates will follow accordingly.

Examples of non risk-free interest rate codes are: 

■ Prime

■ Libor

■ Administered rates

■ 11th District COFI

The Rate Index ID is used only in stochastic processing. See the Oracle Financial Ser-
vices Technical Reference Manual for information on Monte Carlo calculations and 
risk-free rate calculations. 

Creating a Rate Index ID
To create a new Rate Index ID, complete the following steps:

1. From the File menu, select New -> Rate Index ID.

2. Select a folder.

3. Enter a descriptive name for the ID.

4. Enter a description for the ID. This is an optional field.

5. Click Read/Write.

6. Click OK.
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The Rate Index ID screen appears with the name of the ID shown on the top of the 
screen. 

Defining a Rate Index ID
A formula must be defined for each index tied to an instrument. That formula takes 
the following form:

Index Rate term m = K1 Risk Free Rate1 x1 + K2 Risk Free Rate2
x2 + ... K8 Risk Free Rate 8

x8 + Spread

To create your formula, you can select up to eight terms (elements) from the Risk 
Free curve, each multiplied by a user-defined coefficient and raised to the power of 
a user-defined exponent. Additionally, you can add a constant spread to the for-
mula. It is not necessary to define any assumptions for the risk free curve. Any defi-
nition for this curve is ignored and does not affect processing.

Each of the elements you define consist of:

■ A coefficient - A multiplier to weight each term selection.

■ An exponent - An exponent to allow for polynomial curve-fitting.

■ A term selection - a selection of rates associated with a term from the risk-free 
curve.

These elements define different rate forecast generated for each instrument, with a 
given IRC. 

To define a Rate Index ID, complete the following steps:
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1. Select an interest rate code. If the IRC chosen has term options available, the 
Index Term field is activated. If there are no terms associated with the IRC, the 
field is static.

2. If applicable, select an Index Term.

3. If you want to add a spread to the results of the term elements:

a. Click the check mark in the box next to the word Spread. 

b. Enter a spread for the element. A spread is a firm and constant percentage 
added to the variable rate produced on the Monte Carlo calculations. 

You can apply one Spread percentage for each element.

4. Type the number of elements to apply to the IRC. As you increase the number 
of elements, the rows in the table appears as shown in the following example.

5. In the Elements table, type a Term for the first element. 

6. Select a Term Multiplier. Term multipliers include days, months and years.

7. Type a coefficient.

8. Type an exponent.

9. Complete steps 5–8 for the remaining elements.

10. From the File menu, select Save.
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Example: A Defined IRC 

In this example, the IRC is defined as follows:

1. The IRC (Index) chosen is Prime Index.

2. Three Elements have been added to the current As-of-Date.

3. An additional Spread percentage of 2.5% is added to the derived rate.

4. The forecasted rate calculations are multiplied, respective of the three elements 
and displays as:

Prime = 0.25 *  (1 month rate) +.50 * (6 month rate) + 0.25 * (12 month rate) + 2.5%.

5. From the File menu, select Save.
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Transaction Strategy ID

With the Transaction Strategy ID you can test the impact of various hedging 
strategies that are integrated with basic scenario modeling assumptions. This 
supports you in testing alternative strategies and their incremental impact on 
results. The testing is facilitated by the separation of transaction strategies from 
basic scenario assumptions. You can also use this ID to add specific instrument 
records to a processing run without changing the actual instrument data. 

A transaction is either positive or negative and can be defined for any leaf value. A 
Transaction Strategy ID is made up of any number of individual transactions.

Creating a Transaction Strategy ID
To create a new Transaction Strategy ID, complete the following steps:

1. From the File menu, select New -> Transaction Strategy ID.

2. Select a folder.

3. Type a descriptive name for the ID.

4. Type a description for the ID. This is an optional field.

5. Click Read/Write.

6. Click OK.

The Transaction Strategy ID and tree bar appear.
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7. Type values and select options as described in "Setting up a Transaction 
Strategy" this chapter.

8. From the file menu, select Save.

Setting up a Transaction Strategy
To add a new transaction or instrument record to the ID, click the Add button. A 
new column will appear in the Transaction Strategy ID. To delete a transaction or 
instrument record, click the top portion of the Transaction column you want to 
delete; then click the Delete button.

Once you add a new Transaction column by clicking the Add button, position the 
cursor in that column. Double-Click the specified product leaf value in the product 
section of the Tree Bar to add a transaction. The currency code defaults to the 
highlighted currency code from the currency section in the lower half of the Tree 
Bar. The product leaf value appears in the Leaf Node row in the new column. The 
currency code value appears in the Currency row in the new column. 

As an alternative approach for product selection, type the code value of the product 
in the Leaf Node cell at the top of the newly added column. You can update the 
currency code as well, by highlighting the cell and selecting from one of the active 
currencies in the drop-down list. 
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All fields in the white boxes are mandatory fields and must be populated. The gray 
boxes cannot be edited.

The values are populated with the default settings from the corresponding leaf in 
the Leaf Characteristics ID defined in the active Configuration ID. You can then 
modify any of the settings. 

You can add as many transactions for any leaf value as you wish.

Relationship Triggers
When input of a particular characteristic is unnecessary as a result of characteristics 
in other fields, the unnecessary field is disabled. The following table describes those 
relationships.

Leaf 
Charac.

Trans. 
Strat. Field Value Behavior

YES YES Amortization 
Type Code

Conv. Fixed,

Conv. Adjust.,

Adjst/Ng Amrt

Always interest in arrears, therefore 
disables Interest Type.

YES YES Amortization 
Type Code

Conv. Fixed, 
Rule-of-78’s

No repricing occurs, therefore 
disables repricing characteristics, 
e.g.,

Adjustable Type Code

Repricing Frequency and Multiplier

Tease Period Freq. and Multiplier

Tease Discount

Rate Set Lag Freq. and Multiplier

Minimum Rate Change

Rate Cap Life

Rate Floor Life

Rate Increase Period and Life

Rate Decrease Period and Life

Rate Change Round Type & Percent

Negative Amortization fields (only 
enabled for Adjst/Ng Amrt--see 
below)
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YES YES Amortization 
Type Code

Adjst/Ng Amrt Enables Negative Amortization 
fields:

Payment Change Freq. & Multiplier

Payment Increase Period & Life

Payment Decrease Period & Life

Neg. Am. Eq. Frq., Mult., & Limit

YES YES Amortization 
Type Code

Any 
User-Defined 
Payment 
Pattern

Payment Frequency is defined in 
Pattern, therefore disables Payment 
Frequency and Multiplier in this ID

YES YES Adjustable Type 
Code

Fixed, Floating, 
or any 
User-Defined 
Repricing 
Pattern

Repricing Frequency is not 
applicable, or it is defined 
elsewhere, therefore disables 
Repricing Frequency and Multiplier

YES YES Adjustable Type 
Code

Any 
User-Defined 
Repricing 
Pattern

Several of the repricing 
characteristics are defined 
elsewhere, therefore they are 
disabled in this ID (e.g., Interest 
Rate Code, Transfer Rate Interest 
Rate Code, etc.). Only periodic 
increase and decrease, rate change 
minimum, and rounding are 
enabled

NO YES Adjustable Type 
Code

Any 
User-Defined 
Repricing 
Pattern

Disables Rate Pricing Option

YES YES Repricing 
Frequency

0 No repricing occurs, therefore 
disables repricing characteristics 
(listed above under "Amortization 
Type Code ... Conv. Fixed")

YES NO Model with 
Gross Rates

Off Net Margin Flag options are only 
necessary when modeling with 
different gross and net rates, 
therefore disables Net Margin Flag

YES YES Rate Change 
Rounding Type

"No Rounding" 
or "Truncate"

Rounding does not apply, therefore 
disables Rate Change Rounding 
Percent

Leaf 
Charac.

Trans. 
Strat. Field Value Behavior
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For more details on using the cash flow columns, see "Transaction Strategy Fields" 
in this chapter.

Transaction Strategy Fields
The following fields are used in the Transaction Strategy ID.

NO YES Rate Pricing 
Option (when 
active)

Assign during 
processing

Disables direct input Rate fields 
(net, gross, and transfer rate)

YES YES Currency Allows display of Interest Rate 
Codes and Transfer Rate Interest 
Rate Codes for which the selected 
currency is the reference currency. 
In Leaf Characteristics, Default 
Currency (’000’) allows all Interest 
Rate Codes, regardless of currency

Field Description

ACCRUAL BASIS The basis on which the interest accrual on an account is 
calculated. The choices are as follows: 

■ 30/360

■ Actual/360

■ Actual/Actual

■ 30/365

■ 30/Actual

■ Actual/365

ADJUSTABLE TYPE Determines the repricing characteristics of the new business 
record. The choices consist of all standard OFSA codes and all 
additional user-defined repricing patterns created through the 
Repricing Pattern interface. The standard OFSA codes are as 
follows:

■ Fixed

■ Floating

■ Adjustable

Leaf 
Charac.

Trans. 
Strat. Field Value Behavior
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AMORTIZATION 
TERM

Term upon which amortization is based. Units specified by 
amortization multiplier.

AMORTIZATION 
MULTIPLIER

Units (days, months, years) in which Amortization Term is 
specified.

AMORTIZATION TYPE Method of amortizing principal and interest. The choices consist 
of all standard OFSA codes and all additional user-defined 
codes created through the Payment Pattern interface. The 
standard OFSA codes are the following:

■ Conventional Fixed

■ Conventional Adjustable

■ Adjustable Negative Amortization

■ Non-Amortizing

■ Rule of 78’s

■ Level Principal

BALANCE Represents either the originating balance for transaction strategy 
records originating in the future, or the current balance for 
transaction strategy records representing already originated 
accounts. If the origination date is in the past, the current 
balances are from the as-of date.

COMPOUNDING 
BASIS

Determines the number of compounding periods per payment 
period. The choices are the following:

■ Daily

■ Monthly

■ Quarterly

■ Semi-Annual

■ Yearly

■ Continuous

■ Simple

■ At Maturity

CURRENCY Currency of the instrument.

DEFERRED BALANCE Current Unamortized Deferred Balance associated with 
Instrument (i.e. Premium, Discount, Fees, etc.)

GROSS MARGIN Contractual spread over interest rate code used in calculation of 
gross rate.

Field Description
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GROSS RATE  Gross rate on the instrument.(i.e. paid by the customer).

NET RATE Nominal interest rate on instrument owed to, or paid by, the 
financial institution.

TRANSFER RATE  The associated transfer rate for the account.

ORIGINAL TERM Contractual term at origination date.

ORIGINAL 
MULTIPLIER

Units (days, months, or years) of Original term.

ORIGINATION DATE The date of the origination for the transaction account. This day 
may be in the future or the past.

INTEREST TYPE Determines whether interest is calculated in arrears or advance. 
There are two interest types:

■ Interest in Arrears

■ Interest in Advance

For conventional amortization products, interest in arrears is the 
only valid choice.

INTEREST RATE CODE Defines the pricing index to which interest rate is contractually 
tied. The interest rate codes that appear as a selection option 
depend on the choice of currency. The interest rate code list is 
restricted to codes which have the selected currency as the 
reference currency.

MINIMUM RATE 
CHANGE

The minimum required change in rate on a repricing.

NEGATIVE 
AMORTIZATION 
EQUALIZATION 
FREQUENCTY

Frequency at which current payment necessary to fully amortize 
the instrument is re-computed.

NEGATIVE 
AMORTIZATION 
EQUALIZATION 
MULTIPLIER

Units (days, months, or years) of negative amortization 
equalization multiplier.

NEGATIVE 
AMORTIZATION 
EQUALIZATION 
LIMIT

Maximum negative amortization allowed, as a percent of 
original balance. For example, if principal balance exceeds 125% 
of original balance, the column will equal 125.0.

NET MARGIN The contractual margin over the interest rate code used in 
computing net rate. Gross margin minus any fees.

Field Description
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NET MARGIN FLAG The setting of the net margin flag affects the calculation of net 
rate. The two settings are: 

■ Floating Net Rate - the net rate reprices in conjunction with 
the gross rate, at a value net of fees.

■ Fixed Net Rate - the net rate equals a fixed fee equal to the 
net margin.

PAYMENT CHANGE 
FREQUENCY

The frequency at which the payment amount is recalculated for 
adjustable negative amortization instruments.

PAYMENT CHANGE 
MULTIPLIER

Units (days, months or years) of payment change frequency.

PAYMENT DECREASE - 
PERIOD

Maximum payment decrease allowed during a payment change 
cycle of a negative amortization instrument.

PAYMENT DECREASE - 
LIFE

Maximum payment decrease allowed during life of a negative 
amortization instrument.

PAYMENT 
FREQUENCY

Frequency of payment (P&I, Interest or Principal). For bullet 
instruments, use zero.

PAYMENT 
MULTIPLIER

Units (days, months or years) of payment frequency.

PAYMENT INCREASE 
PERIOD

Payment Increase Periods: Maximum payment increase allowed 
during a payment change cycle on a negative amortization 
instrument.

PAYMENT INCREASE 
LIFE

Maximum payment increase allowed during the life of a 
negative amortization instrument.

RATE CAP LIFE Maximum rate allowed during life of the instrument.

RATE CHANGE 
ROUNDING PERCENT

Percent to which the rate change on an adjustable instrument in 
rounded.

RATE CHANGE 
ROUNDING TYPE

Method used for rounding of interest rate codes. The choices are 
as follows: no rounding, truncate, round up, round down, round 
nearest.

RATE DECREASE 
PERIOD

Maximum amount rate can decrease during the repricing period 
of an adjustable rate instrument. 

RATE DECREASE LIFE Maximum amount rate can decrease during the life of an 
adjustable rate instrument. Will be used to calculate the rate 
floor based on the forecasted rate scenario. If both rate decrease 
life and rate floor are defined, the process uses the more 
restrictive rate.

Field Description
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RATE FLOOR LIFE Minimum rate for life of the instrument.

RATE INCREASE 
PERIOD

Maximum interest rate increase allowed during the cycle on an 
adjustable rate instrument.

RATE INCREASE LIFE Maximum interest rate increase allowed during the life of an 
adjustable rate instrument. Will be used to calculate rate life 
based on forecasted rates scenario. If both rate increase life and 
rate cap are defined, the process uses the more restrictive rate.

RATE PRICING 
OPTION

There are two Rate Pricing options: Direct Input and Assign 
During Processing.

Direct Input

■ The Direct Input option allows you to input rates for new 
business in the Transaction Strategy ID.

Assign During Processing 

■ The Assign During Processing option uses the Origination 
Date and Interest Rate Code (IRC) specified in the 
Transaction Strategy and pulls the corresponding rate from 
the Forecast Rates ID; that is, it is priced dynamically during 
the simulation.

RATE SET LAG 
FREQUENCY

 Period by which the payment recalculation lags the date of the 
interest rate used for calculation.

RATE SET LAG 
MULTIPLIER

 Units (days, months, or years) of rate set lag frequency.

REPRICING 
FREQUENCY

Contractual frequency of rate adjustment.

REPRICING 
MULTIPLIER 

Units (days, months, or years) of repricing frequency.

TEASE DISCOUNT The tease discount is used in conjunction with the original rate 
to calculate the tease rate.

TEASE PERIOD 
FREQUENCY

The tease period frequency is used to determine the length of 
tease period. 

TEASE PERIOD 
MULTIPLIER

Units (days, months, or years) of tease period frequency.

TRANSFER RATE 
INTEREST RATE CODE 

The interest rate code will be used to calculate the transfer rate 
for new business. The lists of interest rate codes is restricted to 
interest rate codes with the reference currency equivalent to the 
currency selected from the Tree Bar. 

Field Description
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TRANSFER RATE 
MARGIN

The transfer rate margin is used in conjunction with the interest 
rate code to calculate a transfer rate for new business.

Field Description
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Transformation ID

Most tables in the Oracle Financial Data Manager (FDM) database are formatted for 
processing. Using your specifications, the Transformation ID restructures data from 
the processing tables and creates new tables for reporting and analysis. This new set 
of tables is called the Oracle Financial Data Manager Reporting Data Mart.

The Reporting Data Mart is a collection of tables within a database, optimized for 
use with reporting and analysis tools. It is created in the same database warehouse 
where the FDM processing data is stored. You can use the Reporting Data Mart with 
any reporting tool, without having to further manipulate your data. You can create, 
open, and edit the Transformation ID in any of the Oracle Financial Services (OFS) 
applications that use the Tree Rollup ID, including:

■ Balance and Control

■ Risk Manager

■ Performance Analyzer

This chapter discusses the following topics:

■ The Transformation Process

■ Creating a Transformation ID

■ Defining a Transformation ID

The Transformation Process
As the transformation process extracts data from the processing tables and 
restructures it into the Reporting Data Mart, the Transformation ID maintains the 
integrity of the data. In addition, the Transformation ID stores other transformation 
specifications, such as:
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■ Which transformations are performed

■ What tables are designated for transformation

■ What parameters or special processing options to apply

Pivoting
The Transformation ID uses two methods of pivoting to transform data:

■ Financial Element

■ Time Bucket

Financial Element Pivot
For processing, financial elements are stored in the FDM database in separate rows. 
The Financial Element Pivot extracts the financial elements from the FDM database 
and pivots them into columns. Each financial element in the original table receives 
its own column in the reporting and analysis table.

Time Bucket Pivot
A column exists for each time period in the FDM database. Reporting and analysis 
tools require that time periods exist as rows. The Time Bucket Pivot extracts the 
time periods from the FDM database and pivots them into rows.

The following tables require both the Financial Element and Time Bucket Pivots:

■ Risk Manager Result Detail table (RES_DTL_XXX)

■ Ledger Stat table (LEDGER_STAT)

Non-Pivot Transformations
Some Non-Pivot transformations perform filtering functions. Others run additional 
transformations on selected data. The Non-Pivot Transformations are:

■ Dimension Filtering

■ Data Filtering

■ Rates
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Dimension Filtering
With Dimension Filtering, you can select dimensions to exclude. Only Leaf Type 
Columns are valid dimensions for exclusion. When dimensions are excluded, the 
Transformation ID:

1. Creates the output table without the columns for the selected dimensions, and

2. Performs a sum aggregation of the data based on the remaining leaf columns

Data Filtering
With Data Filtering, you can specify the use of a filter on the input table. A filter 
limits the amounts of data for processing. If a filter is specified in the financial 
element column, then the output table is created with only those financial elements 
specified in the filter.

Rates
There are two types of rates used during processing:

■ Weighted Rates

Rates weighted with their associated balances are stored in the following tables:

■ Ledger Stat

■ Risk Manager Result

The transformation process leaves these rates weighted.

■ Non-Weighted Rates

Real rates (non-weighted) cannot be aggregated unless they are weighted 
against a balance. These weighted rates are then saved to the output table. 

Occasionally, non-weighted rate data is saved in the LEDGER_STAT table. This 
rate data is primarily used with allocations. Reports are not generally created 
from these financial rate elements. The rate data is invalid for transformations 
that aggregate results from these financial elements. You should filter these 
financial elements using a data filter prior to running the Transformation ID. 

Tree Rollup
The transformation for rollups is different than for other tables. Before the 
transformation rollup, data is stored in different tables. One rollup is combined and 
stored in the output table. Each transformation creates a separate table in which 
only one rollup is placed. This output table is also referred to as a Hierarchy Table.
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Metadata and System Information Table
For each new table and column created during the transformation process, the 
Transformation ID inserts the appropriate rows into the FDM metadata tables to 
identify the new output table. The FDM metadata tables contain information for 
defining and tracking tables, columns, and other objects.

Creating a Transformation ID
To create a new Transformation ID, complete the following steps:

1. Choose File -> New -> Transformation ID. 

The New Transformation ID dialog box appears.

2. Choose a folder.

3. Press the Tab key to move to the next field.

4. Enter a descriptive name in the Transformation ID field.

5. Enter a description for your ID in the Description field. This is an optional step.

6. Check the Read/Write option. 

7. Choose OK.

The Transformation ID dialog box appears with the name of the ID displayed at the 
top. 
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Defining a Transformation ID
The sources from which to process the Transformation ID are:

■ Ledger Stat

■ Risk Manager Result Detail

■ Tree Rollup

Defining a Ledger Stat Transformation
The Ledger Stat Table stores General Ledger and statistical information.

To define a Transformation ID for a Ledger Stat table, complete the following steps: 

1. Select Ledger Stat from the Choose Source Type list. Ledger Stat appears in the 
Choose Table field and the Ledger Stat dialog appears.

Note: The selection of tables available under Choose Source Types 
depends on which OFS products are installed.

Note: The Ledger Stat Table appears as the default setting.
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2. Modify the name of the output table in the Transform Into field to fit your 
requirements. This is an optional step. 

You cannot use the following characters in the Transform Into field:

■ , (comma)

■ % (percent sign)

■ " (quotes)

■ . (period)

The Transformation ID automatically calculates the storage parameters for the 
output table. These parameters can also be set manually by your database 
administrator. For more information on output tables, refer to the 
Transformation Output Table Creation section in the Oracle Financial Services 
Installation and Configuration Guide.

3. Check the The Drop Existing Table option to overwrite the existing output table. 

The following tables explain processing variables, and the results of using them 
with the Drop Existing Table option:

Note: The maximum amount of characters you can enter in the 
Transform Into field is 26.

Note: By default, only the primary key index is created when the 
output table is generated. For instructions on how to automatically 
create additional indexes on output tables, refer to the 
Transformation section in the Oracle Financial Services Installation 
and Configuration Guide.

IF THEN

the Drop Existing Table Option 
is checked,

any table with the same name that appears in the 
Transform Into field is dropped.

IF AND THEN

the Drop Existing Table option is 
not checked, and a valid table 
name appears in the Transform 
Into field,

either the Current Month 
or the Selective 
Processing option is 
checked,

newly processed data is 
added into the existing 
Transform Into table.
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4. Check the Replace Existing Data option to overwrite any previously created 
data. The following tables explain several processing variables and the results 
of using them with the Drop Existing Table option:

5. Select one of the following Processing Options:

■ Current Month

This option processes the data for the Current Month. The As of Date in the 
Active Configuration ID specifies the Current Month. 

■ Entire Table

This option processes all records within the Ledger Stat Table.

■ Selective Reprocessing

You can specify a range of dates for processing with this option.

IF AND THEN

the Drop Existing option 
is not checked,

the Entire Table option is 
checked, and a table exists 
with the name specified in 
the Transform Into field,

the Transformation ID stops all 
processing.

IF THEN

the Entire Table Processing Option is 
checked,

the Replace Existing Data option is not 
available.

IF AND THEN

the Replace Existing Data 
option is checked,

new data is being added 
to an existing table,

any previous data that has identical 
dates as the new data is replaced.

the Replace Existing Data 
option is not checked,

new data is being added 
to an existing table, and 
any previous data has 
identical dates as the 
new data being added,

the Transformation ID stops all 
processing.
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6. Choose a Filtering Type from the list if you want to include a filter. 

7. Choose an ID from the Filter list if you want to include a Filter ID.

8. Select the columns you want to exclude from processing in the Leaf Columns to 
Exclude field. All leaf columns within the Ledger Stat Table appear in the Leaf 
Columns to Exclude field. After you choose which columns to exclude, at least 
one column remains and cannot be selected.

The following table explains several processing variables that disable the Leaf 
Columns to Exclude field:

Risk Manager Result Detail Table
The Risk Manager Result Detail Table stores processing results from the Oracle Risk 
Manager product. To define a Risk Manager Result Detail Table, complete the 
following steps: 

1. Select Risk Manager Result Detail from the Choose Source Type list. The Risk 
Manager Result Detail dialog appears.

Note: Filtering narrows the focus of processing to include specific 
assumptions you define. Three filters used by the Ledger Stat Table 
include: Data, Folder, and Tree. A list of previously created filter 
IDs is associated with each filter type.

Note: Your filter cannot include any columns that are selected to 
be excluded during this step.

WHEN IF AND THEN

the Transform Into 
Table already exists, 
and

the Drop Existing 
Table option is not 
checked,

the Current Month or 
the Selective 
Processing option is 
selected,

the Leaf Columns to 
Exclude field cannot be 
changed.
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2. Select a folder.

3. Select a leaf type from the Leaf Type list.

4. Select a Process ID from the list.

5. Modify the name of the output table in the Transform Into field to fit your 
requirements.

Depending on the type of information in the Result_Detail Table, the output 
tables are appended with either of the following characters:

_C This table contains only the cash flow information (XXX_C).

_G This table contains only the GAP information (XXX_G).

$C This table contains only the aggregate cash flow information (XXX$C).

$G This table contains only the aggregate GAP information (XXX$G).

Note: If your results are both Cash Flow and GAP, then output 
tables are created as appropriate with the extensions of _C and _G. 
For aggregated results, output tables with the extensions $C and $G 
are created.
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6. Check the The Drop Existing Table option to overwrite the existing output table. 
The following table explains a processing variable and the result of using it with 
the Drop Existing Table option:

7. Select the names that appear in the Columns to Exclude field to exclude during 
processing. This field shows only valid leaf columns from the Result Detail 
Table. After you choose which columns to exclude, at least one column remains 
and cannot be selected.

Tree Rollup Table
The Transformation ID extracts data for one rollup and places the data into a 
customized table specific to that rollup.

To define a Tree Rollup Table, complete the following steps:

1. Select Tree Rollup from the Choose Source Type list. The Tree Rollup dialog 
appears.

2. Select a folder.

IF THEN

the Drop Existing Table Option 
is checked,

any table with the same name that appears in the 
Transform Into field is dropped.
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3. Select a leaf type from the Leaf Type list.

4. Select a Tree Rollup ID from the Tree Rollup ID list.

5. Modify the name of the output table in the Transform Into field to fit your 
requirements.

6. Check the The Drop Existing Table option to overwrite the existing output table. 
The following table explains a processing variable and the result of using it with 
the Drop Existing Table option:

IF THEN

the Drop Existing Table Option 
is checked,

any table with the same name that appears in the 
Transform Into field is dropped.
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Tree Filter ID

A Tree Filter ID narrows the focus of your tree hierarchy for reporting and process-
ing. For example, you can use a Tree Filter ID if you want to report on only the 
accounts that roll up to the Commercial Loans portion of a product tree. A Tree Fil-
ter ID must have a predefined Tree Rollup ID as part of its definition.

Creating a Tree Filter ID
To create a new Tree Filter ID, complete the following steps:

1. From the File menu, select New -> Tree Filter ID. 

2. Select a folder.

3. Select a leaf type.

4. Select a Tree Rollup ID. 

5. Type a descriptive name for the ID. 

6. Type a description for the ID. This is an optional field.

7. Click Read/Write. 

8. Click OK.

The Tree Filter ID window appears:
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The Tree Filter ID Window
When defining the Tree Filter ID, you use the Rollup Tree and Display Level panes.

Rollup Tree Pane
The Rollup Tree pane shows the hierarchical tree structure at any desired level of 
detail. The Rollup Tree allows you to view the structure of the tree at any level of 
the hierarchy. 

Branch Expansion Indicator
Each node is represented by a description and an Indicator which symbolizes if a 
branch can be expanded or not. The Branch Expansion Indicator is a ’+’ if the branch 
can be expanded further to reveal nodes at the next lower level. The ’-’ indicates that 
the branch has already been expanded and all nodes at the next lower level are dis-
played. A blank indicates that there are no nodes attached at the next lower level. 

Node Inclusion Indicator 
When viewed in the Tree Filter ID, each node of the Rollup Tree is accompanied by 
a Node Inclusion Indicator which identifies whether any part of the branch below 
the node is included in the Tree Filter. If there are nodes at lower levels which are 
included in the filter, the Node Inclusion Indicator is green. If there are no nodes at 
lower levels of the branch which are included in the Tree Filter, it is red. 
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Current Level Name
The name of the level currently selected in the Rollup Tree appears in the top left 
corner of the screen and changes as various levels are selected.

Display Level Pane
The Display Level pane on the right allows you to see all the nodes attached to the 
selected node in the Rollup Tree at a specific level below the selected node. To spec-
ify the level of the hierarchy which you want to display you must select Tree from 
the menu bar.

Tree menu
In order to change how the structure of a tree is viewed and to specify which 
branches are to be included in the filter, select Tree from the menu bar:

Expand One Level
Expand One Level displays the branch of nodes attached one level below the 
selected node. You can also expand a branch by one level by selecting a node in the 
Rollup Tree and typing ’+’, or by double clicking the Branch Expansion Indicator 
when the indicator displays a ’+’.

Expand Branch
Expand Branch displays all levels of nodes attached under the node selected in the 
Rollup Tree. You can also expand a branch to show all lower levels of attached 
nodes by selecting a node in the Rollup Tree and typing ’*’. This option is only avail-
able when the Branch Expansion Indicator displays a ’+’.
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Expand All
Expand All displays every level of the Rollup Tree above and below the selected 
node. You can also display the whole Rollup Tree by typing Crtl+*. This option is 
only available when the Branch Expansion Indicator displays a ’+’.

Collapse Branch
Collapse Branch hides all levels of nodes attached under the selected node from the 
Rollup Tree display. You can also collapse a branch by one level by selecting a node 
in the Rollup Tree and typing ’-’, or by double clicking the Branch Expansion Indica-
tor when the indicator displays a ’-’.

Focus on Branch
Focus on Branch changes the Rollup Tree display from the whole tree to only the 
tree structure below the selected node. You can also focus on a branch by typing 
Ctrl+F.

Undo Focus
Undo Focus turns off the branch focus. Use this to expand your focus from an indi-
vidual branch to the total Rollup Tree. You can also return to the total tree display 
by typing Ctrl+U.

Set Display Level
Set Display Level allows you to change the level that is displayed in the Display 
Level pane. To change the Display Level, from the pop-up menu select the level you 
want to display. 

Set Tree Level
Set Tree Level allows you to change the rollup level shown in the Rollup Tree pane. 
To change the Tree Level, select the level you wish to be displayed from the pop-up 
menu.

Include Branch in Filter
Include Branch in Filter allows you to select an entire branch for inclusion in the 
Tree Filter ID. To include an entire branch of a Rollup in the Tree Filter, select the 
node at the top of the desired branch, then select Include Branch in Filter from the 
Tree pull-down menu, or type Ctrl+D.

If a node is included in the Tree Filter, then the Node Description is displayed in 
bold print, otherwise it is displayed in gray print.
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Exclude Branch from Filter
Exclude Branch from Filter allows you to select an entire branch to be excluded 
from the Tree Filter ID if it has already been selected. To exclude an entire branch of 
a Rollup in the Tree Filter, select the node at the top of the desired branch, then 
select Exclude Branch from Filter from the Tree pull-down menu, or type Ctrl+E.

Toggle In/Out of Filter
Toggle In/Out of Filter allows you to select or deselect a single node from an entire 
branch with out changing the selection status of any other nodes in the branch. To 
include an individual node in a branch that is excluded, or to exclude an individual 
node in a branch that is included, select the node to be toggled, then select Toggle 
In/Out of Filter from the Tree pull-down menu, or type Ctrl+T.

Tree Filter ID Example
In this example, create a Tree Filter ID named Checking, which checks profitability 
analysis. The example uses the Rollup Tree ID named Product that was created in 
the chapter Tree Rollup ID.

1. From the File menu, select New -> Tree Filter ID. 

2. Select All for the folder, so everyone in the group can access it.

3. Select Common COA ID for Leaf Type. This is the same ID that was used in the 
Tree Rollup ID example.

4. Select Product for Tree Rollup ID.

5. Type Checking in the Tree Filter ID name box.

6. Type This filter is for checking profitability analysis in the 
Description box.

7. Click Read/Write.

8. Click OK. 
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The Tree Filter ID window appears:

9. Highlight Checking at Level 2, and select Include Branch in Filter from the Tree 
menu. The Nodes Inclusion Indicators turn green for all the Level 2 Checking 
branches.

10. From the File menu, select Save.
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Tree Rollup ID

Tree Rollup IDs define a hierarchical structure of detailed data in the Oracle 
Financial Data Manager (FDM) database. For example, you can build a model of the 
various levels into which products roll up and use cost centers as the base level of 
the institution. You use a Tree Rollup ID to define these hierarchical structures.

With a Tree Rollup ID, you can define multiple organizational, product, account, 
and other hierarchies by using leaves as the lowest level of detail in the hierarchical 
structure. Each row in the FDM database contains a leaf value for each dimension of 
profitability. These leaves serve as the lowest level in constructing Tree Rollup IDs.

For more information about Tree Rollup IDs and IDs in general, see Chapter 4, 
"Overview of IDs".

This chapter presents the following topics:

■ Creating a New Tree Rollup ID

■ Using the Tree Rollup ID Window

■ Editing a Tree Rollup ID

■ Example: Building a Product Tree

Creating a New Tree Rollup ID
To create a Tree Rollup ID, perform the following steps:

1. From the File menu, click New.

A list of the IDs that are available for the product you are using appears.

2. Select the Tree Rollup ID.

 The New Tree Rollup ID dialog box appears.
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3. Select Folder and Leaf Type.

4. Type in the Tree Rollup ID and Description fields, as required.

5. Select the permission level of the ID, as required.

Read/Write is the default.

6. Click OK to continue.

The Tree Rollup ID window appears.
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Using the Tree Rollup ID Window
The Tree Rollup ID window comprises the Rollup Tree and Display Level panes. It 
also provides access to the Edit, Options, and Tree menus.

Rollup Tree Pane
The Rollup Tree pane enables you to see and manipulate the tree structure at any 
level of the hierarchy.

Branch Expansion Indicators
Each node is represented by a description and an Indicator that indicates whether 
or not a branch can be expanded. The Expansion Indicator is a + (plus sign) if the 
branch can be expanded to display nodes at the next lower level, a - (minus sign) if 
the branch has already been expanded and all lower nodes are displayed, and blank 
if no lower nodes are attached.

Current Level Name
The name of the level currently selected in the Rollup Tree pane appears after Rollup 
Tree in the menu bar. The level name changes as different levels are selected.

Display Level Pane
The Display Level pane enables you to see all the nodes attached to the selected 
node in the Rollup Tree at a specific level below the selected node. To set the level of 
the hierarchy that you want to display, select the Tree menu -> Set Display Level.

Edit Menu

Search
If you want to locate a specific node within a Tree structure, you can use the Search 
option in the Edit menu. The Tree Rollup Search dialog box appears:
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Field Name Field Description

Search Field Select the Node Number or Description for which you are 
searching.

Search String Type the Node Number or Description.

Level Select the Level of the node in the Tree. If you do not know the 
level, leave the default entry of All Levels.

Search Options

■ Case Sensitive Provides exact string matches when searching on descriptions 
only

■ Wrap Search Performs the search of both node numbers and descriptions 
starting from the current cursor location on the Tree structure 
and continuing at the top of the Tree structure

Match

■ Beginning Searches node numbers or descriptions beginning with the 
string entered in the Search String field

■ Contains Searches node numbers or descriptions containing the string 
entered in the Search String field
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Search fails if the value you want is not within the 16,000 leaves range. The 
following message appears: “The tree is too large to show entirely. Collapse 
branches or use Search and Focus to view more.” See the Tree Menu for more 
information about Collapse Branch.

Search Again
The Search Again option is available in the Edit menu and enables you to continue 
your search using the same criteria that you defined in Search.

Search and Focus
The Search and Focus option is available in the Edit menu. It uses the same dialog 
box as the Search option and takes you to the value itself.

Search and Focus Again
Like the Search and Focus option, the Search and Focus Again option is available in 
the Edit menu. It uses the same dialog box as the Search option and takes you to the 
value itself.

Search and Focus Again shows only the node or leaf for which you are searching. It 
does not show context or hierarchy. It is the only option that you can use with a 
large tree, that is, one containing more than 16,000 leaves.

Options Menu
You can use the Options menu to format the appearance of your Tree Rollup ID. The 
Options menu provides the following functions:

■ Select Font

■ Show Node Numbers on Left

■ Show Node Numbers on Right

Note: Trees can show as many as 16,000 leaves and nodes at a 
time.

Note: Search and Focus and Search and Focus Again are 
specifically for use on trees having more than 16,000 leaves.
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Using the Tree Rollup ID Window
Select Font
You can change the typeface in which your tree is displayed on your window. To try 
a new font:

1. Click Set Font.

The default font is Font: System, Font Style: Bold, Size: 10. Each font is 
previewed in the Sample window at the bottom of the dialog box.

2. Select an appropriate Font, Font Style, Size, and Script, and then click OK.

You select a smaller font to view more information within one window or a 
larger font to display less information per window but to view it more clearly.

Show Node Numbers on Left
You can select Show Node Numbers on Left if you are familiar with your Node 
Numbers and want to view them. This option displays the Node Numbers before 
the Node Descriptions.

This option is a toggle. To turn off the Node Numbers, select the option again.

Show Node Numbers on Right
You can select Show Node Numbers on Right if you are familiar with your Node 
Numbers and want to view them. This option displays the Node Numbers after the 
Node Descriptions.

This option is a toggle. To turn off the Node Numbers, select the option again.
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Using the Tree Rollup ID Window
Tree Menu
To change how the structure of a tree is viewed and to specify which branches are to 
be included in the rollup, you select Tree from the menu bar.

Expand One Level
Expand One Level displays the branch and nodes attached one level below the 
selected node. You can also expand a branch by one level by selecting a node in the 
Tree Rollup and typing + (plus sign) or by double clicking the Branch Expansion 
Indicator when the indicator displays a + (plus sign).

Expand Branch
Expand Branch displays all levels of nodes attached under the node selected in the 
Tree Rollup. You can also expand a branch to show all lower levels of attached 
nodes by selecting a node in the Tree Rollup and typing Shift + * (plus sign and 
asterisk). This option is available only when the Branch Expansion Indicator 
displays a + (plus sign).

Expand All 
Expand All displays every level of the entire Tree Rollup above and below the 
selected node. This option is available only when the Branch Expansion Indicator 
displays a + (plus sign).

Collapse Branch 
Collapse Branch hides all levels of nodes attached under the selected node from the 
Rollup Tree pane. You can also collapse a branch by one level by selecting a node in 
the Rollup Tree pane and typing - (minus sign), or by double clicking the Branch 
Expansion Indicator when the indicator displays a - (minus sign).

Note: Focus on Branch, Undo Focus, and Focus to Top are 
specifically for use on trees having more than 16,000 leaves.

Note: Expand All expands only the first 16,000 leaves and nodes. 
A Rollup ID can display a maximum of 16,000 leaves and nodes at 
a time.
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Using the Tree Rollup ID Window
Focus on Branch 
Focus on Branch changes the Rollup Tree pane from displaying the whole tree to 
displaying only the tree structure below the selected node.

Undo Focus 
Undo Focus turns off the focus on a branch. This enables you to display all branches 
of the total Tree Rollup when you no longer want to focus on an individual branch.

Focus to Top
Focus to Top returns you directly to the top of the Rollup Tree pane. You do not 
need to return level by level.

Levels Maintenance
Levels Maintenance enables you to manipulate the level structure of a tree. Using 
this option, you can add, subtract, and rename levels of the Tree Rollup. Selecting 
this option opens the Rollup Level Maintenance dialog box.

■ Insert Level enables you to insert a level into the hierarchy. To insert a new 
level, select the level in the Level Description box above which you want to add 
a level, and click Insert Level.

Note: Focus on Branch, Undo Focus, and Focus to Top are 
specifically for use on trees having more than 16,000 leaves.
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Using the Tree Rollup ID Window
Enter the name of the new level in the New Level Name box, and click OK. For 
more information, refer to the Oracle Financial Services Installation and 
Configuration Guide.

■ Delete Level enables you to remove a level from the hierarchy. To remove a 
level, select the level you want to remove in the Level Description box and click 
Delete Level. You are prompted to confirm your decision to delete the level.

■ Rename Level enables you to rename an already existing level. To rename a 
level, select the level you want to rename in the Level Description box and click 
Rename Level.

Enter the new name in the New Level Name box, and click OK.

When you have finished with Levels Maintenance, click OK to return to the main ID 
window. Click Cancel at any time to exit without changes.

Set Display Level
Set Display Level enables you to change the level displayed in the Display Level 
pane. Click this option to open the display level dialog box.

To change the Display Level, from the menu, select the level you want displayed.

Set Tree Level
Set Tree Level enables you to change the level that is displayed in the Rollup Tree 
pane. Click this option to open the display level dialog box.

Insert Node
Insert Node enables you to add an additional node to the Tree Rollup. To insert a 
node, select a node in the Tree Rollup under which you want to add a node, and 
click Insert Node. You can place new nodes anywhere in the Rollup Tree except 
below the leaf level or orphan node.

The Insert Node dialog box appears:

■ Parent Level is the level of the parent node under which the new node is being 
added.

■ Parent Name is the name of the parent node under which the new node is being 
added.

■ New Node Level is the level at which the new node is being added.

■ New Node Name enables you to enter the name of the new node.
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Using the Tree Rollup ID Window
If you leave the New Node Name field blank, the new node appears in the Tree 
Rollup display, without a descriptive tag.

■ New Node ID enables you to define the ID number that will be associated with 
the new node. This field does not require input because a unique default ID 
number is supplied by the system. If you decide to enter an ID number for the 
new node manually, however, this number must be unique.

Click OK when you have finished. Click Cancel at any time to exit without saving 
changes.

Rename Node
Rename Node enables you to rename or renumber an existing node. Select the 
desired node from the Tree Rollup, and select this option. The Rename/Renumber 
dialog box opens.

■ Name

Enter the new name in the Name box.

■ Number

Enter the new number in the Number box.

Click OK when you have finished. Click Cancel at any time to exit without changes.

Delete
Delete enables you to delete a node from the Tree Rollup. To delete a node, select 
the node you want to delete from the Tree Rollup and click Delete. The selected 
node and all nodes below it are deleted. The Leaves that are attached below the 
deleted node become orphan leaves in the orphan branch of the tree.

Copy
Copy enables you to copy an orphan leaf or group of orphan leaves from the 
orphan branch into another node in the Tree Rollup. To copy a single orphan leaf 
from the orphan branch, select the orphan leaf in the Tree Rollup or set the Display 
Level to Orphan Leaves and select the desired Orphan Leaf. Next, click Copy. Now 
select the node to which the orphan leaf is to be copied in the Tree Rollup, and use 
Paste to attach the leaf to the new node.

To copy several orphan nodes at one time to a single node in the Tree Rollup, hold 
the Shift key while selecting successive nodes. Then use Copy and Paste to attach 
the block of nodes at the new location.
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Using the Tree Rollup ID Window
Cut
Cut enables you to cut a leaf, a group of leaves, or a branch from the Tree Rollup.

To cut a portion of a Tree Rollup, select the leaf or node from the Tree Rollup, or set 
the Display Level. Next, click Cut. To reattach the cut portion of the tree to a 
different part of the tree, select the node to which the portion is to be copied in the 
Tree Rollup, and click Paste to attach it to the new node. 

To cut several orphan nodes at one time, hold the Shift key while selecting 
successive nodes. Then click Cut if you want to reattach the nodes at a new location. 
Click Delete to cut the block of nodes permanently.

If a node that has leaves attached at a lower level is cut, or if leaves from the Tree 
Rollup are cut, the leaves are automatically placed at the end of the orphan leaves. If 
the leaves are reattached, or the node to which the leaves were attached are moved 
to a different part of the tree, the leaves that were placed at the end of the orphan 
branch are automatically moved.

Paste
Paste enables you to attach cut or copied orphan leaves nodes, and branches to new 
nodes in the Tree Rollup. After you Cut or Copy, select the node to which you want 
to attach the data, and click Paste.

You can only perform a Paste after a Cut or Copy action has been performed. Paste 
can only be performed on the leaves or nodes copied or cut in the immediately 
previous cut or copy. If cuts are performed without a paste the node information 
from the first cut is lost and the leaves are placed at the end of the orphan leaves.

You can perform a Paste only after a Cut or Copy has been performed. Paste can be 
performed only on the leaves or nodes copied or cut in the immediately previous 
cut or copy. If you cut without a paste, the node information from the first cut is lost 
and the leaves are placed at the end of the orphan leaves.

Node Up
Node Up enables you to move a node up the list of nodes if more than one node is 
attached to a parent node. In order move a node above another node in the Tree 
Rollup window, select the node to move and click Node Up.

Node Down
Node Down enables you to move a node down the list of nodes if more than one 
node is attached to a parent node. In order move a node below another node in the 
Tree Rollup window, select the node to move and click Node Down.
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Editing a Tree Rollup ID
Transform Rollup
Transform Rollup transforms the current Tree Rollup ID into a hierarchy table 
within the Oracle Financial Data Manager Reporting Data Mart. The new hierarchy 
table has the same name as the Tree Rollup ID.This table makes information 
available to the Reporting Data Mart user and for reporting purposes through 
Oracle Discoverer and other reporting tools. For more information, refer to 
Chapter 23, "Transformation ID".

Save the ID
Save the ID by clicking the Save icon on the horizontal toolbar, or choose Save from 
the File menu.

Editing a Tree Rollup ID
To open an existing Tree Rollup ID, perform the flowering steps:

1. From the File menu, click Open.

A list of the IDs that are available for the product you are using appears.

2. Select Tree Rollup ID.

The Select Tree Rollup ID dialog box appears.

3. Select Folder, Leaf Type, and Tree Rollup ID, as required.

4. Click OK.

The Tree Rollup ID window appears.

5. Click in the pane that you want to search, either Rollup Tree or Display Level.

If you select the Rollup Tree pane, you see the leaves in the context of the tree. If 
you select the Display Level pane, you see only the leaves.

6. From the Edit menu, click Search to search for the Tree Rollup ID you want to 
edit.

The Tree Rollup Search dialog box appears.

7. Select either Node Number or Description in Search Field.

Note: Trees can show as many as 16,000 leaves and nodes at a 
time.
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Example: Building a Product Tree
8. Type the Search String, such as Corporate.

9. Select Level, Search Options, and Match, as appropriate.

10. Click OK.

The Tree Rollup ID appears if your search is within 16,000 leaves. Search fails if 
the value you want is not within the 16,000 leaves range. The following 
message appears: “The tree is too large to show entirely. Collapse branches or 
use Search and Focus to view more.” 

11. Click on the Tree Rollup ID.

12. With the Tree Rollup ID selected, copy or paste it as appropriate.

For example, you want to cut one leaf, Regional Corporate, from Wholesale and 
move it to Branch Administration.

13. When your cutting or pasting is complete, select File -> Save to save your Tree 
Rollup ID, or select File -> Save As to save your edited Tree Rollup ID under a 
new name.

Example: Building a Product Tree
In this example, you use the Tree Rollup ID to build a product tree with five 
hierarchy levels.The tree structure is as follows:

Levels Product Categories

LEVEL I

Business Type Personal

LEVEL II

Market Family Checking, Savings, Retirement

LEVEL III

Market Type Interest, Non-Int., Liquid, Time, IRAs

LEVEL IV

Market Product Regular, Money Market

LEVEL V Star Checking, Super Checking,

Product Description Money Mkt I, Money Mkt II
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Example: Building a Product Tree
You must set the levels of the tree before you can build it. 

Set the Levels of a Tree
To set the levels of a tree, perform the following steps:

1. Click New on the horizontal toolbar.

A list of the IDs that are available for the product you are using appears.

2. Select the Tree Rollup ID.

 The New Tree Rollup ID dialog box appears.

3. Select All for Folder.

Now everyone in the folder has access.

4. Select Common COA ID for Leaf Type.

This is the Leaf Type that contains the information for products.

5. Type PRODUCT as the Tree Rollup ID name.

6. In Description, type This Product Tree is for Deposits Only.

7. Select Read/Write for Security.

8. Click OK.

The Tree Rollup ID window appears.

9. Select Levels Maintenance from the Tree menu.

The Levels Maintenance dialog box appears: The default names are the level 
numbers.
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Example: Building a Product Tree
10. Set the tree levels to define the structure of the tree.

11. To change the numbers to names, select each level, click Rename Level, and 
type the new name.

The default number of levels for a new tree is set at five. You can add or 
subtract levels by clicking the Insert Level or Delete Level buttons. For this 
example, the number of levels is left at five. The maximum number of levels 
available is 15.

12. When you have finished naming the levels, click OK.

13. After setting the levels, build the tree.

Build a Tree
To build a tree, perform the following steps:

1. Highlight the parent branch into which you are going to insert the new branch.

2. Insert a new branch.

You insert the first level of the sample, Business Type, by highlighting Total 
Rollup.

3. Click Insert Level (or select Insert Node from Tree menu).

The Insert Node dialog box appears.

4. In the New Node Name box, type the description for this example, Personal, 
and click OK.
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Example: Building a Product Tree
5. Repeat procedures 1 and 2 to insert all Level Two, Three, and Four branches.

6. The lowest level, Level Five, is the leaf level.

For new trees, Leaves are under the Orphan branch.

7. Attach the leaves to each branch by one of two methods:

■ Use Copy and Paste from the Tree menu to copy the leaf from the Orphan 
branch to the target branch.

■ Use the mouse to drag the selected leaf from the Orphan branch and drop it 
on the appropriate branch.

After the leaves are attached, the Tree Rollup ID window appears.

8. Save the new Tree Rollup ID.

9. Click the Exit icon at on the horizontal toolbar to exit the new ID.
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User-Defined Payment 
26

User-Defined Payment Pattern

The User-Defined Payment Pattern provides a method to customize amortization of 
specific products and instruments. In a payment pattern, you can assign a unique 
amortization code to a set of payment phases, which may include some of the 
following customized features:

■ Changes in payment frequency

■ Seasonal payment dates

■ Non-standard or variable payment amounts

You use a payment pattern by entering it as the amortization type code for the 
instrument. 

This chapter provides information and instruction on:

■ Payment Pattern Structure

■ Defining a Payment Pattern

■ Editing a Payment Pattern

■ Deleting a Payment Pattern

See the Oracle Financial Services Technical Reference Manual for information on how a 
payment pattern is applied during a cash flow process.

Payment Pattern Structure
You define a payment pattern with a payment term of either absolute or relative. 
The payment term determines whether the phases of the pattern focus on calendar 
dates or time periods. Absolute patterns are sets of payment characteristics 
scheduled on specific calendar dates. Relative patterns are sets of payment 
characteristics scheduled for certain periods of time. 
Pattern 26-1



Payment Pattern Structure
You can define a payment pattern with both absolute and relative payment terms. 
This type of pattern is called a Split Pattern, which is discussed separately in a 
following section because of its unique applications.

The user interface for payment patterns is in the form of grids. Each grid has a set of 
columns that you use to define payment patterns and their phases. These columns 
represent the payment characteristics of the payment pattern. The payment 
characteristics of the phases vary depending upon what payment type and term 
that you select for the payment pattern.

You define all payment patterns in the payment pattern grid, and then you define 
the phases of the pattern in another grid.

The columns on the payment pattern grid are as follows:

Columns Description

Code The code is a numeric internal identifier for the payment pattern, also 
known as an amortization code. Valid codes are 1000 through 29999.
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Payment Pattern Structure
Payment Phases
You must define one or more payment phases to complete a payment pattern. A 
payment phase is a set of payment characteristics that defines the timeline of the 
payment phase.

Though the characteristics change based on whether you are defining an absolute or 
relative pattern, two characteristics appear for both patterns: Payment Method and 
Value.

Description The description helps identify the payment pattern. This description 
appears in the Data Filter ID, Leaf Characteristics ID and Transaction 
Strategies ID, under the choices for amortization type codes. Additionally, 
the description is used when reporting on the amortization type code 
column from the instrument tables.

Note: Keep the description for payment patterns concise. The Data 
Filter ID can only display the first 15 characters of the description.

Split When checked, this option designates the pattern code as a split pattern. 
For information on how to define a split pattern, see "Splitting a Payment 
Pattern".

The pattern attributes listed in the next two columns, Payment Term and 
Payment Type, are grayed out if this option is checked. The pattern 
attributes for these codes are defined for each timeline individually, 
rather than for a pattern as a whole. 

Pattern Type The pattern type determines what payment characteristics are available 
when defining the payment phases, such as month and day or frequency 
and value.

Payment Type The payment type determines the available characteristics for defining 
the payment amount. You must assign a payment type for each pattern. 
The payment types are:

■ Conventional 

■ Level Principal

■ Non-Amortizing

Note: The payment pattern interface is for a single user. You 
cannot open the interface when another user has access.

Columns Description
User-Defined Payment Pattern 26-3



Payment Pattern Structure
Payment Method
The payment methods determine the behavior of the value (or payment amount) of 
the payment phase. Six methods are available:

% of Original Balance This method calculates the payment as the original 
balance multiplied by the input percent. This method is 
useful for apportioning the starting balance on a level 
principal instrument over several payments. This 
method is available only for payment patterns that you 
define with a payment type of Level Principal.

% of Current Balance This method calculates the payment as the current 
balance prior to payment multiplied by the input 
percent. This method is available only for payment 
patterns that you define with a payment type of Level 
Principal.

% of Original Payment This method calculates the payment as the original 
payment column from the detail instrument data 
multiplied by the input percent. For new business, it 
uses the original payment amount calculated at the 
origination of the instrument.

Note: Do not use the % of Original Payment method 
for an instrument that initially pays interest only for 
new business. In this case, the original payment 
amount is zero, and all payments described as a % of 
the Original Payment would therefore also be zero.

% of Current Payment This method calculates the payment as the previous 
payment multiplied by the input percent. This 
payment is calculated on the payment date, according 
to the characteristics of the instrument at the time of 
the payment, including the current rate, current 
balance, and current payment frequency. The input 
percent is applied to the calculated payment amount.
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Payment Pattern Structure
Value
The value reflects the percentage or payment amount based on the method chosen 
for the payment phase. Value is not available for phases using the payment method 
Interest Only.

Payment amounts for conventional pattern phases must reflect both principal and 
interest payments. Payment amounts for level principal pattern phases reflect only 
the principal portion of the payment. For level principal pattern phases, the total 
cash flow on a payment date is the principal amount stored as the payment plus the 
calculated interest. 

Absolute Patterns
You can use absolute payment patterns for instruments that are on a seasonal 
schedule, such as agricultural or construction loans that require special payment 
handling based on months or seasons.

Absolute Payment This is an input payment amount. This amount 
represents both principal and interest for a 
conventional payment type. For a payment type of 
level principal, it represents principal only. For both 
types of patterns, you enter absolute value payment 
amounts as gross of participations.

Note: Do not use this method for new business. If you 
assign a pattern that includes absolute value to new 
business, processing ignores the pattern.

Interest Only This is an input payment amount. Processing calculates 
an interest-only payment as balance times rate times 
accrual factor.

Note: The Payment Method and Value columns are not available 
for patterns defined with a Non-Amortizing payment type. The 
application assumes all payments are interest only for this type of 
pattern.
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Payment Pattern Structure
For example, you may have a loan that follows a seasonal pattern. To match the 
slow season of the customer, payments for the months of January, February, and 
March are interest-only payments. As revenues for the customer increase, the 
payment amount also increases. Therefore, the payments for April and May are 80 
percent of the original payment, and the payments for June through September are 
100 percent of the original payment. The payment decreases as the production 
season slows. The payment for October decreases to 80 percent of the original 
payment, and the payments for November and December decrease again to 50 
percent of the original payment.

In addition to Payment Method and Value, two payment characteristics of absolute 
patterns are available:

Relative Patterns
You can create relative payment patterns for instruments that have irregular 
scheduled payments.

Note: You can define only up to a full year of payments. The 
application automatically orders the payments by date and 
schedules the payments in a single-year rotation.

Column Description

Month The month of the payment phase

Day The day of the month the payment is due
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Payment Pattern Structure
For example, you may have a step loan for a term of four years. The payment for 
the first 12 months is interest only. The following 35 payments are 50 percent of the 
currently scheduled payment, and the last payment is a balloon payment for the 
balance of the loan.

In addition to Payment Method and Value, three payment characteristics for relative 
patterns are available:

Split Pattern
A split pattern contains multiple sets of payment phases under a single 
amortization code. You use a split pattern for financial instruments that make 
principal payments along two concurrent amortization schedules. Each separate 
amortization schedule is a timeline to which you assign a percentage of the balance. 

Column Description

Frequency The frequency of the payment

Multiplier The time frame in which the payment phase repeats itself:

■ Days 

■ Months

■ Years

Repeat The number of times the payment phase repeats itself
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Defining a Payment Pattern
You create a payment phase (or timeline) for each separate amortization schedule 
and assign a percentage of the whole balance. For example, you can use a split 
pattern to model customer behavior for payment of credit card balances. 

The columns for the payment pattern grid are as follows:

Defining a Payment Pattern
To define a payment pattern, complete the following steps:

1. Select Setup -> User-Defined Payment Pattern.

2. Click the up-arrow spinner once to add a new row.

Column Heading Description

Pattern Type The payment term determines what payment characteristics are 
available for determining future payment dates. The payment terms 
are Absolute or Relative.

Payment Type The payment type determines the available characteristics for 
defining the payment amount. Each pattern must have a payment 
type. The payment types are:

■ Conventional 

■ Level Principal

■ Non-Amortizing

Percent The percent value represents the percentage weight of the timeline 
within the payment pattern
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Defining a Payment Pattern
If this is the first payment pattern, the new row appears beginning with 1. 
Otherwise, the new row appears at the bottom of the existing list with the next 
available number.

3. Type a code and description for the new payment pattern.

It must be in the range of 1000 to 29999. If you enter a code outside of this 
range, the cell containing the code turns blank and a message displays in the 
status bar:

Code value must be greater than 999 and less than 30000 

You cannot enter duplicate codes. If you attempt to enter a duplicate code, the 
cell containing the code clears and a message appears in the status bar:

Duplicated code value

4. Check Split if you are defining a split payment pattern. 

If you check the Split box, the application disables the Payment Term and 
Payment Type columns.

5. Select the appropriate Payment Term.

If you select Relative, define the payments with a numeric term, a multiplier, 
and the number of payments at this frequency. If you select Absolute, assign a 
specific month and day for each payment.

You must assign a payment term to each pattern. If you change a pattern from 
Absolute to Relative, or from Relative to Absolute, the application deletes the 
phases of the pattern.

6. Select the appropriate Payment Type.

7. Define the payment phases for the payment pattern.

CAUTION: When editing the interface to add new pattern codes, 
avoid typing numbers into the box next to the arrows. For example, 
if you type 25 to increase the number of patterns from 24 to 25, you 
lose many of your patterns. As you initially type the 2, the 
application deletes patterns 3 to 24. When you type the 5, the 
application adds rows 3 to 25 back in as blank rows.
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Defining a Payment Pattern
You can follow the instructions in "Defining Payment Phases for an Absolute 
Payment Pattern" or "Defining Payment Phases for a Relative Payment Pattern" 
to complete the payment phase grid for the appropriate payment pattern.

8. Click OK to accept the payment pattern and exit, or click Cancel to exit without 
saving.

Defining Payment Phases for an Absolute Payment Pattern
To create payment phases for an absolute payment pattern, complete the following 
steps:

1. Click on the line number to select the entire payment pattern.

An arrow appears next to the selected payment pattern.

2. Click Edit Pattern.

The grid for entering the payment phases appears.

3. Click the up arrow spinner to add the required number of rows.

You can define payments for only a single year for absolute payment patterns. If 
the term of the instrument is longer than one year, the pattern repeats itself in a 
yearly rotation until the maturity date.

4. Select the month for each payment phase.

5. Type the day for each payment phase.

6. Select the appropriate payment method for each payment phase.

7. Type the payment amount or percentage amount as appropriate for the selected 
payment method.

8. Click OK when you finish entering all payment phases, or click Cancel to exit 
without saving.

When you complete the payment pattern, the application sorts the payment dates in 
calendar order. Re-ordering the rows in the grid has no effect on processing because 
of this sorting arrangement.

When a detail instrument using a relative payment pattern is processed for 
as-of-date cash flow processing, the next payment date is internally calculated to 
determine which payment phase should be used. The calculated next payment date 
is used only for this purpose. The next payment date stored in the instrument table 
is the date used for any other processing.
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Defining a Payment Pattern
Defining Payment Phases for a Relative Payment Pattern
To create payment phases for a relative payment pattern, complete the following 
steps:

1. Click on the line number to select the entire payment pattern.

An arrow appears next to the selected payment pattern.

2. Click Edit Pattern.

The grid for entering the payment phases appears.

3. Click the up arrow spinner to add the required number of rows.

Each row represents a payment phase.

4. Type the frequency for each payment phase.

5. Select the multiplier for each payment phase.

6. Type the number of payments at this frequency in the Repeat column for each 
payment phase.

7. Select the payment method for each payment phase.

8. Type the payment amount or percentage amount as appropriate for the selected 
payment method.

9. Click OK when you finish entering all payment phases, or click Cancel to exit 
without saving.

Unlike absolute payment patterns, relative patterns can represent multiple 
payments within a single row of the interface. 

The pattern repeats its rotation if the life of the instrument is longer than the 
defined payment phases of the pattern. This rotation occurs until the maturity date 
of the instrument. For example, you create a payment pattern to make monthly 
payments for the first year and quarterly payments for the next three years. If you 
apply this pattern to an instrument record with an original term of five years, the 
pattern wraps around and the payment pattern schedules the fifth year for monthly 
payments.

To avoid this rotation, you can set the repeater of the last defined payment phase to 
999. This repeater instructs the instrument that uses the payment pattern to repeat 
the last payment phase until the maturity date of the instrument.
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Defining a Payment Pattern
Splitting a Payment Pattern
To split a payment pattern, complete the following steps:

1. Check the Split box for the payment pattern.

2. Click on the line number to select the entire payment pattern.

An arrow appears next to the selected payment pattern.

3. Click Edit Pattern.

The Record Split Percent dialog box appears.

4. Click the up arrow spinner to add the required number of rows.

Each row represents an individual payment pattern for the split pattern.

5. Select the desired Payment Term for each phase.

6. Select the desired Payment Type for each phase.

7. Type the percent apportioned to each phase.

As new business or detail records are processed, the initial balance must be 
allocated across the various timelines. To ensure that the sum of all balance 
allocations equals 100 percent, the last timeline defaults to the remaining 
percentage balance.

8. Define the payment phases for each payment pattern.

You can follow the instructions provided in "Defining Payment Phases for an 
Absolute Payment Pattern" or "Defining Payment Phases for a Relative 
Payment Pattern" as appropriate.

9. Click OK when you finish entering all payment phases, or click Cancel to exit 
without saving.

Split Pattern Example
The following model of customer behavior for payment of credit card balances 
assumes three determined behaviors:

■ Customers who pay the minimum payment every month (5 percent in this 
example)

■ Customers who pay the entire balance every month

■ Customers who pay the minimum payment every month and pay the entire 
balance once a year
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Defining a Payment Pattern
This example represents these customers in the order mentioned. Approximately 50 
percent of the credit card customers belong to the first group, 20 percent belong to 
the second, and 30 percent belong to the third. 

The first payment pattern in this split is a relative payment pattern with only one 
payment phase. The payment phase schedules a payment of 5 percent of the 
balance on a monthly basis.

The second payment pattern is also relative and has only one payment phase. This 
payment phase schedules a payment of 100 percent of the balance on a monthly 
basis.
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Editing a Payment Pattern
The third payment pattern is an absolute payment pattern with each month 
scheduled for payments of 5 percent, except for April. This payment phase 
schedules April for 100 percent payment of the balance.

You can enter the payment pattern code as the amortization code in the Leaf 
Characteristics ID to assign this split pattern to credit card portfolios.

Editing a Payment Pattern
You can change anything you want on a payment pattern. However, you should 
proceed with caution if you have assigned this pattern to any instruments. Some 
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Deleting a Payment Pattern
modifications trigger warnings. For example, the following message appears if you 
change the code of the payment pattern:

This Payment Pattern Code may be referred to elsewhere (instrument data, Leaf 
Characteristics or Transaction Strategies IDs.) You should update all uses of 
the code or define another pattern for old code. Change code and save all 
changes to pattern?

To edit a payment pattern, complete the following steps:

1. Select Setup -> User-Defined Payment Pattern.

2. Click on the line number to select the entire payment pattern.

An arrow appears next the selected payment pattern.

3. Make desired changes.

4. Click OK to save the changes, or click Cancel to exit without saving.

Deleting a Payment Pattern
To delete a payment pattern, complete the following steps:

1. Select Setup -> User-Defined Payment Pattern.

2. Click on the line number to select the entire payment pattern.

An arrow appears next the selected payment pattern.

3. Click Delete.

The following message appears:

“Delete selected pattern definition data?” 

4. Click Yes if you want to proceed with the deletion, or click No to exit without 
deleting.
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User-Defined Repricing Pattern

The User-Defined Repricing Pattern provides a mechanism to control the repricing 
structure of instruments whose rates change according to complex schedules. The 
User-Defined Repricing feature enables you to define multiple changes to various 
financial elements including:

■ Rates

■ Margins

■ Frequency

This chapter provides information and instruction on:

■ Repricing Pattern Structure

■ Creating and Defining a Repricing Pattern

■ Editing a Repricing Pattern

■ Deleting a Repricing Pattern

See the Oracle Financial Services Technical Reference Manual for information on how a 
repricing pattern is applied during cash flow calculations.

Repricing Pattern Structure
A repricing pattern has two parts:

■ Repricing Pattern Definition

■ Repricing Event Definition

For every repricing pattern you create, you must define at least one repricing event. 
The following sections describe each part.
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Repricing Pattern Structure
Repricing Pattern Definition
The repricing pattern enables you to define a series of repricing events that describe 
interest rate adjustment characteristics over the life of a cash flow instrument. You 
can assign one repricing pattern to many cash flow instruments.

The two types of repricing patterns you can define are: absolute and relative. An 
absolute pattern is a collection of repricing events that occur on specific dates. A 
relative pattern is a series of repricing events defined for periods of time. 

The user interface of the repricing pattern is in the form of a grid with three 
columns.

The columns of the repricing pattern grid are: 

Column Description

Code The user-defined numeric code for the repricing pattern with 
valid codes from 500 to 998

Description The description of the repricing pattern, which can be up to 80 
characters in length

Pattern Type Absolute or Relative
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Repricing Pattern Structure
Repricing Event Definition
The events of a repricing pattern define all the changes to the interest rates of the 
instrument during its life. Every pattern begins with an origination event. The first 
event describes the characteristics that are set at origination. The second event 
describes the change in the repricing characteristics after the initial period is over. A 
third event describes the next change in the repricing characteristics, and so on.

Repricing Event User Interface
The columns on the repricing event grid change based on the pattern type. You list 
each event on the Repricing Events grid. Then, you enter the detail for each event in 
a separate dialog box (see "Event Detail" for more information). You can define up 
to 999 events per pattern.

Absolute Pattern  You use an absolute repricing pattern for instruments that are date 
dependent. Each specific date represents a separate event. 

You can have up to one year of defined events that repeat for the life of the 
instrument. For example, you may have a pattern that experiences rate changes at 

Note: The repricing pattern interface is for a single user. You 
cannot open the interface when another user has access.
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Repricing Pattern Structure
the end of every quarter. In this case, you set up events for March 31, June 30, 
September 30, and December 31. However, you cannot define another event for 
March 31. If you attempt to add another event for a date already defined, the 
following message appears:

Duplicate dates not allowed.

Relative Pattern  You use a relative repricing pattern for instruments when you want 
the repricing to be determined by elapsed time since origination. Each defined 
timeline represents a separate event.

The repricing events dialog box has a grid with three columns:

Column Description

Frequency The frequency represents how often you want the repricing to occur

Multiplier The unit of time applied to the frequency:

■ Days 

■ Months

■ Years

Repeat The number of times you want the repricing event to repeat
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Repricing Pattern Structure
For example, you can define an event with a frequency of 1, a month multiplier, and 
a repeat value of 3. This translates into an event that reprices every month for a 
duration of 3 months. 

You may have a graduated rate mortgage that requires three rate changes over the 
life of the instrument. In this case, you must create three events following the initial 
event. If you wish the instrument to retain the behavior of the last defined event, set 
the repeater to 999. This prevents wrapping, or the repetition of all the defined 
events until the life of the instrument runs out.

Event Detail
You define each event with a repricing type of flat rate or indexed rate. A flat rate is 
a specific user-defined value, and an indexed rate is a series of adjustable values. 
These rate types determine what characteristics appear. When you check a 
characteristic, the application enables the appropriate fields for data entry.

Flat Rate  You can set the rate of the instrument for flat rate events to a specific value, 
such as 6%.
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Repricing Pattern Structure
When you select Flat Rate, the available detail characteristics are as follows:

Flat Rate always overrides the caps and floors defined in the instrument record or 
for new business. You must define caps and floors for new business (forecast 
balance and transaction strategy) in the Leaf Characteristics ID. See Chapter 15, 
"Leaf Characteristics ID" in the Oracle Risk Manager Reference Guide for more 
information.

Indexed Rate  You can set the rate of the instrument of indexed rate events to an 
adjustable value, defined as the index rate plus a margin. 

Characteristic Description

Net Rate The new net rate value to assign

Gross Rate The new gross rate value to assign

Transfer Rate The new transfer rate to assign
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Creating and Defining a Repricing Pattern
When you select Indexed Rate, the available detail characteristics are as follows:

Creating and Defining a Repricing Pattern
To create a repricing pattern, complete the following steps:

1. Select Setup -> User-Defined Repricing Pattern.

2. Type a code number, or advance the spinner to the next available number for 
the pattern. 

Valid codes are between 500 and 998. A new line appears at the bottom of the 
grid.

3. Type in the description of the pattern (such as, 3-Year Step GRM.)

4. Select the type of pattern (Absolute or Relative.)

5. Click once on the line number to select the entire pattern.

6. Click Edit.

The repricing events grid appears.

7. Advance the spinner to the number of events you are defining for this pattern.

Characteristic Description

IRC The Interest Rate Code is the reference interest rate you want to use 
as the index rate to set Gross Rate and Net Rate. The application 
pulls the list of the interest rate codes from the current Historical 
Rates database.

Transfer Rate IRC Application uses the input value to determine transfer rates

Net Margin Application adds input value to index rate to get Net Rate

Gross Margin Application adds input value to index rate to get Gross Rate

Transfer Margin Application adds input value to index rate to get Transfer Rate

Rate Cap Life Maximum for Gross Rate set by this event

Rate Floor Life Minimum for Gross Rate set by this event

Rate Set Lag Period by which the date of the interest rate used for calculation 
precedes the event date

Yield Curve Term The Yield Curve Term is the term the application uses in interest rate 
code lookups. If you leave this field blank, it defaults to the term 
until the next repricing.
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Editing a Repricing Pattern
8. Complete the columns on the grid as appropriate for each event.

9. Define the details of each event.

a. Click once on the line number of the event to select the entire event.

b. Click Edit.

The dialog box for defining the event details appears.

c. Select the repricing type (Flat Rate or Indexed Rate) for the event.

d. Check the applicable items for the event and type the associated values.

e. Click OK.

Repeat steps a through e for every event of the pattern.

10. Click OK on the Repricing Events grid to accept all the events for the pattern.

Editing a Repricing Pattern
You can change anything you want on a repricing pattern. However, you should 
proceed with caution if this pattern has been used by instruments. Some 
modifications trigger warnings. For example, the following message appears if you 
change the code of the repricing pattern:

This Repricing Pattern Code may be referred to elsewhere (instrument data, Leaf 
Characteristics or Transaction Strategies IDs.) You should update all uses of 
the code or define another pattern for the old code. Change code?

To edit a repricing pattern, complete the following steps:

Note: The grid columns differ for absolute patterns versus relative 
patterns. For further explanation, see "Repricing Event User 
Interface".

CAUTION: When editing the interface to add new pattern codes, 
avoid typing numbers into the spinner. For example, if you try to 
type in 25 to increase the number of patterns from 24 to 25, you risk 
losing many of your patterns. As you initially delete the 4, the 
interface displays a warning message asking you to confirm that 
you wish to delete rows 3 - 24. If you click Yes, all these patterns are 
removed.
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Deleting a Repricing Pattern
1. Select Setup -> User-Defined Repricing Pattern.

2. Click on the line number to select the entire repricing pattern.

An arrow appears next the selected repricing pattern.

3. Make desired changes.

4. Click OK to save the changes, or click Cancel to exit without saving.

Deleting a Repricing Pattern
To delete a repricing pattern, complete the following steps:

1. Select Setup -> User-Defined Repricing Pattern.

2. Click on the line number to select the entire repricing pattern.

An arrow appears next the selected repricing pattern.

3. Click Delete.

The following message appears:

"Delete selected pattern definition data?"

4. Click Yes if you want to proceed with the deletion, or click No to exit without 
deleting.
User-Defined Repricing Pattern 27-9



Deleting a Repricing Pattern
27-10 Oracle Risk Manager Reference Guide



SQ
28

SQL Talk

SQL Talk enables end users to view and write to the Oracle Financial Data Manager 
(FDM) database using Structured Query Language (SQL) statements and proce-
dures.

This chapter presents the following topics:

■ SQL Talk Privileges

■ Using SQL Talk

■ Limitations to the Spreadsheet Display and Processing Time

SQL Talk Privileges
The database privileges assigned to a user also govern SQL Talk privileges, with the 
additional restriction that, by default, all users are restricted to select-only state-
ments. The database owner must make changes in security levels to give a user the 
ability to write back to the database. See the Oracle Financial Data Manager Adminis-
tration Guide for more information.

Caution: SQL Talk provides an easy-to-use SQL input dialog. If 
you are not an expert in SQL or not familiar with your database 
structure it is important to remember the following:

■ SQL Talk is a direct link to the database and writes changes 
without prior confirmation. Misuse can severely damage your 
database.

■ SQL statements and procedures must be compatible with the 
FDM database.
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Using SQL Talk
Using SQL Talk
To open the SQL Talk window, complete the following steps:

1. From the menu bar, select Process -> SQL Talk to display the SQL Talk window.

2. Type your SQL script in the top pane of the window, ending your statement 
with the standard SQL semi-colon. 

3. Press Ctrl-Enter to run the SQL script. 

During processing a “Fetching...” dialog appears.

If you want to interrupt the process click Cancel. The lower pane of the window 
displays data up to the point of interruption.

The completed process returns data in spreadsheet format to the bottom pane of 
the SQL Talk window.

4. Close SQL Talk.

Using Multiple SQL Talk Sessions Simultaneously
You can have more than one SQL Talk open at a time; however, too many open SQL 
Talk dialogs can overtax system resources, resulting in a General Protection Fault 
error. The point at which an individual system fails depends on the client configura-
tion, system environment, and resources required to process the SQL statements.
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Limitations to the Spreadsheet Display and Processing Time
Creating Stored Procedures
To create stored procedures for processing against your database, use the SQL ID in 
Balance and Control. Refer to the SQL ID chapter in Oracle Financial Data Manager-
Balance and Control Reference Guide for information on using this ID.

Limitations to the Spreadsheet Display and Processing Time
The following limitations apply to SQL Talk.

Maximum Number of Rows and Columns Displayed
These limitations apply to the spreadsheet display. 

Maximum Number of Rows
The maximum number of rows that you can select through SQL Talk is 16,000. If 
you issue a select statement that reaches or exceeds this number the following error 
message appears: “Only 16,000 rows can be displayed...aborting.” Only the first 
16,000 rows of your select statement appear in the spreadsheet display.

Maximum Number of Columns
SQL Talk displays a maximum of 252 columns. If you issue a select statement that 
returns more than that number of columns, only the first 252 columns appear.

Optimizing Processing Time
Since the query you process against the database is stored in RAM, the speed at 
which rows are returned depends on the number of columns you select. The greater 
the number of columns, the longer it takes to return data. Therefore, make sure you 
select only the columns you want to see.
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Risk Manager Error Mess
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Risk Manager Error Messages

Error Message Error Condition
Error 
Code Effect of Error on Processing

<Assumption Id type> in Risk 
Manager Process ID 
<Assumption ID name> not 
found in database

Assumption ID cannot be found in the 
database.

105 If ID is critical for processing, 
processing is stopped

No Match for IRC Interest Rate Code cannot be found in the 
active Historical Rates database.

110 When the instrument reprices, it 
will receive a zero rate.

No Data for IRC Interest Rate Code exists in the active 
Historical Rates database, but there are no 
corresponding rate values.

115 When the instrument reprices, it 
will receive a zero rate.

Leaf Types mismatch: COL vs. 
Config ID for leaf: 
<leaf number>

Definition for leaf chosen as product leaf in 
the Config ID has changed or no longer 
exists in the database. Also can relate to 
Organizational Unit leaf if two-leaf output 
processing is defined.

120 Processing is stopped.

No of Buckets mismatch Cnfg 
ID in <Assumption ID>

Assumption ID was created when the 
active Config ID held more/less buckets 
than it has currently; therefore, the 
Assumption ID contains more/less bucket 
information than necessary.

325 If Assumption ID holds more 
buckets than currently exist, only 
the buckets within the current 
modeling term will be used. If 
Assumption ID holds less buckets 
than currently exist, the 
assumption for the last bucket will 
be carried forward for the 
remainder of the modeling term.

Inconsist. Run: MV and Discrt 
should be defined together

Market value switch and Discount Rates 
Assumption Id are not consistent; only one 
has been defined. 

330 Processing is stopped.

Inconsist. Run: MtrtStr FcstBal 
PrMrgn must be def together

New business assumption Ids (Pricing 
Margin, Maturity Strategy, Forecast 
Balance) are incomplete, some but not all 
have been defined.

330 Processing is stopped.
ages A-1



Inconsist. Run: Missing 
stochastic process assump. 

Missing stochastic process assumptions. 330 Processing is stopped.

Inconsist. Run: Rate Index ID 
is not defined

The Rate Index ID is not defined in the 
Process ID.

330 Processing is stopped.

Inconsist. Run: Term Structure 
ID is not defined

The Term Structure ID is not defined in the 
Process ID.

330 Processing is stopped.

Inconsist. Run: For BP, 
Modeling Start Date must be 
1st of month

For BP, Modeling Start Date must be 1st of 
month, for example: March 1, 1998.

330 Processing is stopped.

Inconsist. Run: No Options 
Selected for Sel. Reproc.

No Options Selected for Selective 
Reprocessing in the Process ID.

330 Processing is stopped.

Inconsist. Run: No Instrument 
Tables selected

There are no Instrument Tables selected in 
the Process ID.

330 Processing is stopped.

Inconsist. Run: BP run should 
have 60 buckets

A budgeting process should have 60 
modeling buckets.

330 Processing is stopped.

Inconsist. Run: Inconsistent 
Sel. Reproc. buckets

Number of modeling buckets in results is 
not consistent with the number of modeling 
buckets in the active Configuration ID 
during a selective reprocessing run. 

330 Processing is stopped.

Inconsist. Run: Duplicate 
AutoBal leaves

Duplicate AutoBalance leaves defined in 
the configuration ID.

330 Processing is stopped.

Inconsist. Run: Not all autoBal 
leaves defined

Not all Auto-Balancing leaves are defined. 330 Processing is stopped.

Inconsist. Run: BP buckets 
should be monthly

Modeling buckets should be monthly for a 
Budgeting process.

330 Processing is stopped.

Can’ t hit target for Leaf:<leaf 
number> bucket: <bucket 
number>

It is impossible to calculate a new add 
balance that will satisfy the conditions 
required for new business balances.

335 No new business will be added for 
this bucket.

No Leaf Char. for leaf: <leaf 
number>

Payment and repricing data have not been 
set up for in the current Leaf Characteristics 
ID for leaf being processed.

340 Default characteristics will be 
used:

 amortization type = 700

payment frequency = original term

percent taxable = 100%

accrual basis = 30/360

repricing frequency = 0

Invalid record: Invalid 
Amortiz ation Code leaf: <leaf 
number>

Amortization code is not equal to 100, 200, 
400, 500, 600, 700, 710, 820, 830

345 Risk Manager will assume an 
amortization code of 700

Invalid record: Maturity Date 
in the past leaf: <leaf number>

Maturity Date is less than the as of date 345 Record is not processed.

Error Message Error Condition
Error 
Code Effect of Error on Processing
A-2 Oracle Risk Manager Reference Guide



Invalid record: Remaining 
number of payments <= 0 leaf: 
<leaf number>

Remaining number of payments is less than 
or equal to zero.

345 Record is not processed.

Invalid record: Pmt Freq = 0 
leaf: <leaf number>

Payment frequency is equal to zero on an 
amortizing instrument.

345 Record is not processed.

Invalid record: AmrtTerm < 
OrgTerm on amortiz ing 
instrument leaf: <leaf 
number>

Amortization term is less than original term 
for amortizing instrument. 

345 Re-amortization of payment will 
be affected.

Invalid record: Next payment 
date in the past leaf: <leaf 
number>

Next payment date is less than the as of 
date.

345 If next payment date is much less 
than the as of date, it may cause 
the system to run out of memory 

Invalid record: Invalid net 
margin code leaf: <leaf 
number>

Net margin code <> 0 or 1 345 Risk Manager will default the net 
margin code to 0: Floating Net 
Rate

Invalid record: Current 
payment = 0 on amortiz ing 
instrument leaf: <leaf 
number>

Current payment equal to zero and 
amortization code is other than simple/non 
amortizing

345 For amortization codes of 100,500, 
and 600, interest will be capitalized 
as principal. For amortization code 
of 820, no principal payments will 
be made.

Invalid record: Valid rate cap < 
current rate leaf: <leaf 
number>

Rate Cap is not equal to zero and it is less 
than the current rate

345 Rate cap will be imposed on first 
repricing date.

Invalid record: Valid rate floor 
> current rate leaf: <leaf 
number>

Rate Floor is not equal to zero and it is 
greater than the current rate

345 Rate floor will be imposed on first 
repricing date.

Invalid record: Next repricing 
date in the past on repricing 
instrument leaf: <leaf 
number>

Repricing frequency is not equal to zero 
and next repricing date is less than the as of 
date

345 If the next repricing date is very far 
in the past it may cause the system 
to run out of memory. 

Invalid record: Invalid int rate 
code on repr instr leaf: <leaf 
number>

Reprice frequency is greater than zero and 
Interest rate code is not found in the active 
Historical Rates database

345 Instrument will not reprice.

Invalid record: Original term = 
0 leaf: <leaf number>

Original term is equal to zero. 345 This will produce erratic results if 
instrument is Rule of 78’s; 
amortization term is also zero; or 
payment frequency is also zero on 
a non-amortizing instrument.

Invalid record: Current net rate 
<= 0 on amortiz ing instrument 
leaf: <leaf number>

Amortization code is 100, 500, 600, 820 and 
current net rate <= 0.

345 Negative income will be generated 
for positive balances.

Error Message Error Condition
Error 
Code Effect of Error on Processing
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Invalid record: Inconsistency 
of reprice freq and 
amortiz ation. leaf: <leaf 
number>

Amortization code is 500 or 600 and reprice 
frequency is zero or amortization code is 
100 and reprice frequency is non-zero.

345 Reprice frequency will overwrite 
characteristics defined by 
amortization type code.

Invalid record: No of 
Events>16000

Number of events is greater that 16,000. 345

Invalid record: OrgTerm and 
PmtFreq = 0

Both original term and payment frequency 
are equal to zero.

345 Record is ignored.

Invalid record: Invalid 
Account Type

Invalid Account Type 345 Logs an error, continues execution.

Invalid record: Deferred 
calculations do not converge

Deferred calculations do not converge. 345 Logs an error and recognizes all 
deferred income at maturity. 

Buckets No Mismatch Assumption ID was created when the 
active Config ID held more/less buckets 
than it has currently; therefore, the 
Assumption ID contains more/less bucket 
information than necessary.

350 If Assumption ID holds more 
buckets than currently exist, only 
the buckets within the current 
modeling term will be used. If 
Assumption ID holds less buckets 
than currently exist, the 
assumption for the last bucket will 
be carried forward for the 
remainder of the modeling term.

No Target for Roll/Auto leaf: 
<leaf number> bucket: 
<bucket number>

Forecast Balance methods of Target 
Average or Target End cannot be used for a 
Leaf value used as a roll-into leaf or as an 
autobalancing leaf. 

360 Targeting methods cannot be used 
for leaves specified as roll-into or 
autobalancing. The targeted 
balances will be ignored.

Res_det: Security violation Current user does not have rights to create 
a Risk Manager results table.

365 Processing is stopped.

Res_det: Truncate fail Results table for current processing ID 
could not be cleared of old data.

365 Processing is stopped.

Res_det: Creation fail Results table for new processing ID could 
not be created.

365 Processing is stopped.

Res_det the structure of the 
result_detail table was invalid 
for selective reprocessing

The structure of the current Result Detail 
table does not match the IDT Result Detail 
Template Table.

365 Processing is stopped.

Account Type not defined for 
leaf (leaf number)

In Leaf Set-Up, an account type has not 
been specified for the current leaf.

370 Account type will default to 
Earning Assets.

No. of scen in results > 
expected leaf: <leaf number>

Number of scenarios in results set is greater 
than number of scenarios expected from 
querying current Forecast Rates ID while 
processing Autobalancing.

380 Autobalancing will only be 
processed for the scenarios 
included in the current Forecast 
Rates ID.

Invalid interest type - 
defaulted to interest in arrears

Interest type code is not equal to 0 or 1. 385 Instrument is defaulted to “interest 
in arrears.”

Error Message Error Condition
Error 
Code Effect of Error on Processing
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Invalid Pmt pattern: pmt 
pattern code. <Payment Pattern 
Code>for new business - abs 
val

Payment Pattern assigned to new business 
has a constant payment amount.

390 Error is logged

No Amrt Type in Leaf char for 
leaf: <leaf number>

No amortization type code has been 
assigned in Leaf Characteristics for current 
leaf.

395 An error message is logged and 
instrument is defaulted to simple 
interest.

No Amrt Type in Trans. Str. for 
leaf: <leaf number>

No amortization type code has been 
assigned in Transaction Strategy for current 
leaf.

396 An error message is logged and 
instrument is defaulted to simple 
interest.

Formula Leaves Error: 
Mismatch in buckets number

The number of modeling buckets in result 
set does not match the number of modeling 
buckets defined in Formula Leaves ID.

397 Error is logged.

Negative FullIndexGrs Rate 
for leaf: <leaf number>

A negative fully indexed gross rate was 
calculated on a repricing event.

505 The negative rate will be assigned 
to the instrument.

Negative FullIndexNet Rate 
for leaf: <leaf number>

A negative fully indexed net rate was 
calculated on a repricing event.

505 The negative rate will be assigned 
to the instrument.

Negative CurGrsRate Rate for 
leaf: <leaf number>

A negative current gross rate was 
calculated on a repricing event.

505 The negative rate will be assigned 
to the instrument.

Negative CurNetRate Rate for 
leaf: <leaf number>

A negative current net rate was calculated 
on a repricing event.

The negative rate will be assigned 
to the instrument.

Negative CurTrRate Rate for 
leaf: <leaf number>

A negative current transfer rate was 
calculated on a repricing event.

The negative rate will be assigned 
to the instrument.

Spread rate not found in 
Pricing Spread ID

There is no pricing spread defined for the 
current leaf.

515 Zero will be defaulted as the 
pricing spread.

Rate Not Found Forecasted rates do not exist for interest 
rate code on current instrument.

520 When the instrument reprices, it 
will receive a zero rate.

1st point used Reprice date occurs before forecasting 
period; forecasted rates do not exist.

525 This may occur if the data holds a 
reprice date which is less than the 
as-of-date. Instrument will reprice 
to the rate as of the as-of-date.

Last point used. Reprice date occurs beyond forecasting 
period; forecasted rates do not exist.

530 This may occur when calculating 
market values beyond the 
modeling term or calculating the 
last reprice/payment event for 
accruals in the last bucket. 
Instrument will reprice to the rate 
as of the last forecasted date.

Code found only Interest rate code exists in Forecast Rates 
ID, but no rates have been forecast.

535 When the instrument reprices, it 
will receive a zero rate.

Error Message Error Condition
Error 
Code Effect of Error on Processing
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Prepayment tier not selected, 
z ero prepayment rate used.

Market Rate and Quote Basis have been 
defined in the Prepayment ID, but no tiers 
or prepayment percents have been created.

540 No prepayments will occur on this 
leaf.

Last payment date is before 
origination date.

The last payment date from instrument 
record is prior to the origination date on the 
instrument record.

545 Logs error and continues. For 
Transaction Strategy, last reprice 
date is set to origination date.

No reprice frequency for 
adjustable record.

Instrument is coded as adjustable, but the 
reprice frequency is equal to zero.

550 Instrument will be treated as fixed 
rate.

No schedule found for record. No match can be found in the payment 
schedule table for the current record.

555 Logs error and defaults to simple 
interest record if payment 
frequency does not = 0. Otherwise 
discounts records.

Pattern data can not be found 
for AMRT_TYPE:<payment 
pattern code>

No payment pattern information has been 
defined for the documented amortization 
type code.

560 Log error and default to simple 
interest.

No pattern information found 
for record.

Documented amortization type code exists 
in database, but no supporting details are 
available.

565 Currently is used to notify users 
about invalid adjustment type 
code. Record defaults to fixed.

Maturity date from record does 
not match schedule data.

The maturity date on instrument record 
does not exist in the payment schedule 
table for the current record.

570 Logs error. Uses maturity date for 
schedule.

Conv amrt with interest in 
advance, defaulted to arrears.

Conventionally amortizing instrument is 
classified as interest in advance. This 
combination is not supported.

575 The instrument will be defaulted 
to interest in arrears.

Invalid Amrt. Type detected. 
Defaulted to Simple Int.

An unknown amortization type code was 
used.

585 Instrument will be defaulted to 
simple interest.

No Repricing Pattern found for 
record.

An unknown Adjustable Type Code was 
used.

600 Instrument will be defaulted to 
Other Adjustable.

Error Message Error Condition
Error 
Code Effect of Error on Processing
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Transformation ID Error Mess
B

Transformation ID Error Messages

To determine why a Process ID has failed, consult the Process_Errors table. Trans-
formation ID error information is obtained once you have identified the Process_
Sys_ID number. To determine the Process_Sys_ID number, complete the following 
steps:

1. Select the Transformation ID icon. The Select Transformation ID dialog appears.

2. From the Transformation ID drop-down menu, select the Transformation ID 
you are working on. Do not select OK.

3. Right mouse click inside the Select Transformation ID dialog. The Transforma-
tion ID Information dialog appears. Make a note of the Sys_id_num (for exam-
ple, 105877).

4. Select the SQL icon and execute the following SQL statement:

Select * From OFSA_Process_Errors
Where Process_Sys_ID = xxxxxx;

Press Ctrl+Enter to execute the statement and then look at the results. Each error 
row includes an error number, as well as other context information that can help 
you diagnose your process error. See the remainder of this appendix for further 
error code descriptions.

Error Code Error Message Error Condition Effect on Processing

20702 Error: Failed to properly 
receive params.

The parameters passed to the engine are 
invalid. This is either an internal error or 
bad command-line usage.

Processing stops.

20704 Process ID or Configuration 
ID failed to convert ID 
where <xxxx>, <yyyy>.

Process ID or Configure ID is not 
recognized by OFSA (xxxx = Process ID 
System ID number, and yyyy = 
Configuration ID System number).

Processing stops.
ages B-1



20712 Critical Memory Allocation 
Failure.

Internal Application Logic Error. Processing stops.

20713 Unable to Process. The transformation engine was unable to 
perform the requested processing due to 
an error that is either listed in the Process 
Errors table or is unknown.

This message appears 
anytime processing 
stops for any error, 
known or unknown.

20714 LoadStart Failed During 
Read.

Internal Application Logic Error.

OR

Database Access Layer failure.

Processing stops.

20715 IoBase: Memory Allocation 
Failure.

Internal Application Logic Error. Processing stops.

20716 IoMulti: Memory Allocation 
Failure.

Internal Application Logic Error. Processing stops.

20717 Bad key allocation. Internal Application Logic Error. Processing stops.

20725 LedgerTransform: Fatal 
Error During Parse: Prepare

Internal logic error. Processing stops.

20726 LedgerTransform: Fatal 
Error During Parse: Pivot

Internal logic error. Processing stops.

20727 LedgerTransform: Fatal 
Error During Parse: Time

Internal logic error. Processing stops.

20728 LedgerTransform: Input 
date is not valid.

The Transformation ID has Ledger Stat as 
the source type, Processing Option is 
Selective and either Start date or End date 
< 01 JAN,1950. 

OR 

The Transformation ID has Ledger Stat as 
the source type, Processing Options is 
Selective and the Start Date is greater 
than the End Date. 

OR 

The Transformation ID has Ledger Stat as 
the source type, the Processing Options is 
Current Month and the activated 
Configuration ID has an As Of Date < 01 
JAN,1950.

Processing stops.

20730 LedgerTransform: Fatal 
Error During Parse: Output

Internal logic error. Processing stops.

Error Code Error Message Error Condition Effect on Processing
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20731 LedgerTransform: Fatal 
Error During Parse: Bind 
Output table

Internal logic error. Processing stops.

20732 LedgerTransform: Fatal 
Error During Parse: Writer 
Prepare

Internal logic error. Processing stops.

20734 LedgerTransform: Fatal 
Error. FE Not in DETAIL_
ELEM.

Transformation ID has Ledger Stat as the 
source type and the pivoted group has at 
least one Financial Element ID that is not 
being defined in the DETAIL_ELEM 
table.

Processing stops.

20735 LedgerTransform: Fatal 
Error. FE No column name 
defined in DETAIL_ELEM.

The Transformation ID has Ledger Stat as 
the source type, and at least one Financial 
Element ID that is defined in DETAIL_
ELEM table does not have a 
corresponding COLUMN_NAME 
defined.

Processing stops.

20736 LedgerTransform: Error- All 
dimensions are filtered out.

Transformation ID has Ledger Stat as the 
source type and all the Dimensions are 
being filtered out.

Processing stops.

20737 Transformation ID does not 
exist in table.

A bad Sys_ID_Num is assigned to the 
Transformation ID.

Processing stops.

20738 Configuration ID does not 
exist in table.

Bad Sys_ID_Num is assigned to the 
Configuration ID.

Processing stops.

20739 Processing ID is bad. There is an error in the format of the 
Processing ID.

Processing stops.

20741 Transformation ID: 
Unsupported source table 
type.

Transformation ID has an Undefined 
SOURCE_TBL_TYPE_CD saved in IDT_
TRANSFORM table.

Processing stops.

20742 Ledger Transform Error: 
Transformation would cause 
table overwrite.

Transformation ID has Ledger Stat as the 
source type, Processing Options is Entire 
Table, Drop Existing Table is unchecked, 
and the Transform Into table had already 
existed in the database.

Processing stops.

20743 Filter is filtering out a 
financial element that 
already exists in the table.

The Transformation ID has Ledger Stat as 
the source type, and the Data Filter has 
filtered out at least one of its Financial_
elem_ID which already exists in the 
Transform Into table.

Processing stops.

Error Code Error Message Error Condition Effect on Processing
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20746 A column for financial 
element is being added to 
the table where historic data 
is plugged with a zero, 
which causes inconsistent 
data.

A Ledger Stat Transformation ID is 
adding data to an existing output table. 
The added data causes a column to be 
added to the output table for a new 
financial element. 

However, the values for the new financial 
element column for records that already 
exist in the output table are plugged with 
a zero. This is in error since valid values 
for this financial element for the existing 
records exist in the input table.

Processing stops.

20755 Fatal Error occurred loading 
Transformation ID.

Internal logic error. Processing stops.

20756 Fatal Error occurred loading 
dimension filter.

Failure in Database Layer. Processing stops.

20757 Ledger Transform: No 
Records returned.

Either there are no records in the 
LEDGER_STAT table, or the filter being 
used excludes all records.

No records are 
processed.

20764 RollupTransform: 
Transformation would cause 
table overwrite.

The Transformation ID has Tree Rollup as 
the source type, the Drop Existing Table 
Flag is unchecked and the Transform Into 
table already exists in the database.

Processing stops.

20765 RollupTransform: Rollup 
Sys_ID not found in Level_
Desc table.

For the Tree Rollup ID being transformed, 
no records exist in the Level _Description 
table.

Processing stops.

20766 RollupTransform: Too many 
levels found in Level_Desc 
table.

The value in the LEVEL_NUM COLUMN 
in the Level Description table exceeds the 
Maximum number of levels, which is 15.

Processing stops.

20767 RollupTransform: Rollup 
Sys_ID not found in Catalog 
of IDs table.

The Tree Rollup ID (SYS_ID_NUM) 
cannot be found in the CATALOG_OF_
IDS table.

Processing stops.

20768 RollupTransform: Leaf not 
found in Catalog of Leaves 
table.

The Leaf Type for the Tree Rollup being 
transformed does not exist in the 
Catalog_of_Leaves table.

Processing stops.

20769 RMTransform: Source table 
does not exist.

The Transformation ID has Risk Manager 
Result Detail as the source type and the 
table for the Process_ID does not exists in 
the database.

Processing stops.

20770 RMTransform: Error- 
Unable to drop existing 
table(s).

Missing Privileges: The DBA should run 
Grants in the OFSA System 
Administration.

Processing stops.

Error Code Error Message Error Condition Effect on Processing
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20771 RMTransform: Error: No 
data was found to 
transform.

The Transformation ID has Risk Manager 
Result Detail as the source type, the 
source table exists in the database but no 
data was found in the source table.

No records are 
processed.

20772 RMTransform: Error: No 
information on product or 
organization leaf was found.

The Transformation ID has Risk Manager 
Result Detail as the source type and 
either Product Leaf or Organization Unit 
ID in the source table is not defined in 
The CATALOG_OF_LEAVES table.

Processing stops.

20773 RMTransform: Error- All 
dimensions are filtered out.

The Transformation ID has Risk Manager 
Result Detail as the source type and all 
the Dimensions are being filtered out.

Processing stops.

20774 RMTransform: Inapplicable 
dimensions found in 
dimension filter.

The Transformation ID has Risk Manager 
Result Detail as the source type and the 
Dimension Filter excludes the Leaf type 
which is neither the Product Leaf nor the 
Organization Leaf Type that is being used 
by the input table.

Processing stops.

20775 RMTransform: Error- 
Required bucket 
information not found in 
RESULT_BUCKET table.

Transformation ID has Risk Manager 
Result Detail as the source type and at 
least one Scenario_Num in the source 
table cannot be found in the RESULT_
BUCKET table. 

Processing stops.

20776 RMTransform: RESULT_
BUCKET has more start 
date indexes than result 
table.

The RESULT_BUCKET table expects 
more scenarios than are contained in the 
result detail table. Data may be missing 
from the result detail table.

Note: This is only a 
warning message.

20777 RMTransform: Error: FE in 
source table is not in 
DETAIL_ELEM.

The Transformation ID has Risk Manager 
Result as the source type, and has at least 
one Financial Element ID not defined in 
the DETAIL_ELEM table.

Processing stops.

20778 RMTransform: Error: 
Prepare Writer failed.

Internal logic error. Processing stops.

20780 LedgerTransform:Transform
ation data inconsistent with 
existing table.

Pivoting Data causes the existing 
Transform Into table data to become 
inconsistent.

Processing stops.

20782 Transform: Duplicate 
Column Name found in 
DETAIL_ELEM.

Pivoted Data has at least two Financial 
Elem IDs having the same COLUMN_
NAME defined in the DETAIL_ELEM 
table.

Processing stops.

Error Code Error Message Error Condition Effect on Processing
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20783 LedgerTransform: 
Dimension filter contains a 
column which is used in 
Data Filter.

A leaf column is being excluded that is 
being used by the data filter.

Processing stops.

20784 RMTransform: Error- 
Unable to create output 
table.

The Transformation ID was unable to 
create the Transform Into table or Index.

Processing stops.

20789 Transform: Failed to drop 
table.

Missing database privilege. Processing stops.

20790 Transform: Failed to create 
rollup table.

Run Grants in OFSA System 
Administration, or see your DBA.

Processing stops.

20791 Transform: Failed to create 
table.

Run Grants in OFSA System 
Administration, or see your DBA.

Processing stops.

20792 Transform: Failed to append 
columns to table.

Run Grants in OFSA System 
Administration, or see your DBA.

Processing stops.

20793 Transform: Failed to reserve 
table.

Run Grants in OFSA System 
Administration, or see your DBA. 

OR

Transform Into table has already been 
reserved by other User.

Processing stops.

Error Code Error Message Error Condition Effect on Processing
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Glossary

Aggregation

To send (write) the results from a Stratification Report to a table in the database.

As of Date

Date at which the data is current.

Asset/Liability Management Committee

The Asset/Liability Management Committee (or ALCO) is an organization within a 
financial institution whose charter is to manage interest rate risk. 

At-Risk Period

The time horizon for Value-at-Risk, such as the difference between the time in the 
future when we evaluate portfolio loss and the As of Date.

Base Rates

Section in Oracle Risk Manager that stores the interest rates associated with the data 
As-of-Date.

Basis Points

1/100th of a percent (abbreviated as “bps”)

Breakage Charges

A charge assigned to an account whose actual cash flows vary significantly from the 
expected cash flows at the time of funding.

Cash Flow Table

An instrument table that contains all of the OFSA cash flow columns.
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Cash Flow Column

Column in an instrument table used by the OFSA cash flow engine to perform cash 
flow analysis on a record.

Configuration ID

ID in OFS Applications that stores system default information customized for the 
user and/or the institution.

CPR

Constant Prepayment Rate (CPR) is a measure of an annualized prepayment rate.

Credit Risk

The risk that a loan holder will be unable to repay any portion of the loan.

Current Rate Risk Profit

Component of funding center rate risk results attributed to current mismatches of 
assets and liabilities.

Data Correction Processing ID

Components of funding Center rate risk results attributed to current mismatches of 
assets and liabilities. It allows row level editing of all data in the OFSA database.

DDA

Demand Deposit Account. An example of a DDA is a checking account.

De-annualize

To compute the monthly equivalent rate of an annual rate

Duration

Duration is the rate of market value change with respect to discount rate changes. It 
is a measure of market value sensitivity: the lower the value, the less sensitive the 
market value to changes in interest rates.

Embedded Rate Risk Profit

Portion of funding center rate risk result attributed to prior rate bets.

Floating Tree Bar

Window that allows you to choose the appropriate branch or leaf in the currently 
active Tree ID.
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Funding Center

Area in a financial institution that receives the transfer pricing charge and credit for 
funds.

General Ledger

The main data source that defines an institution’s financial reality. The General 
Ledger reflects all accounting entries. 

Grid

A logical grouping of cells often surrounded by scroll bars.

Historical Rates Table

OFSA Repository for all historical actual interest rates.

Instrument

Type of financial security. See Instrument Table.

Instrument Table

A type of table contained in the OFSA database used to store account level 
information.

Instrument Records

Rows in the OFSA database that carry transaction account level information 
(Example: deposit account by deposit account)

Interest Rate Code

User defined code to reference a yield curve or single rate index for historical 
analysis, transfer pricing, and interest rate forecasting purposes.

Last Repricing Date

Date the rate last changed for an adjustable rate instrument and the origination date 
for a fixed rate instrument.

Leaf Fields

OFSA database fields used to define hierarchical segmentations of data (Trees). 
They also draw a relationship between the instrument data and the General Ledger 
data in Ledger/Stat.
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Leaf ID

A column in the OFSA database that allows the creation of hierarchical trees for use 
in reporting and assumptions. Leaf ID Columns also define the relationship 
between the instrument data and the ledger data.

Leaf Values

Specific numeric values that make up the Leaf Fields.

Ledger/Stat

Table in OFSA database that stores all General Ledger as well as statistical 
information for current and historical periods.

Liquidity Premiums

A charge levied on a long-term instrument to compensate for illiquidity of the 
funds.

Log in

To access the programs and database of any OFS application by providing a valid 
user name and password.

Long Run Rate 

One of the user-input parameters of the Vasicek (discrete-time) term structure 
model; represents the equilibrium value of the one-month annually compounded 
rate.

Market Price of Risk

In financial economics theory the market price of risk is a measure of intertemporal 
risk-aversion of the aggregate investor; for example, a high market price of risk 
during some future period means that investors will be more risk-averse, and that 
rates for that term should be higher to compensate for this risk; in practical terms, 
the market price of risk is the "plug" that makes the risk-neutral rates price risk-free 
bonds correctly.

Market Value

In Monte Carlo, average of the (scenario specific) present values.

Matched Rate Transfer Pricing

Method of Transfer Pricing where all accounts have transfer rates that reflect their 
specific maturity and repricing characteristics.
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Matched Spread

The interest profit margin for any account, measured as the Note Rate minus the 
Transfer Rate for asset accounts and the Transfer Rate minus the Note Rate for 
Liability and Equity accounts.

Monthly Rate

Yield on a loan contracted at the beginning of a month for a period of one month 
assuming a continuous compounding basis; the monthly rate is a function of time 
and scenario; the Rate Generator also computes rates for a different term than a 
month.

Next Repricing Term

Repricing frequency for an adjustable rate instrument and the original term to 
maturity for a fixed rate instrument

Oracle Balance and Control

Balance and Control validates all data used in the OFSA database.

Oracle Budgeting and Planning

Budgeting and Planning performs distributed budgeting of all balance sheet and 
income statement accounts.

Oracle Performance Analyzer

Performance Analyzer analyzes multiple levels of profitability. (Example: 
organizational and product profitability)

Oracle Portfolio Analyzer

Portfolio Analyzer allows flexible reporting and filtering of data.

Oracle Risk Manager

Risk Manager is an Asset/Liability model that generates daily cash flows for each 
individual transaction record.

Oracle System Administration

Oracle System Administration is a set of powerful administrative tools that provide 
management of the OFSA Relational Database and access to the database by OFS 
application users.
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Oracle Transfer Pricing

Transfer Pricing performs Matched Rate Transfer Pricing for an entire balance sheet.

Operating Cost

Non-interest related cost of running a business.

Option Costs

Costs assigned to measure the value of any customer option on an instrument. 
(Example: prepayments on mortgage loans)

Portfolio Fields

Fields in the OFSA database that are common to multiple instrument tables. The 
OFSA Administrator determines the portfolio fields. 

Prepayment

A reduction in the principal balance of a transaction record prior to the contracted 
schedule date.

Present Value

In Monte Carlo, sum of cash flows paid by a security along a particular rate 
scenario, discounted by the stochastic discount factor.

Processing Filter ID

Filter ID used to define which data should go into a processing run.

PSA

A prepayment specification method established by the Public Securities 
Association, which relates an the CPR to the age of that instrument.

Reconciliation

The process of comparing information from one data source to another

Record

Usually a single account or transaction, or aggregation of accounts, stored in the 
database (also called a row).

Remote User

A user not connected to the client server environment. A remote user needs to 
transmit information to the budget administrator via computer files.
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Report ID

OFSA ID that allows the creation of a report by allowing the definition of the report 
rows and columns, and the data that goes into the report (Filter ID).

Reporting Currency

An active currency to which balances in other currencies are consolidated, often 
used for reporting.

Single Rate

An interest rate code with only one point defined. (Examples: prime rate and 11th 
District Cost of Funds Index)

Speed of Mean Reversion 

One of the user-input parameters of the Vasicek and Extended Vasicek (discrete-
time) term structure models; represents the long-run drift factor.

Spreadsheet Control Bar

A pop-up dialogue that facilitates the definition of a series of input values (dates or 
numbers) by allowing several methods for defining structured patterns in the data.

SQL

Structured Query Language. The standard method of accessing the OFSA database.

Stochastic Discount Factor

Present value (along a rate scenario) of one dollar received at some future time; it is 
a function of future time, OAS, and scenario

Stratification ID

A type of Row ID that allows the specification of multiple stratification reports; 
reports that segment data by groupings of one or many database columns.

Stratification Report

A report that segments results into groupings of one or many database columns.

Subtotal ID

ID that specifies the nodes in a Tree ID, with summarized results in a reporting 
process.
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Transfer Pricing

A method for valuing all sources and uses of funds for a balance sheet.

Transfer Pricing ID

A OFSA ID used to specify the method for transfer pricing all balance sheet 
accounts.

Transfer Pricing Table

An instrument table that contains all of the columns required to run transfer 
pricing.

Tree ID

Hierarchical structure for Leaf Fields in OFS applications (Examples: organizational 
and product type)

UPR

Unscheduled Principal Runoff (UPR) is a source of runoff in Oracle Risk Manager 
cash flow calculations that allows another source of unscheduled runoff in addition 
to prepayments. UPR is not applicable for Oracle Transfer Pricing.

Volatility 

One of the user-input term parameters of all (discrete-time) term structure models; 
represents a standard deviation of the one-month annually compounded rate.

Yield Curve

Curve of annually compounded zero-coupon bond yield, as recorded in the 
Historical Rates ID.
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Inclusion Indicator, 24-2
Insert, 25-9
Name, 25-10
Number(s), 25-6, 25-10
Paste, 25-11
Rename, 25-10
Up, 25-11

Non-Pivot Transformations, 23-2
Rates, 23-2

Null Values, 7-6, 12-12

O
OFS applications, 1-2
Open

an Existing ID, 4-3
Operand(s), 12-3
Operator(s), 12-3

Logical, 13-18
Numeric, 13-18
Relational, 13-17

Order
of Process Arrows, 5-3

order of processing, 7-5
Original DeferredPercent, 15-9
original multiplier, 22-7
original term, 17-6, 18-1, 22-7
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Orphan

Branch, 25-10
Leaf, 25-10

Output
Column(s), 12-10

P
Parameters, 12-7
Parent

Level, 25-9
Name, 25-9

Parenthesis, 12-3
password

changing, 1-8
Payment Change Frequency, 15-9
payment change frequency, 22-8
Payment Change Multiplier, 15-9
payment change multiplier, 22-8
Payment Decrease Life, 15-9
payment decrease life, 22-8
Payment Decrease Period, 15-9
payment decrease period, 22-8
Payment Frequency, 15-9
payment frequency, 22-8
payment increase life, 22-8
payment increase period, 22-8
Payment Increase Periods, 15-9
Payment Multiplier, 15-9
payment multiplier, 22-8
Payment Pattern Interface, 26-3, 27-3
PC, 4-23
Performance

Data (TM, 3-1
Permission, 4-2
Pivoting, 23-2
PMT CHG FRQ, 15-9
PMT CHG MLT, 15-9
PMT DECRSE LIFE, 15-9
PMT DECRSE PRD, 15-9
PMT FRQ, 15-9
PMT INCRSE LIFE, 15-9
PMT INCRSE PRD, 15-9
PMT MLT, 15-9

Portfolio, 7-2
prepayment curve, 17-3
Prepayment ID

creating new, 17-8
defining, 17-9
editing, 17-10

prepayment rate, 17-6
prepayment rate dimension values, 18-3
prepayment table calculation method, 17-3
prepayment table dimensions, 18-1
Prepayment Table ID, 18-1

adding dimensions, 18-3
adding prepayment rates, 18-7
creating new, 18-3

prepayments, 17-1
assumptions, 17-1
calculation methods, 17-2

Pricing Margin ID, 3-2
Priority, 4-27
Process, 4-24

an ID, 4-23
Processing

Errors, 3-6
ID, 13-2

processing
order, 7-5

Processing ID, 4-22

R
range, 18-2
Range(s), 7-4
Rate

Scenarios, 2-2
rate cap life, 22-8
rate change rounding percent, 22-8
rate change rounding type, 22-8
rate decrease life, 22-8
rate decrease period, 22-8
rate difference, 18-2
rate floor life, 22-9
rate pricing option, 22-9
rate ratio, 18-2
Rates, 23-3

Graphs, 11-15
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Non-Weighted, 23-3
Weighted, 23-3

Read Only, 4-3
Read/Write, 4-3
Record, 4-25
refinance, 17-6
remaining term, 17-6, 18-1
Remove, 7-3

All, 4-5, 7-3
Rename, 4-4

Node, 25-10
Renumber, 4-6, 4-9
Replace, 12-11
Report(s)

Column, 12-1
reporting

report-related changes, xxi
Reporting Buckets, 2-2
reprice frequency, 17-6, 18-1
Request

Date, 4-26
Results

Writing, 3-4
Rollup

Level Maintenance, 25-8
Tree Window, 25-3

rollup tree pane, 24-2
Row(s)

Level Security, 7-6
RQ, 4-23
RT CAP LIFE, 15-9
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RT FLOOR LIFE, 15-10

S
Save

an ID, 4-4
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Search, 25-3, 25-5

Field(s), 25-4

Option(s), 25-4
String, 25-4

seasonality adjustments, 17-8
See

All Jobs, 4-24
Your Jobs, 4-24

Select
All, 4-5
Multiple IDs, 4-5

Selected
IDs, 5-2

Server
Polling Indicator, 4-25
Status, 4-23, 5-4

Set
Display Level, 24-4, 25-9
Tree Level, 24-4, 25-9

Setup
Leaf, 4-6

Shift Key, 4-5, 25-10
Specific Value(s), 7-4
Spot

Interest Rate Code, 20-4
Spot Input method, 9-4
spread, 17-3
Spreadsheet, 8-1
SQL Talk

limitations, 28-3
columns displayed, 28-3
processing time, 28-3
rows displayed, 28-3

multiple open windows, 28-2
security (SQL Talk privileges), 28-1
stored procedures, creating, 28-3
using, 28-2

Start
Date, 4-26
Date(s), 5-3
Time, 4-26
Value, 4-28
Value Box, 4-29

Status, 4-25
Stop Job, 4-24
support information. See customer support
System
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Configuration, 1-4

T
Table(s)

and Output Columns, 12-10
Multiple, 7-2
Name, 4-25, 7-7

tease discount, 22-9
term to reprice, 18-1
Time Bucket Pivot, 23-2
Title, 4-25
Toggle

In/Out of Filter, 24-5
transfer rate, 22-7
transfer rate margin, 19-3
Transformation ID, 23-1

Applications, 23-1
Balance and Control, 23-1
Data Filtering, 23-2
Dimension Filtering, 23-2
Financial Element Pivot, 23-2
Non-Pivot Transformations, 23-2
OFSA Reporting Data Mart, 23-1
Pivoting, 23-2
Risk Manager, 23-1
Time Bucket Pivot, 23-2
Transfer Pricing, 23-1
Transformation Process, 23-1

Transformation Process
Transformation ID, 23-1

Tree
Menu, 24-3, 25-3, 25-5, 25-7
Rollup ID, 4-3, 25-1
Structure, 25-13

tree bar, 1-8
Tree-Related IDs, 4-12
Triggers, 15-4

U
Undo Focus, 24-4, 25-8
User, 4-25

V
Value(s)

Code, 7-4, 8-4
Virtual Spreadsheet, 8-1

W
Warning, 12-11
Write Cash Flow Results, 3-5
Writing

Processing Errors, 3-6
Results, 3-4

Y
Year, 12-8
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